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Dear Reader,

Pivot tables and pivot charts are powerful tools in Excel that help you create 
a quick summary from thousands of rows of data. It’s easy to get started with 
pivot tables, and this book will guide you from planning to setting up a simple 
pivot table to creating a sophisticated final product. 
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• Add impact with data bars and traffic light icons to highlight good  

and poor results.
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• Investigate the data behind the numbers with a quick double-click.
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Introduction

Excel’s pivot tables are a powerful tool for analyzing data. With only a few minutes of work
and no previous experience, you can create an attractively formatted report that summarizes
thousands of rows of data. This book guides you through the process of planning and creating
a pivot table; enhancing it with formatting, calculations, and special settings; and creating a
polished final report.

Even if you’ve used pivot tables in previous versions of Excel, much has changed in Excel
2007. The user interface is dramatically different, and pivot tables have many new features.
Instead of struggling to find things on your own, you can use this book to accelerate the
process of learning how things work in the new version.

Who This Book Is For
This book is for anyone who has little or no experience with pivot tables or who has used pivot
tables in earlier versions of Excel and wants to learn about the new features in Excel 2007. It’s
designed to take you from the planning stages to the final product. A variety of sample data is
used in the book to show how pivot tables can help you create reports for different industries
or departments and many types of data. 

How This Book Is Structured
Starting with the planning process in Chapter 1, this book leads you through the process of
designing, modifying, and formatting a pivot table. Several different examples are used to
show you what you can achieve with a few simple steps. The following is a brief summary 
of the material contained in each chapter:

• Chapter 1, “Introducing Pivot Tables”: Understanding what a pivot table is and what
benefits it provides. Preparing to create a pivot table by organizing the data in a format-
ted Excel table. Exploring the features and benefits of a formatted Excel table.

• Chapter 2, “Creating a Pivot Table”: Taking the first steps in building a simple pivot table
from your data. Changing the pivot table layout and creating a simple pivot chart.

• Chapter 3, “Modifying a Pivot Table”: Using report filters to limit the data that is summa-
rized. Updating a pivot table when data is added or changed. Changing the summary
function that is used in the pivot table. Applying a pivot table style to enhance the report’s
appearance.

• Chapter 4, “Summarizing Data”: Using different summary functions to report on the
data. Showing and hiding the grand totals. Creating subtotals in the pivot table and
changing the subtotal function. Grouping numbers and dates in the report.

xix
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• Chapter 5, “Formatting a Pivot Table”: Using report layouts and pivot table styles to
change the pivot table’s appearance. Creating custom pivot table styles. Using themes
to affect the workbook’s colors and fonts.

• Chapter 6, “Sorting and Filtering in a Pivot Table”: Adding and arranging multiple
report filters. Filtering row and column labels and removing filters. Filtering for a
dynamic date range, such as Last Month. Filtering values in the total column. Applying
manual filters and filtering by selection. Showing a selection of top or bottom items.
Sorting labels and values.

• Chapter 7, “Creating a Pivot Table from External Data”: Creating a pivot table from data
in a text file, an Access query, or an OLAP cube. Modifying the connection. Creating a
pivot table from an existing connection.

• Chapter 8, “Updating a Pivot Table”: Updating a pivot table when the source data changes.
Refreshing all the pivot tables in a workbook. Changing the Access data source. Refreshing
a pivot table at regular intervals. Saving the source data with the Excel file. Retaining
deleted items in the pivot table filter lists.

• Chapter 9, “Creating Calculations in a Pivot Table”: Creating custom calculations, such
as Running Total In, % of Row, and % Difference From. Creating and modifying calcu-
lated fields and calculated items. Listing the formulas used in a pivot table and
changing the solve order for calculated items.

• Chapter 10, “Enhancing Pivot Table Formatting”: Applying conditional formatting using
color scales, icon sets, and data bars. Changing pivot table settings to control column
widths, visible items, and label buttons.

• Chapter 11, “Creating a Pivot Chart”: Creating and modifying a default pivot chart.
Adding fields and changing the chart style. Formatting a pivot chart and adding titles
and labels. Adding trend lines and creating a dynamic chart title.

• Chapter 12, “Printing and Extracting Data from a Pivot Table”: Extracting underlying
records from a value cell by using the Show Details feature. Creating multiple copies of a
pivot table by using the Show Report Filter Pages feature. Printing a pivot table. Adjusting
the print options to achieve the best results. Using the GetPivotData function to extract
specific data from a pivot table. Using cell references in a GetPivotData formula.
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Prerequisites
The instructions in this book are written for Microsoft Excel 2007. Basic skills in Excel 2007 are
assumed, and no previous knowledge of pivot tables is required.

Downloading the Code
Sample workbooks and code are available on the Apress web site at www.apress.com.

Contacting the Author
You can send comments to the author at ddalgleish@contextures.com and visit her Contextures
web site at www.contextures.com. 

■INTRODUCTION xxi

8903Ch00CMP2  8/29/07  7:13 PM  Page xxi

http://www.apress.com
mailto:ddalgleish@contextures.com
http://www.contextures.com


8903Ch00CMP2  8/29/07  7:13 PM  Page xxii



Introducing Pivot Tables

Using a pivot table in Microsoft Office Excel 2007 is a quick and exciting way to slice and dice
a large amount of data. With it, you can turn your data inside out, upside down, sideways, and
backwards to see how your business is doing. You can examine the data for similarities, differ-
ences, highs, and lows. What’s going up, what’s going down, and what’s staying the same?
Compare one region to another, view key results for several years of data, or zero in on one
product’s sales results. Make a few quick changes to the pivot table, and you can see your data
from a completely different angle.

Pivot tables are even easier to use in Excel 2007 than they were in previous versions. With
just a few clicks of the mouse and no complex formulas, you can summarize thousands of
rows of data to show sums, averages, or other calculations. In this chapter, you’ll get an
overview of what pivot tables are, how you can benefit from using them, and how to prepare
your data in Excel so you can use it as the source for a pivot table.

What Is a Pivot Table?
A pivot table is a tool in Excel that helps you summarize many rows and columns of data into a
concise report. In Figure 1-1, you can see the first few of several thousand rows of data about
food sales. Each row details what was sold, where it was sold, and the date and amount of the
sale.

Figure 1-1. The food sales data

If you were asked to create a report from this data, with a count of orders for each region
per product category where there was a promotional discount, you could manually list all the
regions and product categories and then enter complex formulas to calculate the number of
orders. If you create a pivot table instead, the report could be ready with a few clicks of the
mouse.

1

C H A P T E R  1

8903Ch01CMP2  7/31/07  7:14 PM  Page 1



With a pivot table, you simply drop the data into one of four areas, as shown in Figure 1-2.
When you do this with the food sales data, row and column labels for the regions and product
categories will be automatically created, and the orders will be counted. And you can add a fil-
ter to view only the orders with a promotional discount, instead of all the orders.

Figure 1-2. The four areas of a pivot table

In Figure 1-3, you can see a pivot table that summarizes the thousands of rows of food
sales data, showing the counts of discounted orders.

From the report filter at the top of the pivot table, Yes has been selected so only the orders
with a promotional discount are counted. The Grand Total row/column shows that there are
718 discounted orders. Bars and cookies have the highest number of discounted orders, and
the West region has the lowest number of discounted orders.

Figure 1-3. A pivot table summarizes the food sales data.

With a few more mouse clicks, you could quickly pivot the data to see a different sum-
mary. For example, your marketing director may ask how the sales of low-fat cookies are going
in each of the cities you service. You could remove the regions from the pivot table and put in
the cities. Instead of product categories as headings across the columns, you could show the
Yes and No columns for low-fat items. To focus on cookie sales, you would move the product
category to the report filter area and select Cookies.

In a minute or two, you could e-mail a report to the marketing director to show that the
low-fat cookies are selling about half as well as the non-low-fat cookies (see Figure 1-4).
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Figure 1-4. The food sales data summarized by city

Anxious to see whether the low-fat cookies sales are getting better or worse, the marketing
director asks for the numbers broken down by year to see whether sales are increasing or
decreasing. You simply add the order date to the pivot table and summarize the sales by year
(see Figure 1-5). The pivot table shows that in most cities, the sales for low-fat cookies are
increasing. Overall, the sales are increasing for low-fat and non-low-fat products.

Figure 1-5. The food sales data summarized by city and year
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You get one more phone call, just as you’re heading out the door. The vice president of
sales is flying to Chicago and wants a summary of the product sales in that market. What
direction is each product’s sales headed, and what are the market’s strengths and weaknesses?

Again, you pivot the data, moving a few fields to different positions in the layout. This
time you show the sales for one year as a percent change from the previous year to give a
quick snapshot of the sales directions (see Figure 1-6). The sales of bars increased by 11.16
percent, and the sales of cookies increased by 19.92 percent; however, potato chips sales have
declined. The Grand Total row shows that there is an overall increase in sales.

Figure 1-6. Percent change per year in the food sales data

The vice president of sales is happy with the report you created and asks you to create a
visual summary to use in the Chicago meeting. The chart should show the totals per year for
each product category in the Chicago area. You make a couple of quick changes to the pivot
table, press a key on the keyboard, add a title, and your pivot chart is ready (see Figure 1-7).

The vice president of sales leaves for the airport, ready for the Chicago meeting, and you
are relieved that you completed all those last-minute jobs without having to stay late!
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Figure 1-7. Quickly create a chart from the pivot table data.

Understanding the Benefits of Using Pivot Tables
Some people avoid using pivot tables because they’re convinced they are complicated and dif-
ficult. Those people are missing out on one of Excel’s most powerful and easy-to-use features.
While they’re spending hours writing complex formulas to summarize their data, you can
summarize the data in a pivot table in a minute or two with a few clicks of the mouse. With
pivot tables, you can prepare a sophisticated report from last night’s sales data before today’s 
9 a.m. meeting.

This book will guide you as you dive into using pivot tables, and it will use different exam-
ples to point out many ways you can use pivot tables to report on your business or personal
data. Although pivot tables are easy to use, they also have many sophisticated reporting fea-
tures that may not be easy to discover or to understand exactly how they work. The later
examples in this book are designed to explain those enhanced features and show how you can
benefit from using them.

Whether you’re working with financial data, logistics records, sales orders, customer serv-
ice reports, web site statistics, resource tracking, event planning, or any other set of records, a
pivot table might help you review, analyze, monitor, and report on the data. When the report-
ing requirements change, you can make minor adjustments to the pivot table instead of
starting a worksheet summary from scratch. The examples in this book may inspire you to
experiment with your own data and help make your job easier.

If you have used earlier versions of Excel, you’ll immediately notice that many features
have changed in Excel 2007. Pivot tables are among the features that have undergone a radical
transformation, including the way they’re created; Excel 2007 also offers new and improved
formatting tools and easier ways for connecting to data that’s outside Excel. In this book, you’ll
thoroughly explore the pivot table features that are available through the user interface. A
basic knowledge of Excel 2007 is assumed, and only those features that interact with pivot
tables, such as formatted Excel tables and conditional formatting, will be explained in the
main text. The appendix contains additional instructions for key Excel 2007 skills.
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Preparing to Create a Pivot Table
Before you can create a pivot table, you need to collect your data and organize it in a way Excel
can use. Your data may already be in the correct format, or you may have to do a little or a lot
of preparation before you can create a pivot table from your data. The data can be organized
in an Excel workbook, in an external database, or in other sources…even in a text file. I’ll start
by outlining the requirements for setting up the data. There aren’t too many rules, but it’s
important to set up the source data correctly. Investing in a little preparation time will ensure
that you get the best results from the pivot tables you build.

Planning for Source Data in Excel
Many pivot tables are created from worksheet data in Excel, such as the food sales data shown
in Figure 1-1, and most of the examples in this book will use similarly arranged data in Excel as
the source for a pivot table. First you’ll review the requirements for setting up the source data
in Excel, and in later chapters you will see how to create a pivot table from data outside Excel.
The source data can consist of a few rows and columns or thousands of rows and many
columns, but the basic layout requirements are similar (see “Organizing Data in Rows and
Columns”).

The first example you’ll see involves policy information for an insurance company. When
you sell a new policy, you record information such as the start and end dates of the policy, the
type of business that was insured, where the policy was purchased, and the value of the prop-
erty that was insured. You want to analyze the policy data to see what type of businesses are
insured in each region and what the total insured value is for each type of building. You’ll open
a sample file with data that illustrates the source data layout requirements that follow.

Opening the Sample File
To work with this example, you can download and open the sample file named 
InsurancePolicies.xlsx available at the www.apress.com web site.

If you are unable to download the sample file, you can create your own data, as described
in the following steps. However, the examples will be easier to follow if you use the sample file.
If you downloaded the sample file, you can skip the following steps.

1. In Excel, to create a new workbook, click the Microsoft Office Button at the top left of
the Excel window (see Figure 1-8).

Figure 1-8. The Microsoft Office Button

2. Click New to open the New Workbook dialog box.

3. In the list of templates, select Blank and Recent.

4. In the center pane, click Blank Workbook, and then click the Create button.
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5. Starting in cell A1 on Sheet1, enter the headings and data shown in Figure 1-9. This is
only a small view of a large table, so this data will not produce the same results as the
downloaded sample file.

Figure 1-9. The insurance policy data

Organizing Data in Rows and Columns
The Excel data to be used as the source for a pivot table must be organized in rows and
columns, with each row containing information about one record, such as a sales order or
inventory transaction. In this example, each row, or record, contains information about one
insurance policy.

The information in each record is stored in the same order, with the policy number in 
the first column, the start date in the second column, and other data continuing across the
columns. The first row contains headings to indicate what information is stored in each col-
umn. Each column can also be called a field, and the headings in the first row are the field
names.

In Figure 1-9 you can see eight records in the insurance policy data and eleven columns,
or fields. The last visible record is for policy 100207, and it has an entry of N in the Flood field.
In the sample file there are 11 columns and 927 rows of data.

Adding Column Headings
Each column in the source data must contain a heading. The heading can be one word or
multiple words, and all characters are allowed. You should use a short, descriptive, unique
heading for each column in the source data. The headings should indicate the specific data
that is contained in the column. For example, in the sample file, EQ is a concise heading for
the column that indicates whether earthquake coverage is included.

■Note If you try to create a pivot table from data that has blank heading cells, you will see an error message.

Although you can use the same heading for multiple columns, that might cause confusion
for you and anyone else who is using the pivot table. If headings are duplicated, Excel will add
numbers to make them unique when you create a pivot table.

Entering Similar Data in Each Column
Each column in the source data should contain one type of data. In the insurance policy
example, column B contains dates, column G contains currency, and column H contains text.
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Separating Data into Multiple Columns
To create an effective pivot table, some of the source data should be separated into multiple
columns, instead of using a single column. For example, instead of having a column labeled
Address, with the full address for each record, use three columns—one for Street, another for
City, and another for State. Then you will be able to analyze the data by city or state instead of
having that information buried in with the street address.

Removing Repeated Columns
Don’t create multiple columns to store the same type of information. For example, because
there is a separate column for each region’s dollar amounts in Figure 1-10, it will be difficult to
analyze the data by region in a pivot table.

Figure 1-10. Data in repeating columns will make it difficult to analyze by region.

Although the data arrangement in Figure 1-10 may be ideal for creating totals on the
worksheet, it’s not efficient if the data will be analyzed in a pivot table. Instead, all the related
dollar amounts should be in the same column, with the region name in another column. The
data arrangement in Figure 1-11 will make it easier to analyze the data by region in a pivot
table.

Figure 1-11. Related data in a single column will make it easier to analyze by region.

To help you decide whether something should be a column heading or an entry in the
record, think about how you want that item to appear in the pivot table and how you want to
summarize the data. Is the item a broad category name, such as Region, or does it describe a
quality of the information that’s stored in the column, such as Midwest? Do you want to create
a total from the numbers in all the columns? If you find yourself creating several columns with
different names to store the same type of information that you want to total in the pivot table,
as in Figure 1-10, then it’s likely that the headings should be changed to entries in a single col-
umn, as in Figure 1-11.
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Entering Related Data in Each Row
Each row in the source data should contain the details for one record, such as a sales order 
(or in this example, an insurance policy). If possible, include a unique identifier for each row,
such as an order number or policy number. This will make it easier to track the information
that’s summarized in the pivot table and do any troubleshooting later, if required.

Creating an Isolated Block of Data
The source data should not have any blank rows within it and cannot include any completely
blank columns. If you want a column within the source data to appear blank for aesthetic rea-
sons, it must at least contain a heading, which can be formatted with the same font color as
the cell fill color to appear as though it is blank.

The source data should be separated from any other data on the worksheet, with at least
one blank row and one blank column between it and the other data. The ideal situation is to
have only the source data on the worksheet and move other data to a separate worksheet. In
the insurance policies file, there are no blank columns or rows in the data, and there is no
other data on the worksheet.

Creating an Excel Table
As a final step in preparing the source data, you will create an Excel table from the data on the
worksheet. This will activate special features in the source data, such as the ability to automat-
ically extend formulas as new rows are added to the end of the existing data. In the next
chapter, you’ll create a pivot table from this formatted Excel table.

1. Select a cell in the table of insurance policies data.

2. On the Ribbon, click Insert to activate the Insert tab.

3. In the Tables group, click the Table command (see Figure 1-12).

■Note Do not click the Pivot Table command now. You’ll create a pivot table later.

Figure 1-12. The Table command on the Insert tab in the Ribbon

Insert tab

Tables Group
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4. In the Create Table dialog box, the range for your data should automatically appear,
and the My Table Has Headers option will be checked. Click OK to accept these set-
tings (see Figure 1-13).

Figure 1-13. The Create Table dialog box

5. The Excel table is automatically formatted with a table style, which may include row
shading, borders, and heading cells formatted differently than the other rows. The
heading cells have drop-down arrows that you can use to sort or filter the data (see 
Figure 1-14).

Figure 1-14. The table is automatically formatted.

■Note The Excel table formatting does not overwrite any existing formatting that you had manually applied
to the data.

6. You can drag the resize handle at the bottom right of the last row in the table to make
the table larger or smaller (see Figure 1-15).

Figure 1-15. The resize handle at the bottom right of the table
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Exploring the Excel Table Features
Using Excel’s table feature makes it easier to maintain the source data for a pivot table. In an
Excel table, if you add rows or columns, the new data is automatically included when you
update the pivot table. If you base a pivot table on unformatted source data, new rows or
columns may not be detected, and you would have to manually adjust the source data range
to ensure that the new data is included in the pivot table. Or, you might forget to adjust the
source data range to include the new data, and the pivot table could show inaccurate results.

Because using Excel’s table feature makes it easier to maintain the source data for a pivot
table, you should base your pivot tables on formatted tables where possible. We’ll spend some
time exploring the formatted table so you can see how its features can help you.

New Rows Are Automatically Included
If you add data at the end of an Excel table, the table range automatically expands to include
the new data. You can test this feature with your table.

1. Scroll down to the first blank row at the end of the table, and type the next policy num-
ber in column A to start entering a new record.

2. Press the Tab key to move to the next cell; the row is formatted, and the Excel table
expands to include the new row (see Figure 1-16). The resize handle is now located in
the new row.

Figure 1-16. The new row is automatically formatted.

Headings Are Automatically Created for New Columns
If you expand the Excel table to the right to add columns to the table, column headings are
automatically added for you. If you plan to create a pivot table from an Excel table, every col-
umn must have a heading. This feature will create temporary headings for you, which you can
change to something more descriptive.

1. Scroll down the worksheet until you can see the last row of data, and point to the resize
handle at the bottom right of the table.
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2. When the pointer changes to a two-headed arrow, hold the left mouse button and drag
to the right until you reach the right border of column L (see Figure 1-17).

Figure 1-17. Drag the resize handle to the right to add a column.

3. Release the mouse button, and Excel automatically formats column L to match the
other columns in the table. Excel automatically adds a numbered column heading,
Column1, in cell L1.

Deleting Rows and Columns
In an Excel table, you can easily delete rows and columns you no longer need. You’ll delete the
new row and column that you created, because they don’t contain any data.

1. Select a cell in the last row of the Excel table. This row contains the policy number you
entered but no other data.

2. On the Ribbon, click Home to activate the Home tab.

3. In the Cells group, click the arrow on the Delete command.

4. Click Delete Table Rows (see Figure 1-18) to delete the active row in the Excel table.

Figure 1-18. Delete a row in the Excel table.
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Next, you’ll delete the column you added at the right side of the Excel table:

1. Select a cell in the last column of the Excel table. This column contains a heading but
no other data.

2. On the Ribbon, click Home to activate the Home tab.

3. In the Cells group, click the arrow on the Delete command.

4. Click Delete Table Columns to delete the active column in the Excel table.

Headings Remain Visible
Another advantage of using an Excel table is that the column headings in the first row of the
table remain visible when you scroll down the worksheet. This makes it easier to identify the
columns as you work in a large table.

1. Scroll down the worksheet until the first row is no longer visible, and then click one of
the formatted cells in the Excel table.

2. Look at the column buttons at the top of the columns, and you’ll see that the column
letters have been replaced with the column headings that were entered in the first row
(see Figure 1-19).

Figure 1-19. Column buttons show the column heading text.

■Tip The column headings are visible only in the column buttons when the first row is not visible and a cell
in the Excel table is active. Click outside the Excel table, and the column buttons show their letters.

Table Is Automatically Named
An Excel table is automatically named, as in Table1, when it is created. You can refer to this
name when programming or when creating a pivot table. You can leave the table name that
was created, but in this example you’ll change it to something more meaningful:

1. To see the table name, select a cell in the Excel table.
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■Note When a cell in an Excel table is the active cell, the Ribbon displays a context tab named Table Tools.
Under the Table Tools tab is a Design tab, which contains commands you can use while working with the
Excel table.

2. On the Ribbon, under the Table Tools tab, click Design to activate the Design tab. At the
far left, in the Properties group, is the table name (see Figure 1-20).

Figure 1-20. Table name in the Design tab (under the Table Tools tab) of the Ribbon

■Tip To make more room for the worksheet, you can hide the Ribbon commands temporarily. Double-click
the active Ribbon tab to hide the commands (or to show the commands if they’ve previously been hidden).

Now that you’ve seen the Excel table name that was automatically assigned, you’ll rename
the Excel table so it will be easier to identify each table if other tables are added to the work-
book. Later, you can look for this name when creating a pivot table, or you can use the name
to navigate to the source Excel table.

1. In the Ribbon, select the existing name in the Table Name box.

2. With the existing name highlighted, type Insurance as a new name for the table.

3. Press the Enter key to complete the table name change.

■Tip If possible, create a short descriptive name for each Excel table. This will make it easier to identify
later if there are multiple Excel tables in the workbook.

Data Is Easily Sorted
An Excel table’s heading cells contain drop-down lists that let you quickly and easily sort the
data in the table. This feature can help you review the data before creating a pivot table or
when troubleshooting a pivot table. For example, you can sort the insured values to quickly
spot the highest and lowest amounts in the table.
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1. Press Ctrl+Home to return to cell A1, or scroll up to the first row so the drop-down
arrows in the first row are visible.

2. Click the drop-down arrow in the Insured Value heading cell.

■Note The drop-down arrows are not visible in the column heading buttons, only in the column heading
cells.

3. Click Sort Largest to Smallest (see Figure 1-21).

Figure 1-21. Sorting largest to smallest

The entire table is sorted, with records with the highest insured values at the top of the
table and lowest insured values at the bottom. The heading cell’s drop-down arrow now
includes a small downward arrow to show that the data is sorted in descending order (see 
Figure 1-22).

Figure 1-22. Arrow indicating that data is sorted in descending order
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Even if multiple cells are selected, the selection is ignored, and the entire Excel table is
sorted. This prevents the problems that could occur when cells in one column of an unformat-
ted table are sorted and the data in that column becomes detached from the rest of the record.
For example, in a regular table, a user might select and sort a column of telephone numbers
but not include the columns that contain the related name and address.

Data Is Easily Filtered
An Excel table’s heading cells contain drop-down lists that let you quickly and easily filter the
data in the table. This feature can help you review the data before creating a pivot table or
when troubleshooting a pivot table. For example, you can filter the Region column to view
only the policies that were written in the Central region.

1. Press Ctrl+Home to return to cell A1, or scroll up to the first row so the drop-down
arrows in the first row are visible.

2. Click the drop-down arrow in the Region heading cell.

3. In the list of regions, remove the check mark from (Select All). This removes all the
check marks from the list.

4. Add a check mark to Central, and then click OK (see Figure 1-23).

Figure 1-23. Filtering for the Central region

The Excel table is now filtered, with only the Central region records showing. The Region
heading cell’s drop-down arrow now shows a filter icon to indicate that the data in that col-
umn has been filtered (see Figure 1-24). To view the filter information, point to the drop-down
arrow in the Region heading cell.
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Figure 1-24. Filter icon showing column has a filter applied

Removing a Filter to View All the Data
After filtering an Excel table, to focus on part of the data, you can remove the filter to view all
the data again:

1. In the Excel table, click the drop-down arrow in the Region heading cell.

2. Click the Clear Filter from “Region” option.

This removes the filter from the column, and all the regions are visible again. The Filter
icon is no longer visible on the arrow in the column heading cell.

Saving the File
Excel 2007 offers some new file formats. You can save a file in the default file format by choos-
ing Excel Workbook from the list of formats. The file will have an .xlsx file extension and can
be opened in Excel 2007. Users with older versions of Excel may not be able to open the file. If
you want those users to be able to open the file, you can save it as Excel 97-2003 Workbook
Format. Some features from the Excel 2007 file may be lost if the file is saved in this format.

■Note If a pivot table is created in Excel 2007 format, it will have view-only properties in earlier versions.

You should save your file now using a different file name. That will leave the original file
unchanged, and you can use the new file for your work in the next chapter.

1. Click the Microsoft Office Button at the top left of the Excel window.

2. Point to Save As, and then click Excel Workbook to open the Save As dialog box.

3. In the Save As dialog box, select a folder from the Save In drop-down list.

4. Name the file InsurancePolicies02.xlsx, and then click the Save button.

5. Close the file or continue to Chapter 2, where you’ll create a pivot table from the Excel
table.
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Summary
A pivot table is a powerful Excel tool that you can use to quickly analyze a large quantity of
data. It’s easy to get started using pivot tables and to create one with a few clicks of the mouse.
Once you understand the basics, you can explore the more sophisticated reporting features
that pivot tables offer.

Before creating a pivot table, set up a data source in Excel or another program. To create
an effective pivot table, ensure that the source data is structured correctly and meets the fol-
lowing requirements.

• The data is organized in rows and columns.

• Each column has a unique, descriptive heading.

• There is similar data in each column.

• Data, such as address detail, is separated into multiple columns.

• There are no repeating columns, such as region names, storing similar data.

• Each row contains the related data for one record.

• The data is an isolated block on the worksheet.

The best way to prepare the source data is to format it as an Excel table, which will auto-
matically expand as data is added. The Excel table tools provide an easy way to sort and filter
the data, so you can review the data for the pivot table or troubleshoot if problems occur.
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Creating a Pivot Table

In this chapter, you’ll get up and running with pivot tables so you can see how quickly and
easily you can build and modify them. You’ll create a simple pivot table from the insurance
policy Excel table you created in Chapter 1. After creating the pivot table, you’ll examine its
key features and see how you can quickly change the pivot table layout to get a different view
of the data. You’ll create a pivot chart from the pivot table data to create a visual summary that
will make the data easy to understand at a glance.

Exploring an Insurance Policy Example
In this example, you’ll use the insurance policy Excel table from Chapter 1, which you saved in
the file named InsurancePolicies02.xlsx. If you did not create the file, you can download it at
the www.apress.com web site.

Your company sells insurance policies in four different regions. The claims manager
wants to know which region has the highest total of insured value for the policies sold. In the
insurance data, the region names are in column F, with a column heading of Region. The
insured values are in column G, with the heading InsuredValue (see Figure 2-1).

Figure 2-1. Insurance policies data

To find the region totals without a pivot table, you would list the regions in a column on a
worksheet and then use formulas to sum the insured values. Another formula would sum the
regional totals to create a grand total. The result would look similar to the example in Figure 2-2,
where one of the formulas is displayed.
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Figure 2-2. Worksheet formulas summarize the insurance data.

Instead of building the summary manually, you’ll create a pivot table to achieve the same
result quickly and easily. First, you’ll create an empty pivot table. Then, you’ll drop the data
into the pivot table to create the region labels and total the insured value.

■Note If you used your own data or created your own file in Chapter 1, your workbook may not match the
figures in this book.

1. Open the InsurancePolicies02.xlsx file you created or downloaded.

2. On Sheet1, select a cell in the formatted Excel table.

3. On the Ribbon, under the Table Tools tab, click the Design tab.

4. In the Tools group, click Summarize with PivotTable (see Figure 2-3).

Figure 2-3. The Summarize with PivotTable command

5. In the Create PivotTable dialog box that opens, under Choose the Data That You Want
to Analyze, the option Select a Table or Range is selected, and in the Table/Range box
the name of the active table, Insurance, appears (see Figure 2-4). Leave this value
unchanged.
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■Note If a cell in an Excel table or the entire Excel table is selected when you start to create a pivot table,
that Excel table is shown as the default source range for the pivot table. If you want to use a different table
or range, you can type an Excel table name or range address in the Table/Range box.

Figure 2-4. Create PivotTable dialog box

6. Under Choose Where You Want the PivotTable Report to Be Placed, New Worksheet is
the default selection. Leave that option selected, and click the OK button.

Creating the PivotTable Layout
When the Create PivotTable dialog box closes, Excel inserts a new worksheet in the workbook
using the next available sheet number. In this example, the new worksheet is named Sheet4.
The outline of an empty pivot table starts in cell A3. At the right of the Excel window, the 
PivotTable Field List pane appears (see Figure 2-5).

■Tip If the PivotTable Field List pane is not visible, select a cell in the empty pivot table.
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Figure 2-5. The empty pivot table and the PivotTable Field List pane

At the top of the PivotTable Field List pane is a list of the column headings from your
Excel table; they appear in the same order as in the Excel table. In the pivot table, these are
called fields.

At the bottom of the PivotTable Field List pane are the four areas of the pivot table: Report
Filter, Column Labels, Row Labels, and Values. You will drop the fields into these areas, and
they’ll appear in the matching area of the pivot table layout on the worksheet (see Figure 2-6).

Figure 2-6. The Report Filter, Column Labels, Row Labels, and Values areas in the pivot table 
layout
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Adding Fields to the Pivot Table Layout
In the pivot table example, you want to see a list of regions with the total insured value for
each region. When planning a pivot table, you’ll decide which fields you should use, and then
you’ll determine where each field should be dropped in the pivot table layout.

The region names are in the Region field, so that’s one of the fields you’ll need for this
pivot table. The other field required is the InsuredValue field, which will provide the dollar
amounts for the summary.

Because you want a list of region names down the left side of the pivot table, the Region
field should go in the Row Labels area. To see a sum of InsuredValue amounts, that field
should go in the Values area.

Once you’ve made the design decisions, you can add the fields to the pivot table layout by
using the PivotTable Field List pane.

1. At the top of the PivotTable Field List pane, in the list of fields, add a check mark to the
Region field.

2. Because it contains text data, the Region field is automatically added to the Row Labels
area at the bottom of the PivotTable Field List pane. On the worksheet, the region
names appear in the Row Labels area of the pivot table layout (see Figure 2-7).

Figure 2-7. Row Labels added to the pivot table layout

3. Next, in the PivotTable Field List pane, add a check mark to the InsuredValue field.
Because it contains numbers, the InsuredValue field is automatically added to the 
Values area of the PivotTable Field List pane.
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■Note Based on the type of data they contain, fields are added to a specific area of the pivot table by
default. You can manually place a field in a different area of the pivot table, as you’ll see later in the “Moving
Fields in the Pivot Table Layout” section.

4. On the worksheet, Sum of InsuredValue appears in the Values area of the pivot table,
showing the total insured value for each region (see Figure 2-8).

■Note With just a few clicks of the mouse and no complex formulas, you summarized almost 1,000
records to show the total insured value per region. This ability to quickly and easily summarize data is one of
the key benefits of using pivot tables.

Figure 2-8. Adding values to the pivot table

Changing the Pivot Table Layout
One of the advantages of using pivot tables to summarize data is that it’s easy to change the
pivot table layout after you’ve created it. You created a pivot table that summarizes the insured
value by region. Next, you’ll change the pivot table layout to view other summaries of the data,
and you’ll see how quickly and easily you can create a different summary.
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The underwriting manager is concerned about the fire risk in the insured properties and
has asked you for a report on the total insured value for each construction type. In the Excel
table, the Construction column shows the construction type for each insured property. You
can quickly change the pivot table layout to show a summary for the Construction field.

Currently, the Region field is in the Row Labels area. You’ll remove it and drop the Con-
struction field in the Row Labels area instead.

1. In the PivotTable Field List pane, remove the check mark from Region.

2. The Row Labels area disappears from the pivot table on the worksheet, and the Sum of
InsuredValue area shows the grand total for all records.

3. In the PivotTable Field List pane, add a check mark to the Construction field.

4. The Row Labels area now shows the construction types, and the Sum of InsuredValue
area shows the total insured value for each construction type (see Figure 2-9).

Figure 2-9. Change the field in the Row Labels area to see a different summary.

You send this report to the underwriting manager to show that frame-construction build-
ings comprise almost two-thirds of the total insured value of all the policies sold.

Adding More Fields to the Pivot Table
After receiving your report, the underwriting manager asks you for more detail. Policies are
sold for buildings in urban and rural locations, and your report would be more helpful if it
showed the insured values by construction type broken down by location type. Are the frame
buildings in urban locations, where fire departments can respond quickly?

Currently, Construction is the only field in the Row Labels area, so the pivot table shows
total insured value for all the insurance policies of each construction type. To view the sum-
mary in greater detail, you can also add the Location field to the Row Labels area to show the
insured value by construction and location (urban or rural).

1. In the PivotTable Field List pane, add a check mark to the Location field.

2. The Location field is added to the Row Labels area in the PivotTable Field List pane,
below the Construction field.
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3. In the pivot table layout on the worksheet, the Row Labels area shows each construc-
tion type as a heading, and below each construction heading is a list of location types.
The location labels are slightly indented, or nested, below the Construction labels. The
Sum of InsuredValue area shows a total for each construction type and a total for each
location type within that construction type (see Figure 2-10).

Figure 2-10. Multiple row labels provide a more detailed summary.

You send this more detailed report to the underwriting manager to show that most of the
frame-construction buildings are in urban locations. Only a small percentage of the policies
for frame-construction buildings are in rural locations.

Moving Fields in the Pivot Table Layout
The underwriting manager appreciates the work you’re doing and is pleased you can adjust
your reports so quickly. However, the manager has one more request—the total insured value
for each location type in addition to the total insured value for the construction types.

Currently, with two fields in the Row Labels area, the pivot table is arranged like a report
with headings and subheadings. If you had one set of headings down the left side of the pivot
table and another set of headings across the top, you could create totals down the columns
and across the rows. If you created the table manually, with formulas, it would be similar to
the sample shown in Figure 2-11, where you can see the formula for cell B6 in the Formula Bar
above the worksheet.

Figure 2-11. Worksheet formulas create totals across rows and down columns.
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To create this arrangement in your pivot table, you will move the Location field from the
Row Labels area to the Column Labels area. The locations will become labels across the top of
the pivot table layout. The revised layout will show the same detail but will include the loca-
tion totals that the underwriting manager needs.

1. In the PivotTable Field List pane, in the Row Labels area, point to the Location field.

2. When the pointer changes to a four-headed arrow, drag the Location field to the Col-
umn Labels area (see Figure 2-12).

Figure 2-12. Drag a field to the Column Labels area.

3. The pivot table layout changes. The Row Labels area now shows only the construction
types, and across the top are column labels showing the location types (see Figure 2-13).

Figure 2-13. The pivot layout with row labels and column labels

4. At the bottom of the pivot table is a Grand Total row, which shows the total insured
value for each location type. At the right side of the pivot table is a Grand Total column
that shows the total insured value for each construction type. The cell at the bottom
right of the PivotTable is the grand total for insured values.
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Although the layout is different, you can compare Figure 2-10 to Figure 2-13 to see that
the totals in the Values area are the same. For example, the total insured value for Rural
Masonry is $60764804 in both layouts.

With this layout, you can show the underwriting manager that frame-construction build-
ings have the highest total insured value, and urban locations have a higher total insured
value than rural locations.

Charting the Data in a Pivot Table
The underwriting manager is satisfied with the report and finds the location totals helpful for
analyzing the insurance policy data. To help explain the results to the executive committee,
the manager asks whether you can create a chart to illustrate the results.

In Chapter 11 you’ll learn about pivot charts in detail, but to accommodate the manager’s
request, you’ll create a simple chart from the current pivot table:

1. Select a cell in the pivot table.

2. On the keyboard, press the F11 key.

3. Excel inserts a chart sheet, Chart1, in the workbook, with a pivot chart based on the
current pivot table. The Construction field row labels have become the category axis
fields, and the Location field column labels have become series in the chart (see 
Figure 2-14). A series is a group of related values, like Urban, which is represented by
the light-colored columns.

Figure 2-14. A pivot chart provides a visual summary of the data.
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The pivot chart, at a glance, shows that policies for frame-construction buildings in urban
locations are by far the largest portion of the policies that have been sold. The insured value
for fire-resistant buildings in rural locations is so low that the column isn’t visible in the chart.

You can save your file now as InsurancePolicies03.xlsx. That will leave the original file
unchanged since its last save, and you can use the new file for your work in the next chapter.
Close the file or continue to Chapter 3, where you’ll modify the pivot table you created in this
chapter.

Summary
In this chapter, you learned to create a pivot table, and then you added fields as row labels,
column labels, and values. You also changed the pivot table layout by moving fields from one
area to another.

With just a few clicks of the mouse and no complex formulas, you summarized almost
1,000 records to show the total insured value of policies per region and discovered just how
powerful pivot tables are in analyzing data.

Finally, you created a pivot chart from the pivot table to obtain an effective visual sum-
mary of the pivot table data.
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Modifying a Pivot Table

In this chapter, you’ll modify the insurance data pivot table you created in Chapter 2 by
adding and removing fields and by filtering the pivot table so only specific data is summa-
rized. You’ll see what happens when the data in the source table changes, and you’ll learn how
to view a different type of summary for the values. You’ll use a built-in formatting feature to
change the appearance of the pivot table, and you’ll see how to delete a pivot table if you no
longer need it.

By the end of this chapter, I’ll have covered the basic of creating and modifying a pivot
table. In the remaining chapters, you’ll explore the pivot table features in depth so that you
fully understand all that a pivot table can do.

To work with the examples in this chapter, you can open the InsurancePolicies03.xlsx
file you saved at the end of Chapter 2, or you can download and open the sample file 
InsurancePolicies03.xlsx.

Changing a Pivot Table
Sometimes you will create a pivot table and leave it in the same layout for many months with-
out changing the fields. Weekly or monthly, you’ll update the data, and you’ll either review the
results or distribute a report based on the pivot table summary.

Other pivot tables will change frequently because you use them to create ad hoc reports,
answering the business questions of the day, as you did in Chapter 2 when you analyzed the
insurance policy data by region and then by construction type and location. In this chapter,
you’ll use the same data and pivot table to create more ad hoc reports by using different fields
to summarize the data.

Clearing a Pivot Table
There is a threat of flooding in the Midwest region, and you have been asked to report on the
insured values in each region for policies with and without flood coverage. You’ll clear the con-
tents of the pivot table, and then you’ll create a new layout to produce the requested report.

■Note You can also remove the existing fields individually by clearing the check boxes in the PivotTable
Field List pane.
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1. Select a cell in the pivot table on Sheet4.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Actions group, click Clear, and then click Clear All (see Figure 3-1).

Figure 3-1. Clear the pivot table layout.

4. The pivot table layout is cleared of all fields, and only the empty layout is visible on the
worksheet. The PivotTable Field List pane has not been cleared and still contains all
the fields from the source data.

Adding Fields to Specific Areas of the Pivot Table
In Chapter 2, when you created the pivot table, you checked the fields in the field list, and
Excel automatically placed them in the Areas section and in the pivot table layout on the
worksheet. Later, you moved a field if you wanted it in a different area.

Instead of accepting the automatic field placement, you can control where the fields are
placed. For your flood coverage report, you want regions listed in the Row Labels area and
flood coverage listed in the Column Labels area, showing the total insured value for each
region and coverage type:

1. In the PivotTable Field List pane, add a check mark to the InsuredValue field.

2. Because the InsuredValue field contains numeric data, Excel automatically places it in
the Values area.

3. Add a check mark to the Region field.

4. Because Region is a text field, Excel automatically places it in the Row Labels area.
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5. Next, you want to add the Flood field to the pivot table layout, but you want it in the
Column Labels area, not the Row Labels area. In the fields section of the PivotTable
Field List pane, drag the Flood field to the Column Labels area (see Figure 3-2).

Figure 3-2. Drag a field to the Column Labels area.

6. Release the mouse button, and the Flood field appears in the pivot table Column
Labels area, showing an N for policies with no coverage and a Y for policies that do
have flood coverage.

7. To make the numbers easier to read, you can format them. Right-click one of the val-
ues in the pivot table, and from the context menu, choose Number Format.

8. In the Format Cells dialog box, select the Number category.

9. For Decimal Places, select 0, add a check mark for Use 1000 Separator, and then click OK.

With the numbers formatted, you can see that more than $3 million of the insured value 
is for properties with flood coverage, compared to just $1 million for properties without 
flood coverage. In the Midwest region, about half of the insured value is for properties 
with flood coverage.

Adding a Report Filter
You’ve reported on the overall totals for each region, but the claims manager wants more
information. Each policy is for a specific type of business, and your next report should show
the total insured value for the manufacturing businesses only. To limit what is included in the
summarized data, you’ll add a filter to the pivot table by using the BusType field, which stores
the business type data.

CHAPTER 3 ■ MODIFYING A PIVOT TABLE 33

8903Ch03CMP2  7/31/07  7:43 PM  Page 33



1. In the PivotTable Field List pane, drag the BusType field to the Report Filter area (see
Figure 3-3).

Figure 3-3. Drag a field to the Report Filter area.

2. On the worksheet, Excel adds the BusType field to the top of the pivot table, with the
item (All) showing (see Figure 3-4). The values in the pivot table have not changed.

Figure 3-4. The BusType field added to the Report Filter area

3. Click the drop-down arrow to the right of (All) to see a list of business types. Each 
business type from the source data is listed here.

4. You’d like to filter the data to see only the manufacturing business types, so click 
Manufacturing, and click OK (see Figure 3-5).

Figure 3-5. Select an item in the Report Filter list.
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The values in the pivot table change and now show only the total insured values for poli-
cies sold to manufacturing businesses. Of the total insured values in the Midwest region, only
$25 million is for manufacturing businesses with flood coverage (see Figure 3-6).

In cell B1 on the worksheet, the drop-down arrow has changed to a filter symbol with a
small blue arrow. In the PivotTable Field List pane, there is a filter icon beside BusType in the
field list to show that it has a filter applied to that field.

Figure 3-6. A report filter has been applied.

With this filter applied, you can also see that for the manufacturing businesses, all the
policies sold in the Central region have flood coverage, but no policies sold in the Northeast
region have flood coverage.

Changing the Filter
Now that you have reported on the totals for manufacturing, you’re asked to report on the
retail businesses in the Midwest. To see the results for a different business type, you can
choose a different item from the report filter list.

1. Click the arrow for the BusType report filter to open the list of items.

2. Click Retail in the list, and click OK.

The pivot table now shows a summary for the retail business type, and of the total
insured values in the Midwest region, only $5.7 million is for retail businesses with
flood coverage. After reporting on this business type, you can show all the data again.

3. To see a summary for all the business types, choose (All) from the top of the report fil-
ter list of items.

The pivot table shows the insured values for all business types.
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Filtering for Multiple Items
The next report that the claims manager wants is for office buildings and apartments in the
Midwest. These are similar types of business, and your report should show a combined total
for these. You’ll apply a filter to see both Apartment and Office Bldg policies.

1. In the pivot table, click the drop-down arrow for the BusType report filter.

2. At the bottom of the list, add a check mark next to Select Multiple Items.

3. Check boxes appear beside the business type items, and the currently selected item is
checked. In your pivot table, (All) is selected, so all the items are checked (see Figure 3-7).

Figure 3-7. You can select multiple items in the Report Filter list.

4. To quickly remove the check marks from all the items, click the (All) check box to
remove its check mark. This clears all the check marks in the list.

■Note Unless at least one item is selected, the OK button will not be available.

5. Add check marks to Apartment and Office Bldg. You may have to scroll down the list to
see the Office Bldg item by using the scrollbar at the right side of the Report Filter list.

6. Click OK to close the list and to apply the filter.

The BusType report filter now shows (Multiple Items), indicating that two or more items
have been selected (see Figure 3-8). The pivot table shows the summarized values for the
apartment and office building policies, and you can report that most of the insured value is 
for policies with flood coverage.

Figure 3-8. Multiple items are selected in the Report Filter list.
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Removing a Report Filter
If you no longer need a report filter, you can remove it from the pivot table. For now, you’re fin-
ished analyzing the policies by business type, so you’ll remove the report filter:

1. Select a cell in the pivot table.

2. In the PivotTable Field List pane, remove the check mark from the BusType field name.

The report filter is removed from the pivot table, and the values are a summary of all the
records in the source data.

When you remove a filtered field from the pivot table layout, its last setting is remem-
bered. Before removing the BusType field from the pivot table layout, you selected the
Apartment and Office Bldg items to filter the pivot table. In the PivotTable Field List pane, the
BusType field still shows a filter icon, indicating that the field has a filter applied. Because the
field is not in the pivot table layout, the filter currently has no effect on the displayed data.

To see the retained filter, you can examine the BusType field in the PivotTable Field List
pane. You will also be able to change the filter settings for the field.

1. In the PivotTable Field List, click the BusType field.

2. Click the arrow in the field name (see Figure 3-9) to open the field’s sort and filter list.

Figure 3-9. Filter icon and arrow in the PivotTable Field List pane

3. In the sort and filter list, you can see that the Apartment and Office Bldg items are still
checked. The check mark to the left of the filter list indicates that the field has a filter
applied (see Figure 3-10).

Figure 3-10. Filter and sort list
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4. Even though the BusType field isn’t in the pivot table layout, you can change its filter
settings. To remove the filter, click Clear Filter from “BusType” (shown in Figure 3-10).

5. The filter and sort list closes, and the filter icon is removed from BusType in the 
PivotTable Field List pane.

Updating the Pivot Table
After you create a pivot table, it remains connected to the source data. If you make changes to
the source data, add new records, or delete records, you can update the pivot table to reflect
those changes. In the following sections, you’ll make some changes to your source data, and
then you’ll see the effect of the changes in the pivot table.

Changing the Source Data
You have learned that there is an error in the insured value of one of the policies in the source
data, and you have to correct the amount. Also, another policy has been sold, and you must
add that information to the source data. You’ll go to the Excel table that contains the source
data and make the changes:

1. A quick way to go to the source data table is to use the Name box, which is located to
the left of the Formula Bar, above the worksheet. Click the arrow in the Name box, and
in the drop-down list, click Insurance, which is the name of the Excel table that con-
tains the source data (see Figure 3-11).

Figure 3-11. Select a name in the Name box.

2. Sheet1, where the Excel table is located, is activated, and the entire Excel table is
selected. In row 10, for policy 100208, select the InsuredValue ($30,000), which was
entered with an incorrect amount.

■Note If policy 100208 is not in row 10, you can sort the policies by the policy number in Column A.

3. Type the correct entry, which is $3,000,000, and then press the Enter key to complete
the correction.
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4. Next, you’ll move to the end of the table and enter a new record. A quick way to move
down in a column is to point to the bottom border of the active cell (if it’s not a head-
ing cell) and double-click (see Figure 3-12). This will take you to the bottom of the table
if there are no blank cells in the active column. Otherwise, it will stop at the cell above
the first blank cell.

Figure 3-12. Double-click the bottom border of the active cell.

■Tip To move down a column using the keyboard, tap the End key and then the down arrow key. This will
take you to the bottom of the table if there are no blank cells in the active column. Otherwise, it will stop at
the cell above the first blank cell.

5. To move to the last column in the last record, double-click the right border of the
active cell.

■Tip If there is no other data on the worksheet, you can press Ctrl+End to go to the last cell in the table.

6. Now that you’re in the last cell in the Excel table, press the Tab key to create a new
blank record in the table and to move to the first cell in that new record.

7. In the Policy column, type an apostrophe and the next available number, as in
'101127. The leading apostrophe will force Excel to treat the policy number as text and
will ensure that any leading zeroes are retained.

8. Press the Tab key to move to the next column, and add the rest of the data for the new
record, as shown in Figure 3-13.

■Tip To copy a value from the cell above, hold the Ctrl key, and type an apostrophe.

Figure 3-13. New record in the insurance table

9. After typing Y in the Flood field, press the Enter key to complete the entry without cre-
ating a new record.
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Viewing New Data in the Pivot Table
Now that you’ve completed the changes to your source data, you’ll return to the pivot table
and update it so you can see the revised summary of the insurance data. You corrected an
InsuredValue amount in the East region and added a new policy for the Midwest, so the totals
for those regions should increase, as should the grand total.

1. Switch to Sheet4, and select any cell in the pivot table. This makes the pivot table
active and displays the PivotTable Field List pane.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Data group, click the top section of the Refresh command to update the pivot
table with the new and revised data (see Figure 3-14).

Figure 3-14. The Refresh command in the Data group on the Ribbon

4. In the pivot table, the data is refreshed, and it shows new totals for the East and Mid-
west regions and a new Grand Total amount (see Figure 3-15). For comparison, the old
totals are shown in Figure 3-15 but won’t remain on your worksheet.

Figure 3-15. The refreshed pivot table shows new totals.

■Tip To quickly refresh the pivot table, right-click a cell in the pivot table, and in the context menu, click
Refresh.
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Changing the Summary Function
Currently, the pivot table shows a Sum of InsuredValue item for each region. Instead of seeing
a dollar value, you’d like to know how many policies have been sold in each region for those
with flood coverage and for those without. You’ll change a setting in the pivot table so you can
see a different summary for the InsuredValue field:

1. In the pivot table, right-click a cell in the Values area, such as cell C7.

2. In the context menu that appears, click Summarize Data By. In the list of functions, the
Sum function is checked, because it is the function that is currently used for the
InsuredValue field.

3. Click Count to summarize the data by that function (see Figure 3-16).

Figure 3-16. Select a different function to summarize the data.

4. In the pivot table, the data changes to show a Count of InsuredValue cell instead of a
sum (see Figure 3-17). The grand total is 928, which is the number of policy records in
the insurance table.

Figure 3-17. The Count of InsuredValue cell
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Applying a PivotTable Style
Now that you have set up the summary information the way you want it, you can spend a bit
of time on the appearance of the pivot table. Changing the appearance may make the data
easier to read, and you may want a color scheme that fits with other documents you’re pro-
ducing.

When you created the pivot table, Excel automatically applied formatting. To quickly
change the appearance of the pivot table, you can apply one of the built-in pivot table styles.
This may affect the color and font formatting and may add borders and row or column 
shading.

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the PivotTable Styles group, you can see that one of the styles is selected and has a
border around it.

4. Point to that style, and its name should appear in a ScreenTip (see Figure 3-18), unless
you have turned off the ScreenTip feature.

Figure 3-18. Pivot table styles

5. Point to one of the other pivot table styles, and the pivot table on the worksheet will
show a preview of that style.

6. To see other rows of pivot table styles, click the up or down arrow at the right end of the
PivotTable Styles group.

7. To open the full gallery of pivot table styles, click the More button at the right end of
the PivotTable Styles group (shown in Figure 3-18).

8. In the gallery, you can drag the scrollbar up and down to see the pivot table styles,
which are grouped as Light, Medium, and Dark.

9. Point to any pivot table style to see your pivot table previewed with that style. Some
styles, such as Pivot Style Medium 2, include horizontal borders and may make the
rows easier to follow in a wide pivot table. Some styles have dramatic or dark colors
that may be best suited for presentations or online viewing, rather than printing.
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■Tip If you change your mind and don’t want to apply a style, press Esc on the keyboard, or click outside
the Style gallery, and it will close without applying a style.

10. When you find a pivot table style you like, click it to apply that style to your pivot table.

■Note The first style, at the top left of the Light styles, is named None. If you click this style or click the
Clear button at the bottom left of the PivotTable Style gallery, your pivot table will not have a style. When no
style is applied, the preview function won’t work when you point to a different style in the gallery.

Deleting a Pivot Table
A workbook can contain one or more pivot tables, all based on the same data or based on dif-
ferent data. In later chapters, you’ll create workbooks with multiple pivot tables and will learn
how they interact. Although you can have many pivot tables in the workbook, occasionally
you may want to remove a pivot table completely. To practice this technique, you’ll delete the
pivot table from this workbook:

1. Before you delete the pivot table, you can save the workbook to preserve the work you did.

To delete the pivot table, you’ll select the entire pivot table, and then delete it.

2. Select a cell in the pivot table.

3. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

4. In the Actions group, click Select, and click Entire PivotTable.

5. While the pivot table is selected, press the Delete key on the keyboard. Excel deletes
the pivot table from the worksheet, and the PivotTable Field List pane disappears 
from view.

■Tip To immediately restore the pivot table, you can press Ctrl+Z or click the Undo button on the Quick
Access Toolbar (QAT), which is located above the Ribbon, beside the Microsoft Office Button.

In some cases, you may want to remove both the pivot table and the worksheet that
was inserted when the pivot table was created. If so, you can right-click the worksheet
tab, and click Delete in the context menu. When the confirmation message appears,
click Delete to permanently remove the worksheet and the pivot table.

■Caution You cannot undo the deletion of a worksheet.

6. Close the workbook, and do not save the changes when prompted. In the next chapter,
you’ll use a different workbook with different data.
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Summary
In this chapter, you expanded on your basic pivot table skills. You learned how to clear a pivot
table and how to add fields to a specific area of the pivot table.

You added a report filter and used it to view summarized data for a specific business type.
You changed the report filter and showed data from multiple items from the filter list. When it
was no longer needed, you removed the report filter.

Next, you changed data in the source table and added new data, and then you refreshed
the pivot table to update its summarized data. You changed the summary function used in the
InsuredValue field to use Count instead of Sum.

You applied a pivot table style to make the data in the pivot table easier to read.
Finally, you learned how to delete the entire pivot table from the workbook if required.
I have now covered the basics of creating a pivot table and modifying it. In the remaining

chapters, you’ll dig deeper into the pivot table features, and you’ll see how you can create
more sophisticated pivot table reports.

CHAPTER 3 ■ MODIFYING A PIVOT TABLE44

8903Ch03CMP2  7/31/07  7:43 PM  Page 44



Summarizing Data

In previous chapters, you used a pivot table to summarize insurance policy data and reported
on the grand total of insured value by region and by building construction type. In most of the
reports, you showed a total sum, and in one report you changed the report so it showed a total
count of the policies sold. In this chapter, you’ll use different data to create a pivot table, and
you’ll explore other ways of summarizing the data. You’ll work with the grand totals and
subtotals in the pivot table and learn how to group the data for a range of numbers or dates.

Exploring a Work Orders Example
To follow the examples in this chapter, download and open the sample file named 
WorkOrders_01.xlsx, available at www.apress.com. In this workbook, you’ll find data about 
your company’s service call work orders, including the costs, labor hours, payment type,
whether parts or labor are covered under warranty, and other dates. Figure 4-1 shows a 
sample of the data.

Figure 4-1. Service call work orders data

You’ll use a pivot table to summarize the work order data to see the following:

• Which technicians are working the most

• Which service types require the most rush jobs

• The average time spent on a service call

• One year’s results versus the next
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■Note In the sample file, an Excel table named WorkOrders has been created from the work order data. If
you are using your own data to work through the instructions in this chapter, you should create an Excel
table from your data and then name the Excel table.

Your first task is to create a report on the average hours that each technician spends on
the different types of service calls. This will help your service coordinator schedule the service
calls, because you’ll know how long each type of job normally takes. To get started, you’ll
check the source data to see which fields contain the data that you need for your report and
then create a pivot table with those fields:

1. In the Excel table named WorkOrders on Sheet1, you can see the technician names in
the LeadTech column. In the Service column, you can see the service type, such as
Install or Repair. The final field you’ll use in this report is LbrHrs, which is the total
hours of labor on the service call.

2. From the Excel table, create a pivot table on a new worksheet. In the PivotTable Field
List pane, put the LeadTech field in the Row Labels area, Service in the Column Labels
area, and LbrHrs in the Values area, where it will become Sum of LbrHrs.

This report gives you an overview of the type of service that each technician is doing, with
a sum of labor hours, as shown in Figure 4-2.

Figure 4-2. Sum of labor hours per service type

■Note In this chapter’s figures, some column widths have been manually adjusted.

Using the Summary Functions
Because the LbrHrs column in the source data consists of numbers only, it was automatically
summarized as Sum of LbrHrs when you added it to the pivot table. If the LbrHrs field had
contained cells with text or blank cells, it might have been summarized as Count of LbrHrs.
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You’ll make a change to the LbrHrs summary function to show the average time that each
technician spends on each type of service:

1. Right-click one of the LbrHrs cells in the pivot table, such as cell B5, which contains
the total hours that Burton spent doing assessments.

2. From the context menu, choose Summarize Data By, and click Average.

3. The pivot table now shows the average labor hours per technician for each service
type, and the label at the top left of the pivot table has changed from Sum of LbrHrs to
Average of LbrHrs (see Figure 4-3).

Figure 4-3. Average labor hours per technician for each service type

Your report now shows the average hours per technician for each service call type. How-
ever, because the number of decimal places vary within the pivot table columns, it’s hard to
visually compare the results. You’ll format the numbers so they are consistent, and the sum-
mary will be easier for you and other readers to understand at a glance:

1. Right-click one of the LbrHrs cells in the pivot table, such as cell E7.

2. From the context menu, choose Number Format (see Figure 4-4).

Figure 4-4. Number Format command on the context menu

3. The Format Cells dialog box opens, with only the Number tab available.

4. From the Category list, select Number.

For this data, two decimal places will be sufficient, because 0.01 hour is just 36 sec-
onds, and the service coordinator doesn’t require anything beyond that level of
precision. In other situations, you may require more decimal places.

5. For Decimal Places, select 2, and then click OK to close the Format Cells dialog box.
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With the values all showing the same number of decimal places, it’s much easier to compare
the data and to see that installations have the highest average time (see Figure 4-5). Thanks to
your report, the service coordinator will be able to schedule enough time for those jobs.

Figure 4-5. Consistent number formatting makes comparisons easier.

When you add date and number fields to the Values area, Sum is the default summary
function, and when you add text fields to the Values area, Count is the default summary func-
tion. Although these are the most commonly used functions, other functions may be required
for some of your pivot table analysis. Including Sum and Count, you can use 11 summary
functions for the value fields; Table 4-1 shows a brief overview of these functions.

Table 4-1. Summary Functions

Function Description Similar Worksheet Function

Sum Totals the source data SUM

Count Counts numbers, text. and errors in the COUNTA
source data

Average Totals the source data and divides by the AVERAGE
number of values

Max Shows the highest value from the source data MAX

Min Shows the lowest value from the source data MIN

Product Multiplies all the source data and may result PRODUCT
in a very large number

Count Numbers Counts the numbers in the source data COUNT

StdDev Shows the standard deviation for a sample of STDDEV
the source data

StdDevp Shows the standard deviation for the entire STDDEVP
population for the source data

Var Shows the variance for a sample of the VAR
source data

Varp Shows the variance for the entire population VARP
for the source data

The first six summary functions—Sum, Count, Average, Max, Min, and Product—are
available on the context menu when you right-click a value cell in the pivot table. To give the
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service coordinator a better idea of the range of times required for a job, you’ll create two
more reports, using the Min (minimum) and Max (maximum) functions:

1. Right-click a cell in the Values area, and in the context menu, click Summarize Data By
and then Max to see the longest time that each technician spent on each service type.

2. Using the context menu, click Summarize Data By and then Min to see the shortest
time that each technician spent on each service type.

You can apply the remaining summary functions by using the More Options command, as
described next. You’ll create one more report for the service coordinator by using the StdDevp
(standard deviation) function.

1. Right-click a value cell in the work orders pivot table.

2. In the context menu, click Summarize Data By, and click More Options.

3. In the Value Field Settings dialog box, click the Summarize By tab.

4. In the Summarize Value Field By list, select StdDevp, and click OK. The pivot table now
shows the standard deviation of labor hours per service type for each technician.

This compares the labor hours for each job to the average labor hours for that techni-
cian on that type of job. A lower number means that there is less variance in the labor
hours. Because all the deliveries are a fixed time of .25 hours, the standard deviation 
is zero for all the technicians. Assessments ranged from .25 hours to 2 hours, so the
standard deviation for all the technicians is low. For installation jobs, the standard
deviation is much higher for most of the technicians, and this indicates there is a wide
range of times for repair jobs. For example, Michner’s labor hours ranged from 1 to
19.5 hours, resulting in a standard deviation of 3.79. The StdDevp function was used
instead of StDev because the source data for the pivot table is all the service call data
(the entire population) for the company for the past two years. If you had only a sam-
ple of the service call data, you could use the StDev function.

5. To complete the analysis, reapply the Average summary function by using the context
menu.

The pivot table now shows the average time per service type for each technician.

Showing Multiple Value Fields
Now that you have calculated the average times, the service coordinator has asked you to
show a count of jobs where the labor was done under warranty. You check the source data and
see a column with the heading WtyLbr. WtyLbr is a text field that contains Yes if the labor is
covered by warranty.
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Currently, the pivot table shows the Average of LbrHrs values, and you’ll add the Count of
WtyLbr values to show how many service calls were performed under a labor warranty:

1. Select a cell in the pivot table so the PivotTable Field List pane is visible.

2. In the PivotTable Field List pane, drag the WtyLbr field to the Values area, where it will
default to Count of WtyLbr, because it is a text field.

3. In the pivot table, a second column of values, with the heading Count of WtyLbr,
appears for each service type (see Figure 4-6).

Figure 4-6. Two value fields in the pivot table

With the two value fields now in the pivot table, you can see that Assessments had the
greatest number of jobs done under a labor warranty and that Michner is the technician with
the highest average labor hours per assessment call.

Changing the Value Field Headings
When a field is added to the Values area of the pivot table, its heading cells show its summary
function and its field name. For example, in your pivot table the value fields have the rather
long headings of Average of LbrHrs and Count of WtyLbr. To make the headings easier to read,
you can shorten them:

1. Select a cell in the pivot table to activate it.

2. In the PivotTable Field List pane, click the Average of LbrHrs field within the Values
area, and click Value Field Settings (see Figure 4-7).

Figure 4-7. Value Field Settings option in the PivotTable Field List pane
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3. In the Value Field Settings dialog box, type Avg Hrs in the Custom Name box.

4. Click OK to close the Value Field Settings dialog box.

A quicker way to change the value field heading is to make the change directly in a pivot
table cell:

1. In the pivot table, select one of the cells that contains the heading Count of WtyLbr.

2. In the cell, type Wty Lbr, and then press the Enter key to complete the change. All the
Count of WtyLbr headings show the revised custom name.

■Tip The custom name cannot be the same as the field name in the source data. You can add a space in
the text, or at the end of the text, to make the custom name slightly different from the field name.

In the pivot table and in the Values area of the PivotTable Field List pane, the value fields
now show the custom names you entered. As a result, the columns can be narrower, and the
headings are easier to read.

Showing Multiple Summaries for One Value Field
Now that you’ve finished your reports for the service coordinator, the accountant wants a
report on the total service fees and average fee for each type of service call. You’ll change the
pivot table fields to focus on the fees collected instead of on the hours.

Before you make any changes to the pivot table, you check the source data to see which
fields you’ll use to calculate the fees. The TotalFee column includes the labor fees and parts
fees for each work order and shows the total amount collected on the work order.

In the labor hour reports, you used two different fields in the Values area. For this report
you’ll add two copies of the TotalFee field to the Values area and use a different summary func-
tion in each copy. You’ll clear the pivot table to get a fresh start, and then you’ll add the fields
you need for the accountant’s report:

1. Select a cell in the pivot table to activate it.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Actions group, click Clear, and click Clear All to remove all the fields from the
pivot table.

4. In the PivotTable Field List pane, add Service to the Row Labels area, and add TotalFee
to the Values area.

5. In the pivot table, change the heading for Sum of TotalFee to Total WO.

6. In the PivotTable Field List pane, drag another copy of TotalFee to the Values area,
where it will become Sum of TotalFee.

7. In the PivotTable Field List pane, click the Sum of TotalFee field in the Values area, and
choose Value Field Settings.
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8. In the Value Field Settings dialog box, select the Average function on the Summarize By
tab.

9. Enter Avg WO for Custom Name.

10. Click the Number Format button, and change the number format to Currency.

■Note The currency symbol in your pivot table will depend on the regional settings in your computer.

11. Click the OK button to close the Format Cells dialog box, and then click OK to close the
Value Field Settings dialog box.

12. To make the pivot table easier to read, change the number format for the TotalFee field
to the Currency format.

The pivot table now shows the total charged for each service type and the average amount
charged for each service type (see Figure 4-8). Replacements have the highest total fees col-
lected, and installations have the highest average fee.

Figure 4-8. Two copies of the same value field in the pivot table

Changing the Order of the Value Fields
Once you have multiple value fields in the pivot table, you may want to rearrange them. You’ll
move the Avg WO field so it is to the left of the Total WO field in the pivot table layout:

1. Select a cell in the pivot table to activate it.

2. In the PivotTable Field List pane, in the Values area, drag the Avg WO field so it is above
the Total WO field.

■Tip Don’t drag the field too high, or it will be removed from the pivot table layout. If the pointer has a cir-
cle with a bar through it, that indicates the field cannot be dropped in its current location.
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3. As you drag the field, a light gray bar will appear above the Total WO field, indicating
where the field will be dropped (see Figure 4-9).

Figure 4-9. Drag a value to a new position in the PivotTable Field List pane.

4. Release the mouse button, and the Avg WO button will drop above the Total WO button.

In the pivot table on the worksheet, the value fields switch places, and the Avg WO col-
umn is to the left of the Total WO column. Another way to change the value field order is to
make the change directly in the pivot table.

1. In the pivot table, select the cell that contains the heading Avg WO.

2. Point to the border of the cell, and when the pointer changes to a four-headed arrow,
drag the heading cell to the right of the Total WO cell.

3. As you drag the field, a gray bar will appear to the right of the Total WO field, indicating
where the field will be dropped (see Figure 4-10).

Figure 4-10. Drag a value to a new position in the pivot table.

4. Release the mouse button, and the Avg WO field will drop to the right of Total WO.

In the PivotTable Field List pane, the value fields switch places, and Avg WO is below Total WO.

Changing the Position of the Value Fields
When you add multiple value fields to a pivot table, their headings appear, by default, in the
column area. If you prefer, you can move the headings to the row area, where the value fields
will be listed vertically instead of horizontally.
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In the PivotTable Field List pane, Excel automatically adds a special field button when
multiple value fields are in the layout. You’ll use that button to relocate the value fields.

1. Select a cell in the pivot table to activate it.

2. In the PivotTable Field List pane, in the Column Labels area, locate the ∑Values button
that represents the value field labels (see Figure 4-11).

Figure 4-11. Value field labels in the PivotTable Field List pane

3. Drag the ∑Values button to the Row Labels area, below the Service field.

4. Release the mouse button, and the value field labels will move to the Row Labels area.

In the pivot table, the value field labels are listed under each service type. To see the sum-
mary differently, you could move the ∑Values field in the PivotTable Field List pane so it’s
above the Service field in the Row Labels area. With that layout, the services would be listed
under each value field heading.

Showing or Hiding Grand Totals
On some service calls, two technicians are required instead of just one. The service manager
wants a report on the labor costs for one-technician and two-technician jobs for each type of
service call. You check the source data and see a column with the heading Techs. The number
in that column indicates whether one or two technicians were required. You can use the col-
umn with the heading LbrCost to show the total labor costs for each work order.

First you’ll clear the pivot table layout, and then you’ll add different fields so you can ana-
lyze the labor cost for each type of service call:

1. Select a cell in the pivot table to activate it.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Actions group, click Clear, and click Clear All to remove all the fields from the
pivot table.

4. In the PivotTable Field List pane, add Service to the Row Labels area, and add LbrCost
and LbrHrs to the Values area.

5. In the PivotTable Field List pane, drag the ∑Values button to the Column Labels area
so the value fields are arranged horizontally.

The pivot table now shows the total labor cost for each service type, and there is a grand
total at the bottom of the pivot table that totals the columns of labor costs and labor hours for
all services (see Figure 4-12). These are the grand totals for columns.
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Figure 4-12. Grand totals for columns

Because there are no label fields in the Column Labels area, the pivot table has no grand
totals for rows. There is nothing in the pivot table that should be totaled across the row—labor
cost and labor hours are different fields and shouldn’t be totaled.

The service manager wants the summary by one- and two-technician calls, so you’ll add
the Tech field to the Column Labels area:

1. In the PivotTable Field List pane, remove the check mark from LbrHrs. This will remove
it from the pivot table to simplify the layout for now.

2. In the PivotTable Field List pane, drag the Techs field to the Column Labels area.

Now that there is a field in the Column Labels area, there is a grand total for rows at the
right of the pivot table, which shows the total labor cost for each service type (see Figure 4-13).
There is still a grand total for columns at the bottom of the pivot table, which totals the labor
costs and shows the total cost for one-technician calls, the total cost for two-technician calls,
and the total for all calls.

Figure 4-13. Grand totals for rows and grand totals for columns

When you add fields to the Row Labels or Column Labels area, Excel automatically adds
the grand totals to the pivot table layout. In some cases, you may not want either of the grand
totals displayed. You’ll hide the row grand total at the right of the pivot table. This will reduce
the number of columns in the pivot table and will help focus the reader’s attention on the
comparison between one-technician and two-technician calls.

1. Select a cell in the pivot table to activate it.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.
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3. At the far left, in the PivotTable group, click the Options command (see Figure 4-14) to
open the PivotTable Options dialog box.

Figure 4-14. The pivot table Options command

4. On the Totals & Filters tab, in the Grand Totals section, remove the check mark for
Show Grand Totals for Rows (see Figure 4-15).

Figure 4-15. Set the grand totals options

5. Click OK to close the PivotTable Options dialog box.

The grand totals for rows, at the right of the pivot table, have been removed, and the
grand totals for columns are still visible. The one-technician and two-technician calls can be
compared, without the distraction of the grand totals for rows.

When you want to see the grand totals for rows again, you can use a command on the
Ribbon to turn them on. You’ll show the grand totals for rows in your pivot table again:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the Layout group, click the Options command to open the PivotTable Options dialog
box.

4. Click On For Rows and Columns.

The grand totals for rows reappear in the pivot table.
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Creating Subtotals
The accountant likes the labor cost report you produced and has asked to see the labor costs
broken down by rush and nonrush calls for each service type. In the source data, you find a
column with the heading Rush. If a rush job was requested, a Yes is entered in that column.
You’ll add the Rush field to the pivot table layout.

Currently your pivot table has one field in the Row Labels area and one field in the Col-
umn Labels area. When you add a second field to the Row Labels area, subtotals will be
created.

1. Select a cell in the pivot table to activate it.

2. In the PivotTable Field List pane, add a check mark to the Rush field.

Excels adds the Rush field to the Row Labels area in the pivot table, and each label in the
Service field shows a subtotal of the Rush labels below it (see Figure 4-16). The rows with a Yes
label are the rush calls, and the rows with a (blank) label are the nonrush calls.

Figure 4-16. Subtotals for Row Labels area

Excel will also add subtotals to the pivot table if you place more than one field in the Col-
umn Labels area. To see a more detailed breakdown of the labor costs, you’ll add the LeadTech
field to the pivot table layout. That will let you see, for one-technician and two-technician
jobs, what each technician’s total labor costs are.

1. Select a cell in the pivot table to activate it.

2. In the PivotTable Field List pane, drag the LeadTech field to the Column Labels area,
above the Techs field.

The LeadTech field is added to the Column Labels area in the pivot table and subtotals the
labor costs for one-technician and two-technician jobs (see Figure 4-17).

Figure 4-17. Subtotals for Column Labels area
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When there are multiple fields in the Row Labels area or the Column Labels area, the last
field in the list of fields is called an inner field (see Figure 4-18). All the fields above it in the list
of fields are called outer fields. Only the outer fields automatically display subtotals. The inner
field does not.

In Figure 4-18 the District field has been added to the Row Labels area.

Figure 4-18. Inner and outer fields in the PivotTable Field List pane

Because it is the last field in the list of Row Labels, District is the inner field and doesn’t
display subtotals. Rush, which was previously the inner field, becomes an outer field, and 
displays subtotals. Remove the District field, and the Rush is once again the inner field.

Showing or Hiding Subtotals
As you have seen, subtotals are automatically added when multiple fields are placed in the
Row Labels area or Column Labels area of the pivot table. Although the subtotals can add use-
ful information, you don’t always want them in the pivot table. To simplify a pivot table layout,
you may want to hide the subtotals for one or more of the pivot fields.

First you’ll change the subtotal settings for all the fields in the pivot table, and later you’ll
adjust the settings for individual fields. Because the pivot table looks a bit crowded, with all
the columns of labor costs, you’ll turn off all the subtotals in the pivot table to see whether
that improves the appearance.

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Subtotals command (see Figure 4-19).

4. Click Do Not Show Subtotals.

Figure 4-19. Subtotals command on the Ribbon
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The Service labels remain in the pivot table, but the labor costs have been removed from
those rows. The columns with total labor costs for each lead technician have also been
removed. The grand totals for rows and grand totals for columns remain in the pivot table.

It was easy to hide the subtotals for all the fields in the pivot table, but now suppose you’d
like to show the subtotals for the Service field to see the total cost per service type. You’ll
change the subtotal setting for just that field:

1. In the pivot table, right-click one of the Service labels, such as cell A6.

2. In the context menu, click the Subtotal “Service” option.

The LeadTech subtotals remain hidden, but the subtotals for the Service field are now vis-
ible. The grand totals for rows and columns remain in the pivot table.

Showing Subtotals Above or Below Items
In a pivot table layout, subtotals for the Row fields can appear above or below the items that
they subtotal. Currently, the Service field in your pivot table has its subtotals displayed above
its items. You’ll change one of the pivot table settings to display all the subtotals again and
select a position in which to display the row subtotals:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Subtotals command.

4. Click Show All Subtotals at Top of Group.

■Note Changing this setting will affect the position of the subtotals in all the row fields in the pivot table.

The subtotals for the Service field appear above the rush items. Because the Rush field is
the last field in the Row Labels area, with no items below it, the Rush field is an inner field and
does not display subtotals. The LeadTech field, in the Column Labels area, also shows subto-
tals again, but these come after the LeadTech items. Only the subtotals in the Row Labels area
change position.

Next, you’ll apply the remaining option for subtotals to display them below the items.

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Subtotals command.

4. Click Show All Subtotals at Bottom of Group.
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The outer row field, Service, displays a heading row with only a label at the top of the
group and a subtotal row at the end of the group of items (see Figure 4-20). The Column
Labels subtotals do not change.

Figure 4-20. Subtotals at bottom of group

Changing the Function for a Subtotal
When subtotals appear in the pivot table, they automatically use the Sum function to total the
data in the group. You can change the function that is used to summarize the value fields just
as you changed the summary function for a value field. You’ll change the summary function
for the Service subtotals to see a count instead of a sum.

■Note If there are multiple value fields in the pivot table, the subtotal functions will be the same for all
value fields. You can’t apply different summary functions to the individual value fields in a pivot table.

1. In the pivot table, right-click one of the Service labels, such as cell A6.

2. In the context menu, click Field Settings to open the Field Settings dialog box.

3. On the Subtotals & Filters tab, in the Subtotals section, select Custom (see Figure 4-21).

4. In the list of functions, click Count, and then click OK to close the Field Settings 
dialog box.

The subtotals for the Service field now show the count of records for each service type, and
the label for the subtotal has changed to end with Count, instead of Total. For example, the first
service type is Assess, and its subtotal label has changed from Assess Total to Assess Count.

■Note If you point to a custom subtotal value, the pivot table tool tip will show the name of the value field,
not the summary function used in the subtotal. For example, if you point to cell B9, its tool tip title is Sum of
LbrCost, not Count of LbrCost. The Row information in the tool tip is correct and shows Row: Assess Count.
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Figure 4-21. Custom functions for subtotals

Creating Additional Subtotals
When subtotals are automatically created in the pivot table, there is only one subtotal row per
item. You can create additional subtotals to show other summary functions. Your pivot table
currently shows the sum of labor cost in the Service field. You can add another subtotal to the
field to show the highest labor cost.

■Note If you include more than one subtotal for a field, the subtotals for that field are shown at the bottom
of the group, even if you have selected Show All Subtotals at Top of Group.

1. In the pivot table, right-click one of the Service labels, such as cell A6.

2. In the context menu, click Field Settings to open the Field Settings dialog box.

3. On the Subtotals & Filters tab, in the Subtotals section, select Custom.

4. In the list of functions, click the Sum function and the Max function.

5. Click the OK button to close the Field Settings dialog box.
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The accountant’s report on labor costs is now completed. The subtotals for the Service
field show the sum of labor cost and the highest labor cost, while the label for each subtotal
shows its summary function name (see Figure 4-22).

Figure 4-22. Multiple subtotals

■Note Grand totals may be incorrect for subtotals if the function used is different from the function used in
the value field. You may want to hide the grand totals when using subtotals with custom functions.

Grouping Numbers and Dates
Up to this point, you’ve added fields to the Row Labels area and Column Labels area and then
summarized the value fields by the labels that automatically appear. For example, when you
added the Service field to the Row Labels area, the labels Assess, Deliver, Install, Repair, and
Replace appeared in column A, and you summarized the labor hours or labor costs for each of
those labels.

In a pivot table, you can group numbers, dates, or text to create new labels and summa-
rize the data by these groups. For example, if your source data contains dates, you can group
the dates by year to show annual totals. If the source data has numeric test scores, you can
group the numbers into 1–50 and 51–100 and show a count of results in each range of scores.

Grouping Numbers
The service manager wants to know how long customers are waiting for a service call. In the
source data, you can see a column with the heading Wait. This is the number of days between
the request date (ReqDate) and the day of the service call (WorkDate). To create a count, you’ll
use the WO field, which is the work order number. Every row has a work order number, so this
will give you a reliable count.
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You’ll add the Wait field to the pivot table and organize the numbers into groups to create
new labels. To start, you’ll remove all the fields from the pivot table layout and then add differ-
ent fields:

1. In the PivotTable Field List pane, remove the check marks from all the fields. The
empty pivot table appears on the worksheet.

2. In the PivotTable Field List pane, drag the Wait field to the Row Labels area.

3. Drag the WO field to the Values area, where it will become Count of WO, because the
work order numbers are stored as text.

In the Row Labels area, you can see all the wait days listed, and in the next column is the
count of work orders for each wait period. For example, 19 work orders had a 2-day wait, and
68 work orders had an 8-day wait (see Figure 4-23).

Figure 4-23. Wait days in the row labels

This level of detail may be required occasionally, but you could group the wait days,
instead of listing each number individually. For example, you could list the days in groups of
seven days, which would group the wait days into week lengths. This would give you a shorter
list of items and would make it easier to spot which wait lengths are most common.

1. In the pivot table, select a cell in the Wait labels area, such as cell A5.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Group group, click Group Field (see Figure 4-24).

Figure 4-24. Group Field command

■Note The Group Field command is available only if the currently selected field is a number or date field.
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4. In the Grouping dialog box, the lowest and highest number from the Wait field are
automatically entered as the Starting At and Ending At numbers. The By box contains a
10, which is the default number for grouping (see Figure 4-25).

5. Leave the Starting At box set at zero, which is the lowest number in the data source.

Figure 4-25. Grouping dialog box

6. In the By box, type 7, which is the number of wait days you want in each group.

7. Click the OK button to close the Grouping dialog box.

Instead of individual wait days, the row labels now show number groups in seven-day
intervals, such as 0–6 and 28–34 (see Figure 4-26).

Figure 4-26. Grouped numbers for Wait labels

You can send your report to the service manager, showing that most customers had a two-
to three-week wait for service.

Ungrouping Items
If your pivot table contains groups, you may want to remove them. You’ll remove the grouping
from the Wait field to show the individual numbers again.

1. Right-click a cell that contains a Wait label, such as cell A5.

2. In the context menu, click Ungroup.

The grouping is removed from the Wait field, and the individual Wait days are shown.
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Grouping Dates
You can also group dates in a pivot table field to display a range of dates under one label. To
determine the busiest times of the year, the service manager wants a report that shows a count
of service calls for each month. The WorkDate field in your source data contains dates that
span almost two years. Instead of summarizing the data by the individual work dates, you can
group the dates by year and month. You’ll remove the Wait field from the pivot table and move
the WorkDate field into the Row Labels area:

1. In the PivotTable Field List, remove the check mark from the Wait field.

2. Add a check mark to the WorkDate field to add it to the Row Labels area.

In the Row Labels area, you can see all the work dates listed, and in the next column is
the count of work orders for each day. However, the list is very long, and you want to
see a summary for each month, instead of each day.

3. In the pivot table, right-click a cell that contains a WorkDate label, such as cell A5.

4. In the context menu, click Group.

5. In the Grouping dialog box, the earliest date in your source data appears in the Starting
At text box. The latest date in your source data appears in the Ending At text box. You
can leave these default entries.

6. In the By list, select Years and Months as the interval for your grouping (see Figure 4-27).

Figure 4-27. Grouping dialog box

7. Click the OK button to close the Grouping dialog box.

Instead of individual dates, the row labels now show Years and Months so the service
manager can see the number of work orders that were completed in each month.
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In the PivotTable Field List pane, Excel adds a Years field to the end of the field list. You
grouped by Years and Months so that the data for each year is summarized separately. If you
selected only Months, the January data for both years would have been summarized together.

Grouping Selected Items
The service manager has assigned each technician to one of two teams, Team A and Team B.
To see how the work orders have been split between the two teams, you’ll create a report that
counts the work orders for each group.

The Group Field command and Grouping dialog box work only for number and date
fields. For text fields, you can select and group labels to display those items together. You’ll
remove the WorkDate field from the pivot table and move the LeadTech field into the Row
Labels area:

1. In the PivotTable Field List pane, remove the check marks from the WorkDate field and
from the Years field.

2. Add a check mark to the LeadTech field to add it to the Row Labels area.

In the Row Labels area, you can see all the technician names listed, and in the next col-
umn is the count of work orders for each technician. You’ll group the lead technicians into the
two teams—Burton, Ling, and Tremblay are in Team A, and Khan, Michner, and Mugford are
in Team B.

1. In the pivot table, select cell A4, which contains the label for Burton.

2. Hold the Ctrl key, and select cells A6 and A9, the labels for Ling and Tremblay.

3. With the three labels selected, on the Ribbon, under the PivotTable Tools tab, click the
Options tab.

4. In the Group group, click Group Selection.

This creates a new field named LeadTech2, which you can see in the PivotTable Field List
pane, and a new set of labels in the pivot table. The group you created for the selected techni-
cians is labeled Group1, and each of the remaining technicians has a separate label (see 
Figure 4-28).

Figure 4-28. Group selected labels
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Next, you’ll group the remaining technicians:

1. In the pivot table, select cell A9, which contains the label for Khan. You can select
either the outer label or the inner label, and the result will be the same.

2. Hold the Ctrl key, and select the labels for Michner and Mugford. If you selected an
outer label in Step 1, continue to select outer labels. If you selected an inner label in
Step 1, continue to select inner labels.

3. With the technician labels selected, on the Ribbon, under the PivotTable Tools tab,
click the Options tab.

4. In the Group group, click Group Selection.

This creates another item, named Group2, in the LeadTech2 field.
When you create groups by using the Group Selection command, they are automatically

given a numbered name, such as Group1. You can change these names, so they are more
meaningful as headings in the pivot table. You’ll change the group labels so they show the
team names:

1. Select cell A4 that contains the Group1 group label.

2. Type Team A as a new name for the group.

3. Press the Enter key to complete the name change.

4. Rename the Group2 group label as Team B (see Figure 4-29).

Figure 4-29. Group labels renamed

The pivot table now shows the lead technicians grouped into their teams. If you want to
see the total for each team, you can turn on subtotals, above or below the group items. To see
the team totals without the technician names, remove the check mark from LeadTech in the
PivotTable Field List pane.

■Note If you want to ungroup items that you grouped by selecting them, you will have to ungroup each
group separately. Click a group’s label cell, and then click the Ungroup command in the Ribbon. When the
groups have all been ungrouped, the field’s name will be removed from the PivotTable Field List pane.
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You can save your file now as WorkOrders_02.xlsx. That will leave the original file
unchanged since its last save, and you can use the new file for your work in the next chapter.

Summary
In this chapter, you learned different ways to summarize the data in the pivot table. First, you
changed the function that was used for a value field and tested the result of using different
functions. You added multiple value fields and summarized the same value field using differ-
ent functions.

Next, you hid and showed the grand totals for rows and columns, added subtotals to the
outer fields in the pivot table, and positioned the subtotals above or below the items.

Finally, you grouped the items in the row fields to summarize by a range of numbers or a
date range. For the text field, you manually selected and grouped the items.

I have now covered the basics of summarizing the pivot table data, and next you’ll apply
formatting to enhance the presentation of the data.
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Formatting a Pivot Table

In this chapter, you’ll continue to work with the WorkOrders pivot table. First, download and
open the sample file WorkOrders_02.xlsx. You’ll add formatting to the pivot table to enhance
the data presentation. With suitable formatting, you can make the pivot table easier to read,
and you can highlight specific data. You’ll also apply, modify, and create pivot table styles and
themes in order to make formatting consistent throughout your workbook.

Controlling the Report Layout
First you’ll experiment with the overall layout options for the pivot table. Three layouts are
available for pivot tables: Compact Form, Outline Form, and Tabular Form. When you create a
new pivot table, it is automatically formatted with the Compact Form layout. You’ll apply the
other two layouts to your pivot table and then reapply the Compact Form layout so you can
see the differences.

Applying Outline Form Layout
The first layout you’ll apply is the Outline Form layout to see how it differs from the Compact
Form layout. Before changing the report layout, you’ll turn on the subtotals so you can also
see how they are affected by the layout changes:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Subtotals command, and click Show All
Subtotals at Top of Group.

4. In the Layout group, click the Report Layout command, and click Show in Outline
Form (see Figure 5-1).
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Figure 5-1. Report Layout menu options

After you’ve applied the Outline Form layout, the row labels change from using one 
column for all the labels to using a separate column for each field (see Figure 5-2). In the 
Compact Form layout, the labels are all shown in column A, under the heading Row Labels.
In Outline Form layout, there are two headings—LeadTech2 is in cell A3, and LeadTech is in
cell B3. Below each heading are the labels for the field that is named in the heading cell.

Figure 5-2. Compact Form (on the left) and Outline Form (on the right) layouts

The Outline Form layout may be useful when you want to show all the field names as
heading labels and aren’t concerned about the width of the pivot table.

Applying Tabular Form Layout
Next, you’ll apply the Tabular Form layout to the pivot table to see how it differs from the 
Outline Form layout:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Report Layout command.

4. Click Show in Tabular Form.
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After the Tabular Form layout is applied, the first item for each field starts in the first
available row (see Figure 5-3). As in Outline Form layout, there are two headings—LeadTech2
is in cell A3, and LeadTech is in cell B3. Below each heading are the labels for the field that is
named in the heading cell.

Figure 5-3. Outline Form (on the left) and Tabular Form (on the right) layouts

■Note In the Tabular Form layout, the subtotals are at the bottom of the group, even though you selected
the option to show the subtotals above the group.

If you remove the subtotals, the Tabular Form layout will require fewer rows than the Out-
line Form layout, because it doesn’t add an extra row for each group heading, such as Team A
and Team B. The Tabular Form layout may be useful when you want to show all the field
names as heading labels and aren’t concerned about the width of the pivot table but want to
reduce the number of rows.

Applying Compact Form Layout
Next, you’ll apply the Compact Form layout to the pivot table to return the pivot table to its
original layout:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Report Layout command.

4. Click Show in Compact Form.

After the Compact Form layout is applied, the headings for LeadTech2 and LeadTech dis-
appear. The row labels are all shown in column A, under the heading Row Labels, as they were
originally (see the Compact Form layout in Figure 5-2). The indentation differentiates the sets
of items. Also, because you’ve removed the Tabular Form layout, the subtotals are now visible
at the top of each group.
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Adding Blank Rows in the Layout
To add some whitespace to a pivot table and make it easier to distinguish where items end,
you can change a setting to add blank rows to the layout. You’ll add blank rows to your pivot
table to see the effect:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Blank Rows command.

4. Click Insert Blank Line After Each Item (see Figure 5-4).

Figure 5-4. Blank Rows options

The pivot table now has a blank row after each item in the outer fields in the Row Labels
area. Adding this whitespace may make the pivot table easier to read, especially if it is large or
is crowded with large numbers.

If you’ve added blank rows to the pivot table, later you can remove the rows by using the
Blank Rows command on the Ribbon. You’ll remove the blank rows that you added:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. At the far left, in the Layout group, click the Blank Rows command.

4. Click Remove Blank Line After Each Item.

This removes the blank row after each item and reduces the number of rows in the pivot
table.

Using a Pivot Table Style
To quickly and easily format a pivot table, you can apply a pivot table style. If you change the
pivot table layout, the pivot table style formatting will adjust to the revised layout, so format-
ting such as alternating shaded rows will display correctly when rows are added or removed
from the pivot table layout.
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In Chapter 3 you applied a pivot table style. In this chapter, you’ll modify and create pivot
table styles and see how the styles work in conjunction with other formatting features in Excel.
To get started, you’ll apply one of the existing styles:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. Click the More arrow at the bottom right of the PivotTable Styles group.

4. In the Medium section of the PivotTable Style gallery, click Pivot Style Medium 8.

■Tip As you point to the styles in the Pivot Table Style gallery, the style will be previewed in the active 
pivot table.

The style you applied has medium gray fill in the column headings, light gray fill in the
row headings, and borders on the grand total row. Next, you’ll use other commands on the
Ribbon to modify the selected style.

Adding Row and Column Shading
In a large pivot table it may be difficult to visually connect a label at the far left or top of the
pivot table to a number in the center of the Values area. To help users follow a wide row or 
long column of data, you can use the Banded Rows and Banded Columns commands on the
PivotTable Design tab.

Applying Banded Rows to the Pivot Table
In your pivot table, you’ll add Banded Rows to make it easier to follow the data across the row
for each technician:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the PivotTable Style Options group, click the Banded Rows command to add a check
mark to the option (see Figure 5-5).

Figure 5-5. Banded Rows command
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In the pivot table, the formatting changes to include light gray borders between the rows.
In the PivotTable Styles group, the style samples have changed to include banded rows.

■Tip For some pivot table styles, such as PivotStyle Medium 15, applying the Banded Rows command will
create alternating shaded rows, instead of row borders.

4. To see the benefit of the row banding, in the PivotTable Field List pane, drag the Dis-
trict field to the Column Labels area.

In the wider pivot table, the gray borders help you read across the rows, connecting the
technician names to the data in all the columns.

Applying Banded Columns to the Pivot Table
If a pivot table has long columns, the Banded Columns feature may make it easier to read.
Before applying this feature, you’ll add another field to the Row Labels area to add more rows:

1. To increase the number of rows in the pivot table, in the PivotTable Field List pane, 
add a check mark to the Service field. It is added to the Row Labels area, below the
LeadTech field.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the PivotTable Style Options group, click the Banded Columns command to add a
check mark to the option.

In pivot table, the formatting changes to include gray borders between the columns. In
the PivotTable Styles group, the style samples have changed to include banded columns.

■Tip For some pivot table styles, such as PivotStyle Medium 15, applying the Banded Columns command
will create alternating shaded columns, instead of column borders.

Formatting the Row and Column Headers
Another option you can turn on or off in a pivot table style is special formatting for the row
headers and column headers. When you create a pivot table, formatting for row headers and
column headers is turned on by default.

Removing Row Header Formatting
You’ll turn off the row header formatting in your pivot table to see the effect, and then you’ll
turn it back on:

1. Select a cell in the pivot table.
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2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the Options group, click the Row Headers command to remove the check mark from
the option (see Figure 5-6).

Figure 5-6. Row Headers command

In your pivot table, the formatting for the row label headers is removed, and the cells
are formatted like the other cells in the body of the pivot table. On the Ribbon, in the
PivotTable Styles group, some of the style samples have changed to remove the row
header formatting.

4. To turn the row header formatting on again, click the Row Headers command to add a
check mark.

Removing Column Header Formatting
You’ll turn off the column header formatting in your pivot table to see the effect, and then
you’ll turn it back on:

1. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

2. In the Options group, click the Column Headers command to remove the check mark
from the option.

In the pivot table, the formatting is removed from the column labels, and in 
the PivotTable Styles group, some of the style samples have changed to remove the 
column header formatting.

3. To turn the column header formatting on again, click the Column Headers command
to add a check mark.

Removing a Pivot Table Style
After applying a pivot table style to a pivot table, you may want to clear the style and start over,
or you simply might want to work with an unformatted pivot table. You’ll remove the pivot
table style from your pivot table to prepare for creating your own pivot table style:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. Click the More arrow at the bottom right of the PivotTable Styles group.
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4. At the bottom left of the gallery, click Clear to remove the pivot table style (see Figure 5-7).

Figure 5-7. Clearing the pivot table style

This removes the pivot table style from the pivot table, and the cells have no fill color,
bold font, or colored borders; they have only the formatting that was manually applied to the
cells. Checking the options in the PivotTable Style Options group on the Ribbon has no effect
on the pivot table, because no style is applied.

■Tip A pivot table style, None, appears at the top left in the PivotTable Styles group on the Ribbon. You can
use it to clear the pivot table style, just as you would use the Clear command.

Creating a Pivot Table Style
In addition to using the built-in pivot table styles, you can create and apply your own pivot
table styles, either from scratch or based on an existing pivot table style. You’ll create a pivot
table style from scratch and apply it to your pivot table:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. Click the More arrow at the bottom right of the PivotTable Styles group.

4. Click New PivotTable Style (shown earlier in Figure 5-7).

5. In the New PivotTable Quick Style dialog box, type WorkOrders in the Name box as the
name for your new style (see Figure 5-8).

■Tip In the Preview section of the New PivotTable Quick Style dialog box, you can see a sample of the for-
matting as you create it.
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Figure 5-8. The New PivotTable Quick Style dialog box

6. In the Table Element list, scroll down to Grand Total Row, click to select it, and then
click the Format button.

■Note The Grand Total Row element is the row at the bottom of the pivot table. It is different from the
Grand Totals for Rows element in the column at the far right of the pivot table.

7. In the Format Cells dialog box, click the Fill tab, and select a background color for the
grand total row.

8. Click the Border tab, select a line style and line color, and then select borders for the
grand total row.

9. Click the Font tab, and select Bold as the font style.

10. Click the OK button to return to the New PivotTable Quick Style dialog box, where the
formatted grand total row is listed with a bold font.

■Tip Click a formatted table element, and you can view a description of its formatting in the Element 
Formatting section of the New PivotTable Quick Style dialog box.
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11. Repeat steps 6 to 10 to format the Header Row and Row Subheading 1 table elements.

12. Click the OK button to close the New PivotTable Quick Style dialog box.

■Note The new pivot table style is not automatically applied to the active pivot table.

The pivot table style you created may be visible on the Ribbon, under the PivotTable Tools
tab, in the PivotTable Styles group on the Design tab. It is also added to a Custom section of
the PivotTable Styles gallery (see Figure 5-9).

Figure 5-9. The Custom pivot table styles on the Ribbon

Applying a Custom Pivot Table Style
After you have created a custom pivot table style, you can apply it to your pivot table. You’ll
apply the WorkOrders pivot table style to your pivot table:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. Click the WorkOrders style in the PivotTable Styles group (see Figure 5-10).

Figure 5-10. The new pivot table style on the Ribbon

The WorkOrders custom pivot table style is applied to your pivot table, with the format-
ting you selected when creating the style.
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Modifying a Custom PivotTable Style
After you have created a custom pivot table style, you can modify it. You’ll modify the 
WorkOrders custom pivot table style to remove formatting from one table element and to 
add formatting to another table element:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. Right-click the WorkOrders custom style in the PivotTable Styles group, and click Mod-
ify (see Figure 5-11).

Figure 5-11. Modifying the custom pivot table style

4. In the Modify PivotTable Quick Style dialog box, select Row Subheading 1 in the Table
Element list, and click Clear to clear its formatting.

5. Select First Row Stripe in the Table Element list, and in the Stripe Size drop-down list,
choose 2.

6. Click the Format button, and on the Fill tab, select a background color.

7. Click OK to close the Format Cells dialog box, and you’ll see the stripe in the preview
section of the Modify PivotTable Quick Style dialog box. Because you set the stripe size
to 2, there are two shaded rows and then a row with no fill color.

8. Click OK to close the Modify PivotTable Quick Style dialog box.

Because the WorkOrders style is applied to the active pivot table, you’ll automatically see
the custom style’s changes displayed in the pivot table.
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Duplicating a Pivot Table Style
You can duplicate a built-in or custom pivot table style and modify the duplicate copy to cre-
ate a new pivot table style. Earlier, you created the WorkOrders custom pivot table style from
scratch. Now you’ll duplicate one of the built-in pivot table styles and then modify it to create
a new style:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the PivotTable Styles gallery, in the Dark section, right-click Pivot Style Dark 11, and
click Duplicate (see Figure 5-12).

Figure 5-12. Duplicating a pivot table style

4. Type Dark Green Header as a name for the new pivot table style.

5. In the Table Element list, select Header Row, and format it with dark green background
color instead of black.

6. When finished, click the OK button, and then apply the Dark Green Header style to
your pivot table.

The new style is applied to the pivot table, with the formatting changes you made.

Deleting a Custom Pivot Table Style
If you no longer need a custom pivot table style, you can delete it. You’ll delete the Dark Green
Header style you just created:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Design tab.

3. In the PivotTable Styles gallery, right-click the Dark Green Header custom style, and
click Delete.
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4. In the alert message, click the OK button to confirm the deletion (see Figure 5-13).

Figure 5-13. Deleting the custom pivot table style

Because your pivot table had the Dark Green Header custom style applied, when you
deleted that style, the style was automatically removed from your pivot table. You can
apply a different style from the PivotTable Style gallery.

5. On the Ribbon, in the PivotTable Styles gallery, click the WorkOrders custom style to
apply it to your pivot table.

Using Themes
Another feature in Excel 2007 that affects the formatting is document themes. Each theme is a
collection of colors, fonts, and visual effects you can share between Excel and other Microsoft
Office applications. You can use the existing themes, create new themes, or modify the built-in
themes. In the following sections, you’ll experiment with document themes to help you
understand their impact on pivot table formatting.

Viewing the Current Theme
First, you’ll check the theme information for your workbook to see what theme is currently
applied and what its settings are. Later, you’ll apply a different theme to see what changes
occur.

1. On the Ribbon, click the Page Layout tab.

2. In the Themes group, point to the Themes command, and the tool tip will show Office
Theme as the name of the current theme (see Figure 5-14).

Figure 5-14. Current theme
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Viewing the Theme Colors
Next, you’ll see the colors that are associated with each theme and view the color palette for
the current theme:

1. In the Themes group, click Colors to open the color list, where the Office colors are
shown as selected (see Figure 5-15). To close the list, click the Colors command again.

Figure 5-15. Current colors

2. To see more of the Office Theme color palette, on the Ribbon, click the Home tab, and
then click the arrow on the Fill Color command. The Fill Color palette shows the theme
colors in the first row of colors (see Figure 5-16). The colors in the rows below are
lighter and darker versions of the theme colors.

Figure 5-16. Theme colors in the Fill Color palette

The first four theme colors are used for text and backgrounds. The next six colors are the
accent colors and are also used for the pivot table styles.
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Viewing the Theme Fonts
Next, you’ll view the fonts associated with the current theme. A theme has two fonts, one for
headings and one for the body text.

1. On the Ribbon, click the Page Layout tab.

2. In the Themes group, click the Fonts command to open the list of fonts (see Figure 5-17).

Figure 5-17. Current theme fonts

The Office fonts are selected and show that Cambria is the Headings font and Calibri is
the Body font. These fonts are also visible in the Font drop-down list on the Home tab on the
Ribbon (see Figure 5-18). In your pivot table, Calibri, the Body font from the Office theme, is
used.

Figure 5-18. Theme fonts in the Font drop-down list on the Home tab

Viewing the Theme Effects
Finally, you’ll view the effects associated with the current theme. The effects are used in charts
and shapes, so if you create a pivot chart, its appearance will be affected by the current
theme’s effects.

1. On the Ribbon, click the Page Layout tab.
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2. In the Themes group, click the Effects command to open the list of effects (see 
Figure 5-19).

Figure 5-19. Current theme effects

The Office theme effects are selected and show the line thickness, fill type, and beveling
that would be used for charts and shapes.

Applying a Theme
To change the look of your pivot table, you’ll apply a different theme to see what changes
occur:

1. On the Ribbon, click the Page Layout tab.

2. In the Themes group, click Themes, and in the Themes gallery, point to the Aspect
theme (see Figure 5-20).

Figure 5-20. Themes gallery

3. In your pivot table, the colors and fonts change to match the colors and fonts in the
Aspect theme, as shown in the Aspect sample.
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4. Click the Aspect theme to select it, and your pivot table now has that theme’s fonts and
colors applied.

The Aspect theme uses the Verdana font for headings and body and darker colors.
Because the Verdana font is wider than the Calibri font, your pivot table is wider. In the
Themes group on the Page Layout tab, the icons have changed to reflect the colors,
fonts, and effects of the current theme. In the PivotTable Styles gallery, the styles use
the colors from the new theme.

Other features are also affected by the change in themes. The font in the row and col-
umn buttons changes to the Body font for the current theme. On Sheet1, where your
data is stored, the table has changed, using the colors and fonts of the current theme.
The Table style gallery also shows styles in the current theme.

5. To reapply the Office theme, return to the Themes gallery, and click the Office theme.

Saving the File
You can save your file now as WorkOrders_03.xlsx. That will leave the original file unchanged
since its last save, and you can use the new file for your work in the next chapter.

Summary
In this chapter, you added formatting to a pivot table to enhance the data presentation. With
suitable formatting you can make pivot tables easier to read and highlight specific data. You
also applied, modified, and created pivot table styles to make formatting consistent through-
out your workbook. Finally, you examined themes and saw that they have an overriding
impact on your pivot table formatting and on other features in the workbook.
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Sorting and Filtering in a 
Pivot Table

Instead of viewing a summary of all the pivot table data, you may want to focus on a specific
district’s data or one technician’s results. In this chapter, you’ll filter the pivot table to show
only the data from one district or for selected service types and to show the work orders for a
specific date range. You’ll also sort the data in your pivot table to arrange the summarized data
from the highest to lowest values and from the lowest to highest values.

By sorting and filtering the data in a pivot table, you can focus on areas where perform-
ance could be improved or pinpoint the activities that are consuming the most resources.
With these pivot table tools you can go from the big picture, comparing all aspects of your
business, to the small details, homing in on problems for closer analysis.

You’ll start by creating a new pivot table and adding report filters by using the WorkOrders_
03.xlsx file that you can download from the Apress web site.

Adding Report Filters
The service manager has asked you to report on the work that the lead technician named
Michner has been doing. The report should show the total hours Michner has worked in each
district, and it should indicate which jobs were rush and which were nonrush. For these jobs,
what payment type was received?

In the previous chapter, you arranged and formatted a pivot table to count the work
orders by teams of technicians. You’ll leave that pivot table unchanged so you can refer to it
later, if required, and you’ll create a new pivot table to analyze the rush jobs and payments.

■Note In a workbook, you can create multiple pivot tables from the same source data.

In the WorkOrders_03.xlsx file, you’ll review the WorkOrders Excel table, on Sheet1, to see
which fields you’ll need in the report. The LeadTech field contains the technician name, the
District field shows the district name, the LbrHrs field contains the number of hours worked
on each job, the Rush field indicates whether the job was a rush, and the Payment field shows
the type of payment that was received.
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Now that you’ve determined which fields you need, you’ll create a new pivot table with all
the data summarized:

1. On Sheet1, select a cell in the Excel table named WorkOrders, and create a pivot table
on a new worksheet.

2. On Sheet 5, in the new pivot table, add the LbrHrs field to the Values area, add the Rush
field and the District field to the Row Labels area, and then add the Payment field to
the Column Labels area.

The Rush field creates two subheadings in the Row Labels area: Yes and (blank). The
(blank) label represents the blank cells in the source data. In the source data, a blank
cell means No, so you’ll change the label in the pivot table to make it easier to under-
stand.

3. In the pivot table, select cell A15, which contains the (blank) label for the Rush field.

4. Type No, and press the Enter key to change the label.

■Note Changing the label in the pivot table does not affect the source data.

5. Format the pivot table with a pivot table style. In the example shown in this chapter,
PivotTable Style Light 1 was applied.

To make the pivot table easier to read, format the Sum of LbrHrs value field as a number
with zero decimal places and a thousands separator. With the values all showing whole num-
bers, it will be easier to compare the sorted data (see Figure 6-1).

The pivot table summarizes all the data in the WorkOrders Excel table on which it is
based. In row 5 (Rush=Yes) on the pivot table worksheet, you can see that only 184 labor 
hours were spent on rush jobs. In row 15, you can see that nonrush jobs (Rush=No) had 
2,069 labor hours.
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Figure 6-1. Summary of labor hours per payment type

Adding a Report Filter
Viewing all the data gives you the big picture and lets you compare district totals or payment
types. However, the service manager wants the report to show information about the lead
technician named Michner. Labor hours for all the technicians are included in the summa-
rized data, but the details for each technician aren’t shown. Currently, there’s no way to tell
who did one hour of labor on credit in the Northeast (cell D19) or who did one hour of labor
on a rush job in the Southwest (cell B13).
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You could add the LeadTech field to the Row Labels area, and that would show Michner’s
totals, along with those of all the other technicians. Instead, you’ll add the LeadTech field to
the Report Filter area to limit the information that’s shown.

■Tip To show details, add a field to the Row Labels or Column Labels area. To limit the data, add a field to
the Report Filter area, and filter the data.

1. Select a cell in the pivot table.

2. In the PivotTable Field List pane, right-click the LeadTech field, and in the context
menu, click Add to Report Filter (see Figure 6-2).

Figure 6-2. Adding a field to the Report Filter area

3. The LeadTech field appears in cell A1 on the worksheet, above the body of the pivot
table, and its drop-down list shows (All), indicating no filter has been applied.

4. To view the work order summary for only one technician, click the arrow on the 
LeadTech Report Filter field button, select Michner, and then click OK.

The Grand Total field is reduced to 506 labor hours, which is the total for Michner. You can
send your report to the service manager to show the number of hours that Michner spent in
each district, to show the number of hours he spent on rush and nonrush jobs, and to show
which payment types were used.

Adding Multiple Report Filters
Now that you have filtered the pivot table so only Michner’s data is showing, the service man-
ager wants to focus on Michner’s installation work. How much time is Michner working on
installations in each district? What payment type was most common for the installations?

The type of work is stored in the Service field, so you’ll add that field to the pivot table.
Since you’re interested in only one of the service types, you’ll add the field to the Report Filter
area, where you can use it to limit the data that’s shown:

1. In the PivotTable Field List pane, add the Service field to the Report Filter section,
below the LeadTech field.
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2. The Service field appears in cell A2 on the worksheet, above the body of the pivot table,
and its drop-down list shows (All), indicating that no filter has been applied. The body
of the pivot table is automatically moved down one row to make room for the addi-
tional report filter (see Figure 6-3).

Figure 6-3. Two report filters in the pivot table layout

The pivot table shows only Michner’s labor hours but includes all types of work done
by Michner. You’ll apply a filter to the Service field, so only one type of work is shown.

3. To view the work order summary for only Michner’s installations, click the arrow on
the Service Report Filter field button, select Install, and then click OK.

■Note If there are multiple report filters, the filters are independent of one another. Selecting an item in
one report filter does not limit the items that are available in other report filters. Even if Michner had no
Install work orders, that item would still be available in the Service report filter.

The pivot table now summarizes only the work orders in which the lead technician was
Michner and the service type was an Install. The Grand Total cell (F18) shows that Michner
spent 150 hours on this type of service.

Changing the Order of Report Filters
When there are multiple report filters, you can change the order in which they appear on the
worksheet. Changing the order of the report filters does not affect the pivot table results, but
in some situations it may make the report appear more logical. For example, if you have State,
City, and Country in the Report Filter area, you can arrange the filters in order of geographical
scope—Country, State, City.

In this report, the service manager is concerned with installation work, so you’ll move the
Service field so it’s above the LeadTech field. This will make it appear at the top of the page if
the report is printed.

1. Select a cell in the pivot table.

2. In the PivotTable Field List pane, in the Report Filter area, drag the Service field above
the LeadTech field.
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On the worksheet, the report filters change position to reflect the change made in the 
PivotTable Field List pane.

Arranging Report Filters
You currently have two fields in the Report Filters area, and you’ll add two more fields so the
service manager can see how many jobs were one-technician jobs and which jobs were done
in 2007:

1. Select a cell in the pivot table.

2. In the PivotTable Field List pane, add the Techs and Years fields to the Report Filter
area, below the LeadTech field.

The four report filters appear above the body of the pivot table, in cells A1 to B4 (see
Figure 6-4).

Figure 6-4. Four fields in the Report Filters area

3. To view the jobs that were done by one technician, click the arrow on the Techs Report
Filter field button, select 1, and then click OK.

4. To view the jobs that were done in 2007, click the arrow on the Years Report Filter field
button, select 2007, and then click OK.

The grand total shows that Michner spent 59 hours on installation jobs in 2007, where
there was one technician.

Arranging the Report Filters Horizontally
When a pivot table has multiple report filters, you can arrange them vertically above the pivot
table body or horizontally. Each arrangement has some benefits, and you can decide what
best suits the pivot table on which you’re working.

First, you’ll arrange the report filters horizontally to see how that affects the pivot table
layout. You’ll specify how many report filters should be in each row above the pivot table.

CHAPTER 6 ■ SORTING AND FILTERING IN A P IVOT TABLE92

8903Ch06  8/30/07  4:09 PM  Page 92



1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. At the far left, in the PivotTable group, click the Options command to open the
PivotTable Options dialog box.

4. On the Layout & Format tab, in the Layout section, select Over, Then Down from the
Display Fields in Report Filter Area drop-down (see Figure 6-5). The Report Filter Fields
per Column option changes to Report Filter Fields per Row.

Figure 6-5. Report filter field settings in PivotTable Options

5. In the Report Filter Fields per Row setting, enter 3, and then click OK.

The report filters are now arranged horizontally above the pivot table. The first three
report filters are in row 3, and the last report filter is in row 4 (see Figure 6-6). You specified
that there should be three filters per row and the filters should go down to start another row of
filters, if required.

Figure 6-6. Report filters arranged over and then down
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Arranging the Report Filters Vertically
Next, you’ll arrange the report filters vertically to see how that affects the pivot table layout.
This time, instead of using a Ribbon command, you’ll use a context menu to open the 
PivotTable Options dialog box:

1. Right-click cell E7, which is the Grand Total column heading, to open a context menu
and mini-toolbar (see Figure 6-7).

■Note As the name implies, context menu commands will vary, based on the type of cell on which you
right-click. For example, the commands for a value cell will be different from the commands for a row label
cell.

2. In the context menu, click PivotTable Options.

Figure 6-7. PivotTable Options command on the context menu

3. In the PivotTable Options dialog box, on the Layout & Format tab, in the Layout sec-
tion, select Down, Then Over from the Display Fields in Report Filter Area drop-down.
The Report Filter Fields per Row option changes to Report Filter Fields per Column.

4. In the Report Filter Fields per Column setting, enter 3, and then click the OK button.

The report filters are now arranged vertically above the pivot table. The first three report
filters are in column A, and the last report filter is in column D (see Figure 6-8). You specified
that there should be three filters down per column and that the filters should go over to start
another column of filters, if required.
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Figure 6-8. Report filters arranged down and then over

If your pivot table has many report filters, you can adjust the arrangement of the filters to
make the most efficient use of the worksheet space. You’ll want the report filters easily accessi-
ble, not spread out too far across the worksheet. You’ll also want to avoid a long column of
filters above the pivot table, pushing the pivot table body far down the worksheet. By using the
Display Fields in Report Filter Area option, you can find the best balance of height and width
for the report filter layout.

Clearing All Filters
You have finished your reports for the service manager and want to show all the data in the
pivot table again. Instead of resetting each filter individually, you can change them all at once.
This will clear all the report filters and any label filters or value filters.

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Actions group, click Clear, and then click Clear Filters (see Figure 6-9).

Figure 6-9. Clear Filters command

All report filters are reset to show (All), and the pivot table summarizes data from all the
work orders.
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Moving Labels
With report filters, you changed the way that data was summarized in the pivot table, limiting
the data that was included. Another way you can change how data is presented in a pivot table
is to move the labels. When you add a field to the Row Label or Column Label area of the pivot
table, its labels are usually sorted alphabetically. In some reports, you may want to see the
labels in a nonalphabetical order, and you can accomplish this by manually moving the labels.

In your pivot table, the district labels are arranged alphabetically, with Central at the top
of the list and West at the bottom. The manager of the South district has asked for a copy of the
pivot table, so you’ll manually rearrange the labels to create a nonalphabetical order, with
South at the top of the list. This will make that district’s information stand out in the report.

Dragging Labels to a New Position
In the list of districts, you’ll move the South district higher in the list by dragging its label:

1. In the pivot table, select cell A14, which contains the South item label.

2. Point to the border of the cell, and when the pointer changes to a four-headed arrow,
drag the cell up to above the Central label. An insertion bar indicates where the label
will be dropped (see Figure 6-10).

Figure 6-10. Dragging label to a new position

3. Release the mouse button, and the South item label moves, along with its row of data.
Although you moved only the South label in the Rush Yes group, the South label in the
Rush No group has also moved, from A24 to A19.

You can now send the report to the South district, with its data at the top of the list of dis-
tricts. Manually moving a label allows you to override the default alphabetical sorting in the
field and gives you great flexibility in the item order.

Using Commands to Move Labels
Your next report will be sent to the West district, so you’d like that district’s information at the
top of the list of districts. Another way to manually move the labels is to use a context menu.
You’ll use a context menu to move the West label to the top of the list:
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1. In the pivot table, right-click cell A17, which contains a label for the West district.

2. In the context menu, click Move, and then click Move “West” to Beginning (see 
Figure 6-11).

Figure 6-11. Moving a label with a context menu command

3. The West label moves, along with its row of data. The West label in the Rush No group
has also moved, from A27 to A19.

You may prefer to use this method for moving a label if you find it easier than positioning
the pointer over the cell border and using the four-headed arrow to drag the label.

Moving Labels by Typing
The next report is for the East district. A third way to manually move the labels is by typing.
You’ll use this method to move the East item to the top of the list:

1. In the pivot table, click cell A9, which contains the West label. This is the position in
which you’d like the East label, which is currently in cell A12.

2. Type East in cell A9, replacing the West label (see Figure 6-12), and then press the 
Enter key.

Figure 6-12. Typing over an existing label
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3. The East label moves up to row 9, along with its row of data. The labels that were above
East have moved down, with the West label now in cell A10.

You may prefer to use this method for quickly moving an item label if it has a short, easy-
to-spell label.

■Caution If you misspell the label, Excel will rename the label you overtyped, and the labels will not move.

Sorting Labels
When you add a field to the Column Labels or Row Labels area of the pivot table, the labels are
usually sorted alphabetically in ascending order. For some fields, you may prefer the labels in
descending order. After making changes to the pivot table, such as manually moving the
labels, the sort order may have changed, and you may want to restore the alphabetical order
to the labels. You’ll sort the labels in your pivot table to see labels in descending or ascending
order.

Sorting the Labels with a Ribbon Command
When you added the Rush field to the Row Labels area, Yes was added at the top of the list, and
the No item (blank) was added at the bottom. You changed the (blank) label to No, and now
you want the rush labels in alphabetical order.

To sort the labels in a pivot table field, you can use the Ribbon commands. You’ll sort the
labels in the Rush field, so the No label is at the top of the list, instead of the Yes label:

1. In the pivot table, select cell A8, which contains the Yes label for the Rush field.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Sort group, click Sort A to Z to sort the rush items in ascending order (see 
Figure 6-13).

Figure 6-13. Sorting A to Z

The Yes rush label moves down in the pivot table, and the No label moves to the top of the
pivot table.
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After reviewing the revised order, you decide to sort the field again, so the Yes label is at
the top. To return the labels to their original positions, you’ll sort the labels in descending
order:

1. In the pivot table, select cell A8, which contains the No label for the Rush field.

2. In the Sort group, click Sort Z to A to sort the rush items in descending order.

■Note The Sort commands are also available on the Data tab of the Ribbon.

Sorting Labels with a Context Menu
In the pivot table, the Payment field is in the Column Labels area, with labels arranged alpha-
betically, from Account on the left to Warranty on the right. You want to sort these labels in
descending order so Warranty is on the left.

You’ll use a context menu to sort the payment labels in descending order:

1. In the pivot table, right-click one of the payment labels. For example, right-click cell
F7, which contains the Warranty label.

2. In the context menu, click Sort, and then click Sort Z to A to sort the items in descend-
ing order (see Figure 6-14).

Figure 6-14. Sorting labels in descending order

3. The payment items are sorted in descending order, from left to right, starting with 
Warranty in cell B7.

You may prefer to use this method for sorting labels if the Sort group on the Ribbon is not
visible.
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Sorting Labels with the Heading Drop-Down List
While preparing your reports earlier, you manually moved a few of the district labels. You’d like
to sort the list of districts in ascending order so they’re back to the original list order. Another
method for sorting the labels is to use the drop-down arrows on the Row Label and Column
Label headings. You’ll use this method to sort the district labels in ascending order:

1. In the pivot table, click the arrow on the Row Labels heading, in cell A7.

2. In the Select Field drop-down list, Rush is the field that is currently showing. Click 
the drop-down arrow, and choose District, which is the field you want to sort (see 
Figure 6-15).

Figure 6-15. Selecting the field to sort

3. In the list of sort options, click Sort A to Z to sort the labels in ascending order.

The district labels are sorted in ascending order, as they were originally. You can use this
method of sorting if you don’t want to select a label before sorting.

Sorting Values
In addition to sorting the labels by their text, you can sort the pivot table by the values. This
will move the largest or smallest numbers to the top of the list so you can focus your attention
on those items. You’ll sort the Grand Total column to arrange the values in ascending order.

Sorting from Smallest to Largest
Under each rush item in the row labels, the pivot table has an alphabetical list of districts. 
For each rush item, you want to see which districts have the smallest number of labor hours
(LbrHrs), so you’ll sort by the values:

1. In the Grand Total column, right-click one of the district totals in column G. For exam-
ple, right-click cell G9, which contains the total of labor hours for the Central district
for Yes rush work orders.

2. In the context menu, click Sort, and then click Sort Smallest to Largest to sort the labor
hours in ascending order.

Values within each rush group are sorted in ascending order, showing that the South dis-
trict has the lowest number of labor hours for rush work orders (Yes) and the Southwest
district has the lowest number of labor hours for nonrush work orders (No).
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Sorting from Largest to Smallest
The next report you have been asked to create will focus on the payment type. In your pivot
table there is a column for each payment type, with labels in cells B7 to F7. In the Account 
column (F), you can see the number of labor hours for each district. Currently, the districts 
are listed under the rush labels, so there are two numbers for each district in the Account 
column—one in the Yes section and one in the No section.

You want to see which districts have the highest number of labor hours (LbrHrs) with an
Account payment type, so you’ll modify the pivot table to create one number for each district
in the payment columns. After you make that change to the layout, you’ll sort on the values in
the Account column.

To create one number for each district, you’ll remove the Rush field from the pivot table
layout:

1. In the PivotTable Field List pane, remove the check mark from the Rush field. The Rush
headings are removed from the pivot table layout, and the pivot table shows the total
labor hours for each district. Even though you changed the layout, the Grand Total col-
umn is still sorted in ascending order.

2. Right-click one of the district values in column F. For example, right-click cell F8,
which contains the Account labor hours for the Northeast district.

3. In the context menu, click Sort, and then click Sort Largest to Smallest to sort the labor
hours in the Account column in descending order.

Values in the Account column are sorted in descending order, showing that the North 
district has the largest number of labor hours (238) paid on account (see Figure 6-16). The
Southwest district has the smallest number (6).

Figure 6-16. Account column values in descending order
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Sorting a Grand Total Row
Besides sorting a column’s values in ascending or descending order, you can also sort a row’s
values. Currently, the payment labels in row 7 are sorted in descending alphabetical order,
with Warranty at the left and Account at the right. You’ll sort the payment grand totals so the
payment type with the largest number of labor hours is at the left. In the Grand Total row, you
can see that the C.O.D. payment type has the highest number, so it should move to the left
when you sort by the Grand Total values.

1. Right-click one of the payment grand totals in row 17. For example, right-click cell B17,
which contains the grand total for the Warranty column.

2. In the context menu, click Sort, and then click Sort Largest to Smallest to sort the labor
hours in descending order, left to right.

The Grand Total values in row 17 are sorted in descending order. In row 7, the payment
labels have been sorted with the grand totals. At the left is the C.O.D payment type, which has
the largest number of labor hours, and at the right is the Credit payment type, which has the
smallest number of labor hours. The Grand Total column (G) is not affected by the sort and
remains at the far right of the pivot table.

Sorting from Left to Right
You’re preparing a report for the North district, and instead of sorting by the Grand Total row,
you’d like to sort the values in the North district row. Although the Grand Total row can be
sorted easily, sorting other rows requires a few more steps.

Currently, the grand total amounts are sorted in descending order, with C.O.D. at the left
and Credit at the right. You’ll sort the North district, in row 8, by its labor hour amounts so the
column with the largest number of labor hours in the North district is at the left. In that row,
cell C8 has the largest number, so after the sort, the Account column should be at the far left.

1. In the pivot table, select a cell in the North district row. For example, select cell B8,
which contains the C.O.D. total for the North district.

You can’t use the Sort Largest to Smallest command on the context menu to sort any
row of values, except the grand total. To sort the North district row, you’ll open the Sort
By Value dialog box.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Sort group, click the Sort button to open the Sort By Value dialog box.

4. Under Sort options, select Largest to Smallest.

5. Under Sort direction, select Left to Right. In the Summary section, you’ll see a sum-
mary of the sort settings (see Figure 6-17). The Summary section indicates you will sort
using values in the North row.

6. Click the OK button.

The labor hours for the North district are sorted largest to smallest, from left to right. The
Account column is now at the far left, because it has the largest number of labor hours for the
North district. Labor hours for other districts, such as Central, may not be in descending
order, since the column order has been set by the North district.
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Figure 6-17. Sort By Value dialog box

Sorting Automatically When the Pivot Table Changes
When you sorted the pivot table values, you didn’t apply any report filters, so all the work orders
were summarized. You want to see the data for Michner only, so you’ll choose that name from
the LeadTech report filter and see the effect of applying a filter when the values are sorted.

Currently, the Account column is sorted in descending order, and the North district row is
sorted in descending order.

1. In the LeadTech report filter, select Michner.

2. Click OK to filter the pivot table data for that technician’s data.

The Account column remains sorted in descending order, and the Central district now
appears at the top of the list of districts. That is the district in which Michner has the largest
number of labor hours that were paid on account.

The values in the North district row have also changed, and this affected the column
order. The P.O. column has moved to the left because, in the North district, it is the payment
type with the largest number of labor hours (four) for Michner (see Figure 6-18).

Figure 6-18. Row and column sorted with report filter applied
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Preventing Automatic Sorting
In some cases, you may prefer that the sort order not change when the pivot table changes.
You’ll change a setting so the districts will remain in their current order, even if the report is fil-
tered. First you’ll remove the filter to restore the previous order, and then you’ll change the
sort setting for districts:

1. In the LeadTech report filter, select (All), and then click OK. The filter is removed, and
the columns and rows are returned to their previous orders.

2. In the pivot table, right-click a district label cell. For example, right-click cell A8, which
contains the North district label.

3. In the context menu, click Sort, and then click More Sort Options.

4. The Sort dialog box opens, showing the name of the current field, District, in the title
bar of the dialog box (see Figure 6-19).

In the Sort options section, Descending (Z to A) By, is selected and shows that the dis-
tricts are sorted by Sum of LbrHrs.

In the lower half of the dialog box, the Summary section shows that the Account col-
umn values are used for the sort order.

Figure 6-19. Sort dialog box

5. At the bottom of the dialog box, click the More Options button.

6. The More Sort Options dialog box opens, showing the name of the current field, 
District, in the title bar of the dialog box (see Figure 6-20).

Figure 6-20. More Sort Options dialog box
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7. In the AutoSort section, remove the check mark from Sort Automatically Every Time
the Report Is Updated (see Figure 6-20).

8. Click OK to close the More Sort Options dialog box, and then click OK to close the Sort
dialog box.

■Note The sort for the Payment labels changes when the District AutoSort is turned off. You could reapply
this filter later, if desired.

You’ll choose a technician name from the LeadTech report filter to see the effect of chang-
ing the sort update setting:

1. In the LeadTech Report Filter, select Michner.

2. Click OK to filter the pivot table data for that technician’s data.

The districts remain in the previous order, with North at the top, even though the North
district does not have the largest amount in the Account column.

Restoring Automatic Sorting
You’ll open the Sort dialog box to see how the sort settings have been changed and to restore
the previous settings:

1. In the pivot table, right-click a cell that contains a district label.

2. In the context menu, click Sort, and then click More Sort Options.

The Sort dialog box opens, and in the Sort options section, Manual is selected, instead
of Descending (Z to A). This setting was changed automatically to prevent the district
labels from sorting when you filtered the report.

3. Select Descending (Z to A), and from the drop-down list, choose Sum of LbrHrs. This
will sort the districts by their values in the LbrHrs field.

4. At the bottom of the dialog box, click the More Options button.

This opens the More Sort Options dialog box, where you’ll turn the AutoSort option on
again and select a column in which the values should be sorted.

5. In the AutoSort section, add a check mark to Sort Automatically Every Time the Report
Is Updated.

In the Sort By section, Grand Total is currently selected. You’ll change this so it sorts on
the values in the Account column, which is column C.

6. In the Sort By section, select Values in Selected Column, and type $C$8 in the column
box so the Account column will be used for sorting (see Figure 6-21). Instead of $C$8,
you could type the address of any cell in the Account column.
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■Tip Instead of typing the address, you can click a cell in the pivot table’s Account column on the worksheet.

Figure 6-21. Restoring the AutoSort settings

7. Click OK to close the More Sort Options dialog box, and then click OK to close the Sort
dialog box.

The pivot table is sorted by the values in the Account column, and the Central region is at
the top, since that is the largest amount for Michner (see Figure 6-22).

Figure 6-22. Pivot table sorted by amounts in the Account column
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Now that you have restored the sort settings, the sort order for the district labels will
update automatically when the pivot table changes.

Sorting Labels in a Custom Order
In some situations you may want labels sorted in a custom order that is not alphabetical or
numerical. For example, when including the service types in a pivot table, you may need to list
them in the following order to match other reports produced in your company:

• Install

• Replace

• Repair

• Assess

• Deliver

You could manually rearrange the service type labels after you add them to the pivot
table, but it would be easier to have the labels automatically sorted in this custom order. You’ll
move the Service field to the Row area of the pivot table and sort them alphabetically. Later,
you’ll sort them in a custom sort order.

1. Select a cell in the pivot table.

2. In the PivotTable Field List pane, move the Service field from the Report Filter section
to the Row Labels section, below the District field.

3. Right-click a cell in the service labels, and in the context menu, click Sort. Then click
Sort A to Z.

The service types are listed under each district in ascending alphabetical order.

Creating a Custom List
You’ll create a custom list of service types in the order in which you want them sorted auto-
matically:

1. Click the Microsoft Office Button on the Ribbon.

2. At the bottom right, click the Excel Options button.

3. In the Excel Options dialog box, click Popular.

4. In the Top Options for Working with Excel section, click Edit Custom Lists. The Custom
Lists dialog box opens and shows all the existing custom lists. You can add your own
lists by typing them or by importing lists from a worksheet.

5. In the Custom Lists dialog box, under Custom lists, select NEW LIST.
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6. Click in the List Entries section, and type a list of the service types, pressing the Enter
key after each service type: Install, Replace, Repair, Assess, Deliver (see Figure 6-23).

Figure 6-23. Creating a custom list

7. Click the Add button to add your list to the Custom Lists area.

8. Click the OK button to close the Custom Lists dialog box, and then click the OK button
to close the Excel Options dialog box.

Sorting with a Custom List
After creating a custom list, the custom sort order isn’t automatically applied to fields that 
are already in the pivot table layout. You’ll refresh the pivot table to apply the custom list 
sort order:

1. Right-click any cell in the pivot table, and click Refresh.

The service types are listed under each district in the custom list order.

Sorting Without Using a Custom List
If you don’t want to use custom lists when sorting in a pivot table, you can change a pivot table
setting to block their use:

1. Right-click any cell in the pivot table, and click PivotTable Options.

2. In the PivotTable Options dialog box, click the Totals & Filters tab.
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3. In the Sorting section, remove the check mark from Use Custom Lists When Sorting
(see Figure 6-24), and then click OK.

Figure 6-24. Using custom lists when sorting

The custom sort order is removed, and the service types are sorted in ascending alphabet-
ical order.

■Note Changing the Use Custom Lists When Sorting setting will affect all fields in the active pivot table.

Filtering Row and Column Labels
Another feature that will help as you focus on specific data in the pivot table is filtering the
row and column labels. You don’t have to move a field to the Report Filter area to filter it; you
can keep the pivot table layout as it is and filter the labels to reduce the amount of data that’s
shown in the pivot table.

Filtering for Begins With
Currently, all the districts are visible in the pivot table. You have been asked to create a report
that shows only the districts in the north—North, Northeast and Northwest—so you’ll use a
label filter to hide the other districts.

The names of all the districts in the north begin with North, so you’ll filter for that text
string:

1. Click the drop-down arrow in the Row Labels heading.

2. In the Select Field drop-down list, choose District.
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3. Click Label Filters, and then click Begins With (see Figure 6-25).

Figure 6-25. Label filters for Begins With

4. In the Label Filter dialog box, the drop-down box at the left shows begins with. Where
the cursor is flashing, type North (see Figure 6-26), which is the text string you want to
filter, and then click OK.

Figure 6-26. Label Filter dialog box

■Note The filter is not case sensitive, so items that begin with north or NORTH would also be visible after
the filter is applied.

In the district labels, only the labels that begin with North are still visible. All other dis-
tricts are hidden, and the grand totals show the amounts for the filtered districts only. The
LeadTech report filter is still applied, so the results are for Michner only. You can see that more
than half of the labor hours for Michner in the three northern districts were paid by C.O.D.

CHAPTER 6 ■ SORTING AND FILTERING IN A P IVOT TABLE110

8903Ch06  8/30/07  4:09 PM  Page 110



The drop-down arrow on the row labels shows a filter icon to indicate that a filter is cur-
rently applied to the labels. In the PivotTable Field List pane, a filter icon is visible to the right
of the District field.

Filtering for Contains
For your next report, you need to list all the districts that are in the east or west. These districts
have the text east or west in their names. When you filtered the district labels to show only the
labels that begin with North, you may have noticed the long list of options for filtering. You’ll
use a different option in your next filter to filter for districts in the east and west.

1. Click the drop-down arrow in the Row Labels heading.

2. In the Select Field drop-down list, choose District.

3. Click Label Filters, and then click Contains.

4. In the Label Filter dialog box, the drop-down box shows contains. Where the cursor is
flashing, type e*st (see Figure 6-27). The asterisk is a wildcard that represents any
series of characters or no characters.

Because you used the * wildcard, the filter will return district names that contain East,
because those names have an e and then one character and then st. The filter will also return
district names that contain West, because those names have an e and then no character and
then st.

Figure 6-27. Label Filter dialog box

5. Click the OK button.

All the districts that contain east or west in their names are visible in the pivot table, and
the other districts, such as North and Central, are hidden.

Viewing Filter and Sort Information
After applying a filter or sort to the row or column labels, you can quickly view a summary of
the current status. You’ll view the current filter and sort information:

1. Point to the drop-down arrow in the Row Labels heading.
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2. In the tool tip that appears, the current filter and sort information is listed for the fields
in the Row Labels area (see Figure 6-28).

Figure 6-28. Filter and sort information in tool tip

Removing Filters
After applying a filter to the row labels, you can remove it to show all the labels again. You’ll
remove the filter that you applied to the district labels:

1. Click the drop-down arrow in the Row Labels heading.

2. In the Select Field drop-down list, choose District.

3. Click Clear Filter from “District” (see Figure 6-29).

Figure 6-29. Clearing the filter

The filter is removed from the district labels, and all the districts are visible again.

Filtering Values
In addition to filtering the row and column labels, you can filter the values in the pivot table.
You may want to view only the values that are within a certain range or exceed a specific
amount. By filtering the values, you can limit what’s shown in the pivot table and focus on
only the values that are of current interest.
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Filtering Values for Row Fields
Currently, the pivot table is showing Michner’s labor hours. In the Grand Total column, you
can see the number of hours that Michner spent on each service type in each district. You
want to focus on the service types and districts where Michner spent most of his time, so
you’ll filter the grand totals for the service rows.

By reviewing the grand totals, you can see that most of the totals are less than 30 hours, so
you decide to use that as your cutoff point. You’ll apply a filter so only the amounts greater
than 30 hours are visible for any service in a district:

1. In the pivot table, click the arrow on the Row Labels heading, in cell A7.

2. In the drop-down list, in the Select Field list, choose Service.

3. Click Value Filters, and then click Greater Than.

4. In the Value Filter dialog box, the title bar shows the name of the current field, Service.

5. The first drop-down box shows Sum of LbrHrs, and the second drop-down box shows
is greater than. Leave those settings unchanged (see Figure 6-30).

Figure 6-30. Value Filter dialog box

6. In the third box, enter 30 as the number of hours you want to exceed, and then click OK.

The filter is applied, and only four service labels remain visible, three in the Central dis-
trict and one in the Northwest district (see Figure 6-31). The total for Assess in the Central
district shows as 30, but if you select the cell and look in the Formula Bar, you’ll see that it’s
actually 30.25. Therefore, it meets the filter criteria and is displayed in the filtered pivot table.

Figure 6-31. Pivot table with value filter applied

CHAPTER 6 ■ SORTING AND FILTERING IN A P IVOT TABLE 113

8903Ch06  8/30/07  4:09 PM  Page 113



Filtering Values for Column Fields
At the bottom of the pivot table, the grand totals for the Column fields can also be filtered. To
focus on the payment types with the highest number of labor hours, you’ll filter the grand
totals for the Payment columns, so only the amounts between 100 and 200 hours are visible.

1. In the pivot table, click the arrow on the Column Labels heading, in cell B6.

2. Click Value Filters, and then click Between.

3. In the Value Filter dialog box, the title bar shows the name of the current field, Payment.

4. The first drop-down box show Sum of LbrHrs, and the second drop-down box shows is
between. Leave those settings as is (see Figure 6-32).

Figure 6-32. Value Filter dialog box

5. In the third box, enter 100 as the minimum number of hours.

6. In the fourth box, enter 200 as the maximum number of hours.

7. Click the OK button to apply the filter.

Only the C.O.D. column remains visible, because its grand total is between 100 and 200
hours.

■Note The values entered in the minimum and maximum boxes are included in the filter results.

Filtering for a Date Range
The accounting manager has asked you to create a report that shows the fees that were col-
lected for work done in April 2007, with totals for one- and two-technician jobs. To analyze the
data for a specific date range, you can use date filters.

To start the report, you’ll change the pivot table by adding a date field to the Row Labels
area and then filtering for a date range. Using the date range filters will let you focus on the
results for a specific time period to see whether the results are what you expected.
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Clearing the Filters
You’ve finished analyzing the work done by one of the lead technicians, so before working
with the date filters, you’ll clear the pivot table and rebuild it with different fields:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Actions group, click Clear, and then click Clear All.

Because another pivot table in the workbook is based on the same data as the pivot
table you’re clearing, you’ll see a message warning you that Grouping, Calculated
Items, Calculated Fields, and Custom Items will be removed from all the pivot table
reports.

4. Click Clear PivotTable to continue with the Clear, because you don’t need to save the
grouped items in the other pivot table.

5. To rebuild the pivot table, add the TotalFee field to the Values area, add the WorkDate
field to the Row Labels area, and add the Techs field to the Column Labels area. The
Techs field shows whether one or two technicians were assigned to the job.

6. To make the pivot table easier to read, format the Sum of TotalFee value field as a num-
ber with two decimal places and a thousands separator.

7. Although the dates are in dd-mmm-yy format in the Excel table, in the pivot table they
appear in short date format. To format them, right-click a date cell, and in the context
menu, click Field Settings.

8. Click Number Format, and in the Format Cells dialog box, select the Date category and
the dd-mmm-yy format. Then click OK twice.

The pivot table now shows results for all the dates in the source data, from January 2006
to December 2007 (see Figure 6-33).

Figure 6-33. Formatted dates in the Row Labels area
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Filtering for a Specific Date Range
To create a report for the date range that the accounting manager requested, you’ll apply a 
filter to view only the data for the first two weeks of April 2007:

1. In the pivot table, click the arrow on the Row Labels heading, in cell A7.

2. Click Date Filters, and then click Between to open the Date Filter dialog box.

3. In the first drop-down, is between is selected. Leave that setting unchanged.

4. To the right of the second box, click the calendar icon to open the date selector (see
Figure 6-34).

Figure 6-34. Date filter for specific date range

5. Use the arrows at the top of the date selector to move to April 2007, and then click 
April 1 to select it.

6. To the right of the third box, click the calendar icon to open the date selector.

7. Use the arrows at the top of the date selector to move to April 2007, and then click 
April 14 to select it.

8. Click OK to close the Date Filter dialog box.

The pivot table now shows results for work done from April 1, 2007, to April 14, 2007.

Filtering for a Dynamic Date Range
The accounting manager likes the report you created for the April 2007 fees and asks whether
you can create a report each Monday to show fees collected during the previous week. To
make this task easier, you can use a date filter with a dynamic date range. Instead of specific
dates, these are time periods relative to the current date. For example, you can filter for last
month, next week, or tomorrow.

You’ll apply a dynamic filter to show the data from the previous week. The pivot table fil-
ter can do this dynamically, so you don’t have to enter specific dates each week to see the
updated summary.
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1. In the pivot table, click the arrow on the Row Labels heading, in cell A7.

2. Click Date Filters, and then click Last Week (see Figure 6-35).

Figure 6-35. Date filters for last week

The pivot table now shows results for work done in the previous week (assuming that
some of the records in the source data are from the week previous to you applying the filter).

■Note When the filter criteria can change automatically, such as with Last Week or Next Month, it is called
a dynamic filter.

Applying a Manual Filter
Instead of using the filter options, you can manually select or deselect the items in a field
drop-down list. You can use this option if you want to filter for specific items that can’t be fil-
tered by using a common or dynamic filter. For example, you may want to see the data from
three specific dates when the service department was short staffed. You’ll apply a manual filter
to see those dates:

1. In the pivot table, click the arrow on the Row Labels heading, in cell A7.

Because you’re interested in only three dates, you’ll remove all the check marks so no
dates are selected, and then you’ll select the three dates for the filter.

2. In the list of dates, remove the check mark from (Select All) to remove all the check
marks from the list.
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3. Add check marks to the three dates you want to see: 01-Feb-06, 02-Feb-06, and 
10-Feb-06 (see Figure 6-36), and then click OK.

Figure 6-36. Manual filter for specific dates

The pivot table now shows results for work done on the three selected dates, and you can
focus on that data only. The Techs field in the Column Labels area now shows only a label for 1.
The column for 2 is not visible, because no two-technician work was done on those short-
staffed days.

Including New Items in a Manual Filter
If you manually apply a filter to a field and then update the pivot table, some new items may
appear in the pivot table and not be affected by the filter. For example, if you manually filter
for specific dates and then add new records to the source data, the filter may include the new
items, even if they are not records for the date selected in the manual filter. You can change a
setting in the field to specify whether new items are included.

You’ll change one of the records in the source data to create a new work date. Then you’ll
refresh the pivot table to see how the revised record is handled.

1. On Sheet1, in the source data in cell G2, change the date from 08-Jan-06 to 09-Jan-06.
This date did not previously exist in the pivot table’s WorkDate field.

2. On Sheet5, right-click a cell in the pivot table, and click Refresh.

The revised record’s data does not appear in the pivot table. Now you’ll change a pivot
table setting to show new data even if it doesn’t meet the filter criteria.

1. In the pivot table, right-click a cell in the WorkDate Row labels, such as cell A8.

2. Click Field Settings.
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3. On the Subtotals & Filters tab, in the Filter section, add a check mark to Include New
Items in Manual Filter, and then click OK (see Figure 6-37).

Figure 6-37. Including new items in manual filter

You’ll change another record in the source data to create another new work date. Then
you’ll refresh the pivot table to see how the revised record is handled with the new setting in
effect.

1. In the source data on Sheet 1, in cell G3, change the date from 11-Jan-06 to 12-Jan-06.
This is another date that did not previously exist in the pivot table’s WorkDate field.

2. On Sheet5, right-click a cell in the pivot table, and click Refresh.

The revised record’s data appears in the pivot table, below the existing records, even
though it doesn’t meet the filter criteria. You can turn this setting on if you want to ensure that
you notice new records when they’re added, and then you can manually deselect them after
they appear. If you don’t want new records to appear in the filtered pivot table, remove the
check mark from the Include New Items in Manual Filter option.

Filtering by Selection
To quickly filter the items in a pivot table, you can select one or more labels and then use the
selected labels to filter the pivot table. You’ll select a few dates in the WorkDate field and then
hide all the other dates.

First you’ll clear the filter, and then you’ll apply a filter by selection.

1. Right-click a cell in the WorkDate labels, click Filter, and then click Clear Filter from
“WorkDate.” All the dates are visible in the Row Labels area.

2. In the Row Labels for WorkDate, click 19-Jan-06 to select that label.

3. Hold the Ctrl key on the keyboard, and click three other dates to select them.

■Tip The selected items can be in adjacent cells or any location in the list.

4. Right-click one of the selected labels.
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5. In the context menu, click Filter, and then click Keep Only Selected Items (see 
Figure 6-38).

Figure 6-38. Filter to keep only selected items

Only the four selected dates are visible, and all the other data is hidden. This is like man-
ual filtering. If you look at the list of dates in the Row Labels drop-down, the four selected
dates have check marks, and all the other dates have their check marks cleared.

Showing Top and Bottom Items
The final filtering method you’ll test is the filter to show the highest or lowest values in a value
field. You’ll filter the pivot table to show the five days with the highest total fees. The filter
option you’ll use is called Top 10, but you can use this feature to filter for top or bottom values
and use numbers other than 10.

Filtering for the Top Items
The accounting manager wants to know which days you collected the largest amount in fees.
You’ll use the Top 10 feature to view the five work dates with the highest total fees.

■Note The current filter does not have to be cleared, because you are applying a new filter to the Work-
Date field, and it will automatically override the previous filter applied to that field. By default, multiple filters
per field are not allowed. You can change this setting on the Totals & Filters tab in the PivotTable Options dia-
log box.

1. Click the drop-down arrow in the Row Labels heading.

2. Click Value Filters, and then click Top 10.

3. In the Top 10 Filter dialog box, select Top from the first drop-down list.
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4. In the second box, enter 5.

5. Select Items in the third box, select Sum of TotalFee in the last box, and then click the
OK button.

The pivot table shows only the five days that have the highest grand totals for the TotalFee
field.

■Note If there are ties in the Grand Total values, more than the specified number of items may be returned
in the filter. For example, if six dates had total fees of 20,000, all six would be listed.

Filtering for the Bottom Percent
In the previous filter, you viewed top items. Now that you have seen the top five days, you’ll
focus on days with the lowest amount of fees collected. You could filter for a specific number
of days, as you did for the top days. Instead, you’ll filter the pivot table to show the days that
comprise the bottom 10 percent of the total fees.

First you’ll clear the filter to see the grand total when all records are visible:

1. Right-click a cell in the WorkDate labels, click Filter, and then click Clear Filter from
“WorkDate.”

With all the records visible, the pivot table shows a grand total of $634,376.28 for the
sum of TotalFee. You’ll filter the pivot table to see the days with the lowest totals for
TotalFee that combine to total 10 percent of that overall grand total, or approximately
$63,437.

2. Click the drop-down arrow in the Row Labels heading.

3. Click Value Filters, and then click Top 10.

4. In the Top 10 Filter dialog box, select Bottom from the first drop-down list.

5. In the second box, enter 10.

6. Select Percent in the third box, and select Sum of TotalFee in the last box.

7. Click the OK button.

The pivot table shows a long list of days with the lowest totals for TotalFee that combine to
total $63,474.24, which is just over 10 percent of the overall grand total.

You could use this type of filter to determine where to focus your improvement efforts.
There may be only a few clients or products that contribute to the top 10 or 20 percent of your
sales and several hundred that comprise the remaining percent of sales. Using a top or bottom
filter can help you identify those clients or products.
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Filtering for the Top Sum
The final option for the Top 10 filter is to specify a sum. You’ll filter to find the top days that
combine for a total of at least $50,000:

1. Click the drop-down arrow in the Row Labels heading.

2. Click Value Filters, and then click Top 10.

3. In the Top 10 Filter dialog box, select Top from the first drop-down list.

4. In the second box, enter 50000.

5. Select Sum in the third box, and select Sum of TotalFee in the last box.

6. Click the OK button.

The pivot table shows only the eight days with the highest totals for TotalFee that com-
bine to total at least $50,000 (see Figure 6-39).

Figure 6-39. Filtering for the top sum

Summary
In this chapter, you learned how to add multiple filters to the pivot table and arrange multiple
report filters at the top of the pivot table. You manually arranged field items by dragging, using
commands, and typing. You sorted the field items automatically by using Ribbon commands,
using context menus, and using field heading drop-downs. Value items were sorted by column
or by row, from largest to smallest or smallest to largest. By creating a custom list, you were
able to automatically sort items in a custom order.

You filtered the row and column labels for specific text and viewed the sort and filter
information in a tool tip. You filtered the values for the row and column grand totals, and you
filtered for dates in a specific range or in a dynamic range. You manually filtered the pivot
table by checking items in the field drop-down list and filtered by selecting items in the row
labels. Finally, you filtered for top and bottom items in the pivot table, by items, by percent,
and by sum.

By creating a pivot table, you can quickly and easily summarize all the data in an Excel
table. Filtering and sorting in the pivot table allow you to focus on specific items or highlight
the high and low results. These tools add to the value of a pivot table and can help you identify
problem areas that should be addressed.
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Creating a Pivot Table 
from External Data

So far, you’ve created pivot tables from data that is stored in Excel tables. You can also create
a pivot table in Excel from many kinds of external data sources. In this chapter, you’ll connect
to data that is outside Excel, and you’ll create pivot tables from that data. You can download
and work with a text file, an OLAP cube, and a Microsoft Access query to see how the pivot
table creation process is slightly different depending on the source data. You’ll also see some
differences in pivot tables that are created from external data sources compared to pivot
tables based on Excel data.

To create a pivot table from data that is outside Excel, you can import the data to a work-
sheet and create the pivot table from the imported data, or you can create a connection to the
external data, telling Excel where the file is and how to connect to it, and then create a pivot
table from the data.

You’ll use both techniques to create pivot tables in the examples in this chapter:

1. First, you’ll import data from a text file onto a worksheet. Instead of creating an Excel
table from the data and using that as the source for your pivot table, you’ll create a
pivot table from the unformatted external data to show employee test results.

2. Next, you’ll connect to a query in an Access database and create a pivot table to show
shipment information.

3. Finally, you’ll connect to an OLAP cube to summarize sales information from another
database.

Creating a Pivot Table from a Text File
You have been sent a text file from the human resources (HR) department, and the HR man-
ager has asked you to create a report from this file to summarize the employee test scores by
location. Each month a new version of the text file will be created and sent to you so you can
create an updated report. To make the updates easier, you’ll connect to the text file and create
a pivot table from the external data.
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The first time you use a text file as the source for a pivot table, you should check it to
make sure it’s set up correctly. If necessary, you can make changes to the file so it’s ready to use
as the source for your pivot table. You’ll download and check the sample file that contains the
employee test scores.

1. Download the text file named EmployeeData.txt, and save it in one of your folders. In
this example, the file was saved in the c:\Data folder.

2. Using Notepad or another text editor program, open the EmployeeData.txt file to see
the data it contains (see Figure 7-1).

Figure 7-1. Text file opened in Notepad

3. Identify the type of text file you have opened—delimited or fixed width. This is a
delimited text file in which the field data in each row is separated by an identified 
character, or delimiter. In this file, the delimiter is the tab character, and in other files 
a comma or other character may be used. In a fixed-width text file, each field is a set
number of characters, and there is no separator between the fields.

4. Field headings are required in the first row of the text file if you plan to use it to create 
a pivot table. If the headings are missing, you should add them before using the file as
the source for your pivot table. This file contains a heading row that identifies the fields
in each record—EmpNo (employee number), FName, LName, HireDate, TestDate,
Location, Age, and Score.

5. Ensure that there is a line break at the end of each record to separate the records. 
In this file, each record starts on a new line.

6. The text file looks fine, so close the text file without making any changes.

Importing the Text File
After you have examined the text file, the next step is to open the workbook in which you want
the pivot table or create a new workbook where you will create the pivot table. To create the
report for the HR manager, you’ll create a new workbook and build the pivot table there using
the EmployeeData.txt file.
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As a first step, you’ll import the text file onto a worksheet, and later you’ll create the pivot
table from the imported data:

1. In Excel, create a new blank workbook.

2. On the Ribbon, click the Data tab, and in the Get External Data group, click From Text
(see Figure 7-2).

■Note You may see a single Get External button instead of several buttons. Click the Get External Data but-
ton, and then click From Text.

Figure 7-2. From Text command on the Ribbon

3. In the Import Text File dialog box, select the folder in which you stored the 
EmployeeData.txt file, select the file, and click Import (see Figure 7-3).

Figure 7-3. Import Text File dialog box
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4. On the Step 1 of 3 page of the Text Import Wizard, the wizard examines the file to deter-
mine which type of text file you are importing and shows a preview of the data. If it is
incorrect, you can change the original data type. For the EmployeeData.txt file, select
Delimited (see Figure 7-4).

Figure 7-4. Text Import Wizard’s Step 1 of 3 page

In the preview section at the bottom of the dialog box, you can see the first few rows of
data from the text file with small squares between the fields. These represent the tab
characters that separate the fields in the text file.

5. The import is set to start at row 1, which is correct for this file. If a text file had a few
rows at the start that you did not want to import, you could change the start row.

6. The file origin shown in Figure 7-4 is 437: OEM United States, but this may be different
on your screen depending on your regional settings in the Windows Control Panel. In
most cases, you can leave this option at the default setting. However, if a text file is
known to be from a different location and uses a character set, you can change the 
file origin.

7. Click Next to go to Step 2.

8. On the Step 2 of 3 page of the Text Import Wizard, the wizard has applied a tab delim-
iter to the text and shows a preview of the separated data. If the file uses a different
delimiter, such as a comma, you can change the delimiter. For the EmployeeData.txt
file, select Tab (see Figure 7-5).
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Figure 7-5. Text Import Wizard’s Step 2 of 3 page

9. Click Next to go to the next step.

10. On the Step 3 of 3 page of the Text Import Wizard, you can adjust the data type for each
column. In this example, General will be used for each column, and for other text files
you can change the data type for one or more columns if required. To change a data
type, click a column heading in the Data Preview area, and select a column data format
for that column (see Figure 7-6).

Figure 7-6. Text Import Wizard’s Step 3 of 3 page
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11. Click Finish to close the Text Import Wizard.

12. In the Import Data dialog box, leave the default setting for Existing Worksheet and the
formula (=$A$1) that references cell A1, and click OK (see Figure 7-7).

Figure 7-7. Import Data dialog box

13. The data from the EmployeeData.txt file appears on the worksheet, and you can create
a pivot table from this imported data.

14. Save the Excel file. In this example, the file was named EmpDataPivot.xlsx and saved in
the c:\Data folder.

Modifying the Connection
By importing the EmployeeData.txt file, you created a connection in the workbook. This is a
link to the EmployeeData.txt file outside Excel, and you can change some settings for this con-
nection to control how it works. For example, you can specify how often the data should be
refreshed and what should happen to the formatting when the data is refreshed.

You’ll view and test the current connection settings and then change some of the settings
for the connection to the EmployeeData.txt file:

1. Select a cell in the imported data.

2. On the Ribbon, click the Data tab, and in the Connections group, click Properties (see
Figure 7-8).

Figure 7-8. Properties command on the Ribbon

3. The External Data Range Properties dialog box opens and shows the current settings
for this connection, with the name of the external data range, EmployeeData, shown at
the top of the dialog box (see Figure 7-9).
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Figure 7-9. External Data Range Properties dialog box

4. In the Refresh Control section of the dialog box, remove the check mark from Prompt
for File Name on Refresh. With this setting turned on, you would have to select the
EmployeeData.txt file each time you refreshed the data. This setting may be useful if
the file name changes each day, for example, if there is a daily text file download. In
this case, the text file will remain the same, so you won’t want to be prompted during
each refresh.

5. In the Refresh Control section of the dialog box, add a check mark to Refresh Data
When Opening the File. With this setting turned on, you will ensure that the data is
current in the Excel file. If there have been changes to the EmployeeData.txt file, the
revised data will be available in the Excel file.

6. Click OK to close the External Data Range Properties dialog box.

You’ll leave the Excel file open while you make a change in the EmployeeData.txt file, and
then you’ll refresh the external data in Excel to test the settings you changed. The first name in
the text file was typed incorrectly, so you’ll change it.

1. Using Notepad or another text editor program, open the EmployeeData.txt file, and in
the first record, change the name from Celine to Celina.

2. Save and close the EmployeeData.txt file.
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3. In Excel, right-click a cell in the imported data.

4. In the context menu, click Refresh.

5. The external data is refreshed, and you were not prompted to select the 
EmployeeData.txt file. The name in the first record has changed to Celina.

Next, you’ll close the Excel file and then make another change to the EmployeeData.txt
file. When you reopen the Excel file, the external data should automatically refresh, because
you changed that setting for the external data connection. The first employee’s name needs
further correction, so you’ll make the additional change.

1. In Excel, save and close the EmpDataPivot.xlsx file.

2. Using Notepad or another text editor program, open the EmployeeData.txt file, and in
the first record, change the last name from Bloom to Blume.

3. Save and close the EmployeeData.txt file.

4. In Excel, open the EmpDataPivot.xlsx file, and check the name in the first record to 
verify that it was changed from Bloom to Blume.

Changing the Security Settings
If the name in the first record was not changed to Blume, your security settings may have pre-
vented the update. You may be able to adjust these settings, as described in this section, or
temporarily allow updates each time you open the file.

If the name in the first record was successfully changed, your security settings are allow-
ing data connections and won’t need to be changed. You can skip this section and proceed to
the next section to create the pivot table.

1. Below the Ribbon, you may see a security warning that tells you the data connections
have been disabled (see Figure 7-10).

Figure 7-10. Security warning for data connections

2. If the Security Warning bar is visible, click the Options button.

3. In the Microsoft Office Security Options dialog box, read the information about the
data connection and the file path for the Excel file. Because you know and trust the
source data, select the Enable This Content option, and click OK (see Figure 7-11).
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Figure 7-11. Microsoft Office Security Options dialog box

4. The external data is refreshed, and the name in the first record has changed to Blume.
The Security Warning bar disappeared from below the Ribbon. You have enabled the
content temporarily, and the Security Warning bar may reappear if you close and
reopen the Excel file.

If the Security Warning bar was not visible but the file did not refresh, your security set-
tings may have the message bar turned off. The content from the external data file has been
blocked, but you do not see the warning. You can manually refresh the external data:

1. Right-click a cell in the Excel table, and in the context menu, click Refresh.

2. If a Microsoft Office Excel Security Notice dialog box appears, read the information
about the external data source. Because you know that this source can be trusted, click
OK (see Figure 7-12).

Figure 7-12. Microsoft Office Excel Security Notice dialog box
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3. The external data is refreshed, and the name in the first record has changed to Blume.
You have enabled the connection temporarily, and the Security Notice dialog box may
reappear if you close and reopen the Excel file and try to refresh the data.

To permanently allow the connection each time you open the Excel file, you can add the
source data file to a trusted location. These are folders that you or your system administrator 
has designated as safe locations, and all files in these folders can be opened without a security
warning. To view or change these locations or to change other security settings, you can use 
the Trust Center, accessible through the Microsoft Office Button (click Excel Options, and then
click Trust Center). If you’re not sure about these settings, check with your system administrator.

Creating the Pivot Table
Now that the text file has been imported to a worksheet, you can create a pivot table from the
external data. The HR manager has asked for a summary of employee test scores by location,
so you will show a list of locations with a count of employees and the average test score for
each location.

Usually you would create an Excel table from the data on a worksheet and then use the
Excel table as the source for the pivot table. However, this data is in an external range that has
the name EmployeeData, which you saw in the External Data Range Properties dialog box. If
you try to create an Excel table from this data, it will override the external data range, and you
will lose your connection to the text file.

1. Select a cell in the imported data.

2. On the Ribbon, click the Insert tab, and in the Tables group, click PivotTable (see 
Figure 7-13).

■Caution Use the PivotTable command. Do not click the Table command and create an Excel table, or you
will remove your connection to the text file.

Figure 7-13. PivotTable command on the Ribbon

The Create PivotTable dialog box opens and shows the address of the external data
range, Sheet1!$A$1:$H$501, in the Table/Range box. You can use the external data
range address as the source range, and the pivot table will automatically adjust if rows
are added or removed in the source data. However, using the name of the external data
range may make the data source easier to identify when working with the pivot table.
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3. In the Table/Range box, type EmployeeData, which is the name of the external data
range, and then click OK (see Figure 7-14).

Figure 7-14. Entering the external data range name

4. A new worksheet, Sheet4, is inserted with an empty pivot table. In the PivotTable Field
List pane, you can see the field names from the EmployeeData.txt file.

5. In the PivotTable Field List pane, add a check mark to Location to add that field to the
Row Labels area.

6. In the PivotTable Field List pane, add a check mark to EmpNo to add that field to the
Values area and then change the field so it is summarized by Count.

7. In the PivotTable Field List pane, add a check mark to Score to add that field to the Val-
ues area and then change the field so it is summarized by Average. Change the number
format for the score so it has no decimal places.

8. To complete the pivot table, change the heading for Count of EmpNo to Emps, change
Average of Score to Avg Score, and make the columns narrower (see Figure 7-15).
These changes will make the report more visually appealing and easier for the HR
manager to read. You can now send the report, showing the number of employees who
were tested at each location and the average scores.

■Note If the external data has changed, that will not be reflected in the pivot table until the imported 
data is refreshed and then the pivot table is refreshed. Refreshing the pivot table does not refresh the
imported data.

CHAPTER 7 ■ CREATING A PIVOT TABLE FROM EXTERNAL DATA 133

8903Ch07CMP1  7/31/07  8:44 PM  Page 133



Figure 7-15. Pivot table from text file

9. Now that you have completed the pivot table, save and close the EmpDataPivot.xlsx file.

Creating a Pivot Table from an Access Query
Another source that you can use for pivot tables is a query in a Microsoft Access file. In this
example, you’ll download a small database in which shipments are recorded. You do not need
a copy of Microsoft Access on your computer in order to connect to an Access database from
Excel.

Connecting to the Access Query
Impressed by the report you created for the HR manager, the shipping manager has sent you a
copy of the shipments database and has asked you to summarize the freight charges for each
county. In the database is a query that combines data from three tables: Shipments, Contracts,
and Counties. You’ll connect to this query and create a pivot table to summarize the freight
charges by county. When you create this report in Excel, employees who don’t have Access
installed will be able to view and manipulate the shipments report.

1. Download the Access database file named Shipments.accdb, and save it in one of 
your folders. In this example, the file was saved in the c:\Data folder.

2. The shipping manager has sent you a screen shot of the Access query named 
ShipmentsByDate, which is the query that you’ll connect to when creating the 
pivot table (see Figure 7-16).
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Figure 7-16. ShipmentsByDate query in Access database

3. Before using this query for the first time, you’ll confirm it contains all the fields you’ll
need for the pivot table. If anything is missing, you’ll ask the shipping manager to
make changes to the Access query. In the pivot table, you want to summarize the
freight charges by county, and you can see that the County and FreightAmt columns
are in the query results.

4. You will also need the freight tax amounts in the pivot table totals, and that has been
calculated in the query based on the county tax rate. The query also calculates the total
amount, which is freight plus tax.

■Tip It is best to include these line calculations in the Access query to ensure that the results are accurate,
because the pivot table cannot calculate the line details.

5. Now that you have verified that the query is set up correctly, you’re ready to create the
pivot table.

In the following steps, you’ll create a new workbook and build the pivot table there using
the query in the Shipments.accdb Access database. You’ll connect to the query and create the
pivot table directly from the data. Unlike the text file you used for the Employee test scores
pivot table, you won’t import the Access data onto a worksheet.

1. In Excel, create a new blank workbook.

2. On the Ribbon, click the Data tab, and in the Get External Data group, click From
Access.

3. In the Select Data Source dialog box, locate and select the Shipments.accdb file, and
then click Open.
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4. In the Select Table dialog box, select ShipmentsByDate, which is the query you want to
use, and then click OK (see Figure 7-17).

Figure 7-17. Select Table dialog box

5. The Import Data dialog box opens, with a list of options for viewing the data. Select
PivotTable Report from the list of view options, and select cell A1 on the existing work-
sheet as the location for the data (see Figure 7-18).

Figure 7-18. Import Data dialog box

6. Click OK to close the Import Data dialog box.

An empty pivot table is created on Sheet1. In the PivotTable Field List pane, you can see
the field names from the ShipmentsByDate query. You created a connection to the query in
the Access database, and you can use its data in your pivot table.

You’ll add fields to the pivot table layout to show a list of counties, with a count of ship-
ments and the average total freight for each county:

1. In the PivotTable Field List pane, add a check mark to County to add that field to the
Row Labels area.

To count the shipments, you’ll add the delivery date field, DelDate, to the Values area.
Since each record has a delivery date, this will be a reliable field to use for the count.
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2. In the PivotTable Field List pane, add a check mark to DelDate, and then move that
field to the Values area, where it will be summarized by count.

To calculate the average shipping cost, you’ll add the total amount field, TotalAmt, to
the Values area.

3. In the PivotTable Field List pane, add a check mark to TotalAmt to add that field to the
Values area, and then change the field so it is summarized by Average. Change the
number format to Currency.

4. To complete the pivot table, change the heading for Count of DelDate to Shipments,
change Average of TotalAmt to Avg Total, and make the columns narrower (see 
Figure 7-19).

Figure 7-19. Pivot table from Access query

5. Now that you have completed the pivot table for the shipping manager, save the file as
ShipmentPivot.xlsx. In this example, the file was saved in the c:\Data folder.

Modifying the Connection to the Access Query
By creating a pivot table from the Access query, you created a connection in the workbook.
This is a link to the Access file outside Excel, and just as you did for the text file connection
earlier, you can change some settings for this connection to control how it works.

You’ll view the current connection settings and then change the settings for the connec-
tion to the ShipmentsByDate query to ensure that the data is refreshed frequently while the
Excel file is open. Then, if the shipping manager opens your workbook first thing in the morn-
ing, the data will be refreshed throughout the day if the workbook is left open.

1. On the Ribbon, click the Data tab, and in the Connections group, click Connections
(see Figure 7-20).

Figure 7-20. Connections command on the Ribbon
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2. The Workbook Connections dialog box opens and shows the connections in the active
workbook. The Shipments connection is listed, and you can scroll to the right in the
list to see the date and time that the connection was last refreshed (see Figure 7-21).

Figure 7-21. Workbook Connections dialog box

In the lower half of the Workbook Connections dialog box, you can view a list of 
locations where a connection is used in the workbook. You’ll select the Shipments 
connection and see where it is used.

3. Select the Shipments connection in the list at the top of the dialog box.

4. In the lower section of the dialog box, point to the text that says Click Here to See
Where the Selected Connections Are Used.

5. When the text becomes underlined, click the underlined text, and you’ll see the sheet,
name, and location of the pivot table listed (see Figure 7-22).

Figure 7-22. List of locations where the selected connection is used
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When the list of locations is visible, you can use it to select any location that is listed.
This feature is especially helpful if you have multiple connections and pivot tables in a
workbook and want to understand how things were set up.

6. Click the location information, and the pivot table on Sheet1 is selected.

From the Workbook Connections dialog box, you can access the Connection Properties
dialog box to view or change the properties for the selected connection. You want to
change the refresh settings for the connection, so you’ll open the Connection Proper-
ties dialog box.

7. With the Shipments connection selected in the list, click the Properties button. In the
Connection Properties dialog box, on the Usage tab, you can see the date and time of
the last refresh and the current settings for the connection. At the top of the dialog box
are the connection name and description (see Figure 7-23).

■Tip You can type a description to explain what data the connection contains, why the connection is used,
or other notes that will help you when using the file.

Figure 7-23. Connection Properties dialog box
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8. In the Refresh Control section, add a check mark to Refresh Every 60 Minutes, and
change the time to 30 minutes. This will ensure that the external data is refreshed 
frequently, so if the data changes in the Access database, the revised information will
be available in the Excel file.

■Note This option is available only when using external data.

9. Also add a check mark to Refresh Data When Opening the File. This will ensure that the
external data is automatically refreshed as soon as the file opens.

10. To see the settings that were stored when you created the connection, click the Defini-
tion tab (see Figure 7-24). You can see the connection type and the location of the
connection file. The Connection String box contains information that tells Excel how
to connect to the external data, and the Command Text box contains information
about the Access query.

Figure 7-24. Definition tab in the Connection Properties dialog box

11. Leave these settings untouched, and click OK to close the Connection Properties dia-
log box. Then click Close to close the Workbook Connections dialog box.

The Security Warning bar may appear, alerting you that the data connections have been
disabled. Just as you did for the EmployeeData.txt file connection, you can click the Options
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button and enable the content. You can also add the source file to a Trusted Location to 
prevent the Security Warning bar from reappearing.

Using an Existing Connection to Create a Pivot Table
The shipping manager likes the pivot table you created to show the shipments per county and
asks whether you can create another report in the same workbook. In this report, the number
of shipments per delivery truck should be listed to see whether the loads are evenly distrib-
uted among the drivers.

After you have created a connection in a workbook, you can use it again to create a pivot
table or to import data to a worksheet. You’ll reuse the Shipments connection to create
another pivot table. On Sheet2, you’ll create a pivot table to summarize the data by truck to
count the shipments per county for each delivery truck:

1. Select Sheet2, where you’ll create the new pivot table.

2. On the Ribbon, click the Data tab, and in the Get External Data group, click Existing
Connections (see Figure 7-25).

Figure 7-25. Existing Connections command on the Ribbon

■Note If the active cell is in a pivot table, the Existing Connections command won’t be available.

3. In the Existing Connections dialog box, from the Show drop-down list, select Connec-
tions in this Workbook.

4. In the list of connections, select Shipments, and click Open (see Figure 7-26).

Figure 7-26. Existing Connections dialog box
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5. In the Import Data dialog box, select PivotTable Report as the way you want to view the
data in your workbook. Leave the default settings for the Where Do You Want to Put the
Data? option, and click OK.

6. An empty pivot table is created on Sheet2. In the PivotTable Field List pane, you can
see the field names from the ShipmentsByDate query.

Now you can create a different pivot table from the external data. You’ll show a list of
delivery trucks, with a count of shipments for each truck.

7. In the PivotTable Field List pane, add a check mark to Truck, and then move that field
to the Row Labels area.

8. In the PivotTable Field List pane, add a check mark to DelDate, and then move that
field to the Values area, where it will be summarized by Count.

9. To complete the pivot table, change the heading for Count of DelDate to Shipments,
change Row Labels to Truck, and make the columns narrower (see Figure 7-27).

Figure 7-27. Reusing a connection to create another pivot table

10. Now that you have completed the second pivot table, save the ShipmentPivot.xlsx file,
and then close it.

Creating a Pivot Table from an OLAP Cube
Another source that you can use for pivot tables is an OLAP cube. This is aggregated data from
an Online Analytic Processing (OLAP) database and can provide an efficient way for you to
analyze data from SQL Server or another large database. In this example, you’ll use a small
OLAP cube, created from a hardware sales database. It will give you an opportunity to connect
to the OLAP cube and see the differences in a pivot table that is created from this type of data
source.

Understanding OLAP Cubes
Using a pivot table, you can easily connect to thousands of rows of data in an Excel table or in
a data source outside Excel. However, for some applications, there may be hundreds of thou-
sands or millions of rows of data, which could be more than a pivot table is able to process
with acceptable speed or could exceed the memory limits of your computer. For example, a
national hardware chain might have hundreds of thousands of purchases each month. To effi-
ciently process and store that much data, large and powerful databases are required.
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The vice president of sales has asked you to create a couple of reports from transaction
data that has been collected by a hardware chain. Figure 7-28 shows a small sample of the
data. For each transaction, information about the product, the selling location, the date, the
quantity sold, and the price is entered.

Figure 7-28. Hardware sales records

You won’t be permitted to connect your pivot table directly to the transaction database.
Instead, the database administrator will create a subset of the data for you in an OLAP cube. In
the OLAP cube, instead of raw data, the data will be aggregated based on the information you
need to analyze. In Excel, you can connect to the OLAP cube by creating a pivot table.

You send your report requirements to the database administrator so the OLAP cube can
be created. The first report you’ll create will show the total dollar amounts for each product
group per region. The second report will show the quantity of each product sold, per year, for
the East region.

To create the OLAP cube, the database administrator might use a product such as
Microsoft SQL Server 2005 Analysis Services, Hyperion Essbase, Cognos PowerPlay, or Busi-
ness Objects. In the OLAP cube, there are two types of data: measures and dimensions. The
measures are numerical fields, such as quantity and price, that will be used in the Values area
of a pivot table. The dimensions are the categories in which the data will be summarized, such
as Region and ProductGroup. The dimensions are arranged in hierarchies of related fields. In
the hardware sales data, Region, City, and StoreNo are in a hierarchy, as are ProductGroup and
ProdName (see Figure 7-29). When the SaleDate field is added to the OLAP cube, a time hier-
archy is automatically created, with Year, Quarter, Month, Week, and Day.

Figure 7-29. Dimensions in hierarchies
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When you create a pivot table based on the OLAP cube, you’ll see these hierarchies in the
PivotTable Field List pane and in the pivot table layout. A pivot table that is based on an OLAP
cube has some differences from a pivot table that is based on other data sources, and you’ll
see those as you create your hardware sales pivot table.

Connecting to an OLAP Cube
The database administrator e-mails to let you know that the OLAP cube is ready for you to use.
The only way that the OLAP cube data is available in Excel is through a pivot table. You’ll take
advantage of that limitation and create a pivot table simply by opening the cube file in Excel.
From the empty pivot table, you’ll create your first report, showing the sales by product group
and by region:

1. Download the OLAP cube file named HardwareSales.cub, and save it in one of your
folders. In this example, the file was saved in the c:\Data folder.

2. In Excel, click the Microsoft Office Button, and click Open.

3. In the Open dialog box, in the Files of type drop-down list, choose All Files (*.*).

4. In the c:\Data folder, select the HardwareSales.cub file, and click Open.

5. If the Microsoft Office Excel Security Notice dialog box appears, click Enable to allow
the data connection.

6. The connection to the OLAP cube is created, an empty pivot table appears on the
active worksheet, and the PivotTable Field List pane shows the fields from the OLAP
cube (see Figure 7-30).

Figure 7-30. PivotTable Field List pane for OLAP cube fields

When the data source is an OLAP cube, the PivotTable Field List pane looks different than
it does for other data sources. At the top is a list of Values, and these are the only fields that can
be placed in the Values area. These are the measures, which are the numeric fields from the
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source data, and they can be placed only in the Values area. In the transaction database,
OrderPrice is the total price for each order, and Qty is the quantity sold in each order.

Below Values in the PivotTable Field List pane are the remaining fields, and these can be
placed in the Row Labels, Column Labels, or Report Filter area. These are the dimensions, and
they look different than fields from other data sources because they have plus and minus but-
tons that show the fields in a hierarchy. For example, click the plus sign beside SaleDate, and
the field expands to show Year, Quarter, Month, and Day.

The vice president of sales has asked for a report on the total sales for each product group
in each region, so you’ll add the ProductGroup, Region, and Sum Of OrderPrice fields to the
pivot table layout:

1. In the PivotTable Field List pane, add a check mark to ProductGroup, and then move
that field to the Column Labels area.

2. In the PivotTable Field List pane, add a check mark to Region, which will appear in the
Row Labels area.

3. In the PivotTable Field List pane, add a check mark to Sum Of OrderPrice, which will be
added to the Values area, where it will be summarized by Sum.

■Note The summary function cannot be changed for Values in a pivot table that is based on an OLAP cube.

4. To complete the pivot table, format the values as currency with zero decimal places
(see Figure 7-31).

Figure 7-31. Pivot table based on an OLAP cube

5. Now that you have completed the first report, save the file as HardwarePivot.xlsx. In
this example, the file was saved in the c:\Data folder.

Modifying the Connection to the OLAP Cube
By opening the OLAP cube file in Excel, you created a pivot table and a connection in the
workbook. You’ll view the current connection settings to see the settings that are available
when an OLAP data source is used:

1. On the Ribbon, click the Data tab, and in the Connections group, click Connections.
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2. In the Workbook Connections dialog box, select the HardwareSales connection, and
click Properties.

3. In the Connection Properties dialog box, you can see the date and time of the last
refresh and the current settings for the connection. The Enable Background Refresh
setting is not available, but the OLAP Server Formatting, OLAP Drill Through, and Lan-
guage settings are available (see Figure 7-32).

Figure 7-32. Connection Properties dialog box for OLAP-based pivot table

4. Add a check mark to Refresh Data When Opening the File. This will ensure that the
external data is refreshed as soon as the file opens. If the OLAP cube has been updated,
you’ll automatically be connected to the new data.

5. Click OK to close the Connection Properties dialog box, and click Close in the Workbook
Connections dialog box.

Next, you’ll create your second report to show the quantity of each product sold, per year,
for the East region. You want to limit the data to show only one region, so you’ll move that field
to the Report Filter area:

1. Select a cell in the pivot table, and in the PivotTable Field List pane, move the Region
field to the Report Filter area.
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2. Click the Region drop-down list in cell B1, and then click the + sign beside All to open
the list of regions.

3. Select East, which is the region you want in your report, and then click OK (see 
Figure 7-33).

Figure 7-33. Report filter for East region

4. In this report, you want to see the quantities sold, so in the PivotTable Field List pane,
remove the check mark from Sum Of OrderPrice, and add a check mark to Sum of Qty.

■Note For a pivot table based on an OLAP cube, the measures (numeric fields) can be added only to the
Values area of the PivotTable Field List pane.

5. In the PivotTable Field List pane, move the ProductGroup field to the Row Labels area.

For this report, you’re interested in the individual products, so you’ll expand the field
so all the product names are visible.

6. Select a cell that contains a ProductGroup label. For example, select cell A4, which
contains the Electric label.

7. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

8. In the Active Field group, click Expand Entire Field (see Figure 7-34).

Figure 7-34. Expand Entire Field command
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■Tip Later, to hide the product names, you could select a ProductGroup label and then click the Collapse
Entire Field command on the Ribbon.

The product names under each product group become visible, and you can see the
total quantity for each product. Next, you’ll add the SaleDate field to see the totals per
year. Because the pivot table is based on an OLAP cube, you won’t have to group the
date field in order to see the totals per year. You’ll examine the SaleDate field in the 
PivotTable Field List pane and then add it to the pivot table layout.

9. In the PivotTable Field List pane, click the + sign to the left of the SaleDate field’s check
box. This will expand the hierarchy for SaleDate (see Figure 7-35).

Figure 7-35. The expanded SaleDate hierarchy

10. Add the SaleDate field to the Column Labels area. Because Year is the highest level in
the SaleDate hierarchy, the Year labels, 2007 and 2008, appear in the Column Labels
area (see Figure 7-36). The report now shows the total quantity sold per year for each
product in the East region.

Figure 7-36. The completed pivot table
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■Tip To see the quantities sold per quarter, select one of the Year labels, and click the Expand Entire Field
command on the Ribbon. To hide the quarters, click the Collapse Entire Field command.

11. Now that you have completed the pivot table, save and close the HardwarePivot.xlsx file.

Summary
In this chapter, you created connections to data outside Excel, and you created pivot tables
from that data. With this capability, you can reach beyond your Excel data and report on data
that is stored in other formats.

To work with a text file, you imported the data to a worksheet and created a pivot table
from the imported data. You changed the data in the text file and refreshed the pivot table to
show the updated data. If necessary, you changed the security settings to allow the connection
to the external data.

Next, you connected to a query in an Access database and built a pivot table from that
data. Then you modified the connection to ensure that the data was refreshed frequently. You
used the features in the Workbook Connections dialog box to list the locations where the
selected connection was used and to go to that location. In the same workbook, you created a
second pivot table, based on the existing connection.

Finally, you connected to an OLAP cube by simply opening the cube in Excel. This auto-
matically created a connection to the OLAP cube and an empty pivot table. While working on
this pivot table, you saw differences in the fields in the PivotTable Field List pane and col-
lapsed and expanded the fields in the pivot table.
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Updating a Pivot Table

In this chapter, you’ll learn how to maintain a pivot table after you’ve created it to ensure that
it shows the correct data and stores the data in the way that works best for you. For example:

• If your pivot table is based on an Excel table, what will happen if someone edits the
sales data or adds new records? How will you ensure that your pivot table is updated
and shows the correct results?

• If a product name is changed in all the records in the database, do you want to see the
old name in the pivot table’s filter drop-down lists, or should the old name be removed?

• If your pivot table is based on a query in a Microsoft Access database, how can you
make it easy to get the updated data into your pivot table throughout the business day?

• If someone moves or renames the Access database, how can you reconnect to it so your
pivot table will continue to work correctly?

• When you close the Excel workbook, should the pivot table data be stored in memory
so it’s ready to use as soon as you open the workbook?

Updating an Excel Table
In this chapter, you’ll work with a sample workbook that contains two Excel tables with food
sales data for the East and North regions. It also contains a pivot table that uses one of the
Excel tables as its data source. The sales manager has asked you to make some corrections to
the data and to update the pivot table.

You haven’t worked with the file before, so to start, you’ll examine the Excel tables that
contain the data and determine which Excel table is the source for the pivot table. Next, you’ll
make the corrections and refresh the pivot table so it includes the updated data.

1. Download and open the sample file named RegionSales.xlsx, available on the Apress
website.

2. On the Pivot_East worksheet, you can see the pivot table that shows sales totals for
Boston, New York, and Philadelphia (see Figure 8-1). The grand total for these cities is
$344,461.
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Figure 8-1. Pivot table on Pivot_East worksheet

3. On the Sales_East worksheet, you can see the sales data for Boston, New York, and
Philadelphia, so you assume the pivot table uses that Excel table as its source. On the
Design tab on the Ribbon, you can see that the table name is Sales_East.

4. On the Sales_North worksheet, you can see the sales data for Chicago, Detroit, and
Seattle. On the Design tab on the Ribbon, you can see that the table name is
Sales_North.

Before you change the data, you want to confirm that the pivot table is based on the
Sales_East Excel table. To determine the source of the pivot table, you can use the Change
Data Source command on the Ribbon:

1. On the Pivot_East sheet, select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab, and in the Data
group, click the top section of Change Data Source (see Figure 8-2).

Figure 8-2. Change Data Source command

The Change PivotTable Data Source dialog box opens and shows that Sales_East is 
the Excel table on which the pivot table is based. In the background, the Sales_East
sheet has been activated, and the Sales_East Excel table is selected. Now that you 
have confirmed the data source, you’ll make the changes to the data in the Sales_East
Excel table.
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3. Click Cancel to close the Change PivotTable Data Source dialog box.

The final entry on the Sales_East worksheet is incorrect, so you’ll change it and then
update the pivot table.

4. On the Sales_East worksheet, change the numbers in the last record, as shown in 
Table 8-1.

Table 8-1. Sales_East Excel Table Data Changes

Qty TotalCost SellPrice TotalPrice Profit

521 651.25 1641.15 1641.15 989.9

5. Return to the Pivot_East worksheet, where the grand total remains unchanged, at
$344,461.

When the source data changes, the pivot table has to be refreshed before it shows the
summary of the revised data. In previous chapters, you manually refreshed the pivot table by
using the Refresh command. In this pivot table, you’ll change the settings so the pivot table
will refresh automatically when you open the workbook. This will ensure that the pivot table is
up-to-date when you start working with it.

1. Right-click a cell in the pivot table, and click PivotTable Options to open the PivotTable
Options dialog box.

2. On the Data tab, add a check mark to Refresh Data When Opening the File (see 
Figure 8-3).

Figure 8-3. Refreshing data when opening the file

3. Click OK to close the PivotTable Options dialog box.

■Note Whether this setting is on or off, after the workbook is opened, you can manually refresh the pivot
table at any time.
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4. To test the setting, save and close the file, and then reopen it. The pivot table was auto-
matically refreshed, and the grand total has increased to $345,406 (see Figure 8-4).

Figure 8-4. The pivot table was automatically refreshed.

Using this setting to refresh a pivot table when the file opens may make it slower to open 
a file, especially if the Excel table is large. However, you’ll ensure that the pivot table contains
the latest data and reduce the chance that you’re working with outdated information in your
report.

Changing an Excel Data Source
When you create a pivot table from data in Excel, you select a table or range as its data 
source. In the RegionSales.xlsx workbook, there is one pivot table, and its data source is the
Sales_East Excel table. Occasionally, after you have created a pivot table, you may need to
select a different data source for the pivot table. For example, this could happen if you used a
range of cells as the pivot table’s data source instead of a formatted Excel table. If you add new
rows to an Excel table, they are automatically included in the source data range for the pivot
table. However, in an unformatted range of cells, new rows would not be automatically
included in the data source range, and you would have to change the range to include them.

Another reason to change the data source is if you make a copy of a pivot table and want
the copy to use a different data source than the original pivot table. The sales manager likes
the layout of the East region’s pivot table and has asked you to create a pivot table for the
North region with the same layout and formatting.

Instead of starting from scratch and trying to duplicate the layout and formatting, you’ll
make a copy of the East region’s pivot table and then change its data source so it is based on
the data on the Sales_North worksheet. To copy the pivot table, you’ll make a copy of the
worksheet that it’s on:

1. To make a copy of the existing pivot table, right-click the sheet tab for the Pivot_East
worksheet, and in the context menu, click Move or Copy (see Figure 8-5).
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Figure 8-5. Right-click a sheet tab to open the context menu.

2. In the Move or Copy dialog box, in the Before Sheet list, select Sales_North, because
you want the new worksheet positioned between the Sales_East and Sales_North
sheets (see Figure 8-6).

Figure 8-6. Move or Copy dialog box

3. Add a check mark to Create a Copy, and then click OK.

4. Double-click the sheet tab for the new sheet, and change the sheet name from
Pivot_East (2) to Pivot_North.

■Tip To quickly copy the active sheet, press the Ctrl key, point to the sheet tab, and drag it to the left or
right, beside an existing sheet. A small black triangle indicates where the sheet will be placed. Release the
mouse button and then the Ctrl key, and the sheet will be copied.
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By copying the Pivot_East worksheet, you’ve created a copy of the East region’s pivot table.
The layout and formatting are the same, just as the sales manager wanted. The new pivot table
still shows the summarized data for the East region, because it is based on the Sales_East Excel
table. You’ll change the data source so the new pivot table summarizes the data for the North
region:

1. On the Pivot_North worksheet, select a cell in the pivot table, and on the Ribbon,
under the PivotTable Tools tab, click the Options tab.

2. In the Data group, click the top section of the Change Data Source command.

3. The Sales_East sheet is activated, and the Sales_East Excel table has a flashing border.
The Change PivotTable Data Source dialog box opens, showing the current data source
for the pivot table, Sales_East.

4. In the Table/Range box, change the name of the Excel table to Sales_North (see 
Figure 8-7), and click OK.

Figure 8-7. Change PivotTable Data Source dialog box

5. The pivot table is automatically updated and shows the names of the three cities in the
North region—Chicago, Detroit, and Seattle—with their sales totals (see Figure 8-8).

Figure 8-8. Pivot table after the data source change

By making a copy of the East region’s pivot table and changing the data source, you were
able to create a pivot table very quickly, with the same layout and formatting as the existing
pivot table.
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Refreshing All Pivot Tables in a Workbook
Now that you have multiple pivot tables in the workbook, you may want to refresh them all at
the same time instead of refreshing each pivot table individually. You’ll correct a record in the
source data for each pivot table and then refresh both pivot tables at once:

1. In the Sales_East Excel table, change TotalPrice in the first record from 115.77 to
10115.77. This record was for a Banana Bars sale in Boston, so that amount should
increase when the Pivot_East pivot table is refreshed.

2. In the Sales_North Excel table, change TotalPrice in the first record from 202.03 to
10202.03. This record was for a Banana Bars sale in Chicago, so that amount should
increase when the Pivot_North pivot table is refreshed.

Neither pivot table has been refreshed yet, and each shows the same grand total
amount it showed before you corrected the TotalPrice amounts. The East grand total is
still $345,406, and the North grand total is still 320,922. Next, you’ll use a command on
the Ribbon to refresh both pivot tables with one mouse click.

3. Select any cell in the workbook, and on the Ribbon, click the Data tab, and in the Con-
nections group, click the upper section of the Refresh All command (see Figure 8-9).

Figure 8-9. Refresh All command on the Ribbon

■Tip Refresh All is also available under the PivotTable Tools tab on the Ribbon’s Options. In the Data group,
click the lower section of the Refresh command, and then click Refresh All.

4. Check the Pivot_East worksheet, and you’ll see that the grand total has increased from
$345,406 to $355,406. On the Pivot_North worksheet, you’ll see that the grand total has
increased from $320,922 to $330,922.

Using the Refresh All command makes it easy to update many pivot tables in one work-
book at the same time. If you’ve changed data in several sources, you can use this command
to update all the affected pivot tables with one click of the mouse.

■Note Using the Refresh All command will refresh all pivot tables and external data ranges in the active
workbook and will affect both visible and hidden worksheets.
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Retaining Deleted Items
The sales manager has asked you to change the name of one of the products in the Sales_East
Excel table. After testing the new product in the East region, the marketing department has
decided to change the cracker name from Cheese to Cheesy. When you change the records,
there will no longer be a product named Cheese in the data.

You can decide how you want your pivot table to deal with this deleted product. Do you
want to continue to see the product name in the pivot table filters, even if it doesn’t have any
data in the current month’s report? Would you prefer to have deleted items disappear, if they
are no longer included in the data?

By retaining the old items, you’ll be aware of what has been removed and can investigate
the reasons why they no longer have data in the source data. However, the old items can make
the filter lists longer than necessary and may make it difficult to find the active items.

Changing the cracker name will result in a product being removed from the source data,
and you’ll see the effect of that change. Before you make the change to the source data, you’ll
modify the pivot table layout to show product information instead of cities:

1. On the Pivot_East sheet, remove the City field from the Row Labels area, and add the
Product field to the Row Labels area.

2. On the Sales_East sheet, scroll up to row 1, and filter the Product column to see only
the Cheese product.

3. In each of the three records for this product, change the product name to Cheesy.

4. On the Pivot_East sheet, refresh the pivot table.

The Cheese label disappears from the pivot table layout, and Cheesy appears at the end
of the list of products.

5. Click the arrow for the Row Labels to open the Sort and Filter list. Although the Cheese
label has been removed from the pivot table layout, it remains in the Sort and Filter list
(see Figure 8-10).

Figure 8-10. The deleted item remains in the filter list.
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6. Click Cancel to close the Sort and Filter list.

You’ll change a pivot table setting so deleted items don’t remain in the filter list. These
items can make the filter list excessively long and can make it harder to find the active
items in the list.

7. Right-click a cell in the pivot table, and click PivotTable Options.

8. On the Data tab, from the Number of Items to Retain per Field drop-down list, choose
None (see Figure 8-11).

Figure 8-11. Setting the number of items to retain per field

9. Click OK to close the PivotTable Options dialog box.

10. Refresh the pivot table, and then click the arrow for the row labels to open the Sort and
Filter list. The Cheese label has been removed from the Sort and Filter list.

11. Click Cancel to close the Sort and Filter list.

You can use this setting to prevent the accumulation of old items in the pivot table, espe-
cially if the items change frequently.

Now that you have made the corrections to the RegionSales.xlsx file and created a new
pivot table for the North region, you can save the file and close it. Next, you’ll refresh pivot
tables that are based on external data.

■Tip Instead of creating multiple pivot tables from data in separate Excel tables, you could combine the
data in one Excel table, create a single pivot table, and use a report filter to show the results for a specific
region.
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Changing an Access Data Source
In the previous chapter, you created a pivot table that was based on a Shipments query in an
Access database. Your IT department has revised the database and asked you to use the new
file as the data source for your pivot table instead of the old one. They have added a new
county to the list of counties, and there are a few new contracts and shipments.

You’ll complete these steps when connecting to the new database:

1. Download the new database, and open the Excel file.

2. Create a new connection and a temporary pivot table.

3. Change the existing pivot table so it uses the new connection.

4. Remove the temporary pivot table and the old connection.

Step 1: Download the New Database, and Open the Excel File
Follow these instructions to download the revised database and to open the Excel file that
contains the current pivot table. After that, you’ll create a connection to the new database 
and then change the data source for the pivot table.

1. Download the revised version of the database, ShipmentsNew.accdb (which is available
on the www.apress.com web site), and save it in one of your folders. In this example, the
database is saved in the c:\Data folder.

2. Open the Excel file ShipmentPivot.xlsx you created in Chapter 7, or download and
open the file ShipmentPivot02.xlsx (available on the www.apress.com web site).

3. If the Security Warning bar appears, click Options, and enable the content. This will
allow the connection to the Access database.

Step 2: Create a New Connection and a Temporary Pivot Table
One of the easiest ways to change the external data source is to create a connection to the new
database and then change the data source for the pivot table so it uses the new connection.
Now that you have the Excel file open, you’ll create a new connection to the new Shipments
database:

1. Select a cell outside the pivot table. If a cell inside the pivot table is active, you won’t be
able to select a new data source.

2. On the Ribbon, click the Data tab, and in the Get External Data group, click From
Access.

3. In the Select Data Source dialog box, select the folder in which you saved the 
ShipmentsNew.accdb file, select the file, and click Open.
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4. In the Select Table dialog box, select ShipmentsByDate, which is the query you want to
use, and click OK (see Figure 8-12).

Figure 8-12. Select Table dialog box

Although you want to continue to use your existing pivot table, you’ll create a new
pivot table temporarily to establish the new connection. Later, you’ll delete this tem-
porary pivot table.

5. In the Import Data dialog box, select PivotTable Report, select New Worksheet as the
location for the pivot table, and then click OK.

Step 3: Change the Existing Pivot Table So It Uses the New 
Connection
A new worksheet was inserted, and it contains an empty pivot table. Now that you have 
created the new connection, you’ll change the data source for the original pivot table:

1. On Sheet 1, select a cell in the original pivot table, and on the Ribbon, under the 
PivotTable Tools tab, click the Options tab.

2. In the Data group, click the top section of the Change Data Source command.

The Change PivotTable Data Source dialog box opens and shows Shipments as the
connection name.

3. In the Change PivotTable Data Source dialog box, click Choose Connection.

The Existing Connections dialog box opens and shows an All Connections list. You are
interested only in the connections in the active workbook, so you’ll change the setting
at the top of the dialog box to limit the number of connections that are shown in the
list. This will make it easier to find the connection you need.
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4. At the top of the Existing Connections dialog box, choose Connections in this Workbook
from the Show drop-down list (see Figure 8-13).

Figure 8-13. Existing Connections dialog box

5. In the list of connections, click ShipmentsNew, and then click Open.

The Change PivotTable Data Source dialog box now shows ShipmentsNew as the con-
nection name.

6. In the Change PivotTable Data Source dialog box, click OK.

7. The pivot table is automatically updated and shows the new county, Tehama, with one
shipment.

Step 4: Remove the Temporary Pivot Table and the Old 
Connection
Now that the original pivot table uses the new connection, you’ll delete Sheet4, which con-
tains the empty pivot table that was created for the new connection:

1. Right-click the tab for Sheet4, and click Delete. When the warning message appears,
click Delete to delete the sheet.

Finally, you’ll delete the old connection to the query in the Shipment database, since
it’s no longer needed.

2. On the Ribbon, click the Data tab, and in the Connections group, click the Connections
command.

3. In the Workbook Connections dialog box, select the Shipments connection, and click
Remove (see Figure 8-14).
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Figure 8-14. Removing an existing connection

4. Read the warning message that appears, and then click OK to remove the connection.

5. Click Close to close the Workbook Connections dialog box.

By creating a new connection and changing the data source for the existing pivot table,
you were able to change the data source quickly and easily while maintaining the layout and
formatting of the existing pivot table. There are other ways to change the data source for an
Access database, but this method, while requiring several steps, is one of the easiest.

Refreshing the Pivot Table Regularly
When a pivot table is based on external data, you can change the connection settings so the
connection will update regularly while the file is open. You’ll set this option for the Shipments
pivot table, because you expect the source data to change frequently throughout the day while
new shipments are arranged.

1. Select a cell in the pivot table.

2. On the Ribbon, click the Data tab, and in the Connections group, click Properties.

3. In the Connection Properties dialog box, on the Usage tab, add a check mark to Refresh
Every 60 Minutes (see Figure 8-15).

Figure 8-15. Refreshing data every 60 minutes
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■Note This option is available only for pivot tables with an external data source.

After you check the option, the scroll box for minutes is activated. You’ll change this
setting so the data will refresh every half hour.

4. In the scroll box for minutes, change the setting to 30 minutes.

5. Click OK to close the Connection Properties dialog box.

You can use this option for refreshing the connection if the source data changes fre-
quently and it’s important that the pivot table reflect the latest available data.

Saving Source Data with the File
When you create a pivot table, the records from the source data are saved in a memory area
named a pivot cache. When you close the file, you can save the source data in this pivot cache,
or you can choose to not save it. Both options have advantages and disadvantages:

• If you save the source data, the file will be larger but may open more quickly.

• If you do not save the source data, the file will be smaller but may open slowly while the
pivot cache is rebuilt.

The ShipmentPivot.xlxs file is based on a small query in Access, so there won’t be much
difference in the file size if the file is saved without the source data. However, you’ll change the
setting to see the effect:

1. To see the current size of the file, check Windows Explorer. In this example, the file size
is 15KB.

2. Right-click a cell in the pivot table, and click PivotTable Options.

3. On the Data tab, in the PivotTable Data section, remove the check mark from Save
Source Data with File (see Figure 8-16), and then click OK.

Figure 8-16. Save Source Data with File option
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4. Save and close the file, and then to see the size of the file saved without the source
data, check Windows Explorer. In this example, the file size is 13KB, a slight reduction
in size.

With a larger set of records in the source data, the size difference should be more dra-
matic, and if storage space is limited, use this option to reduce the file size.

■Note If you choose to turn off the Save Source Data with File option, you should turn on the Refresh Data
When Opening the File option. Otherwise, you will have to manually refresh the pivot table each time you
open the workbook before you can use it.

Summary
In this chapter, you learned how to maintain a pivot table after you created it to ensure that it
shows the correct data and stores the data in the way that works best for you. Specifically, you
performed the following tasks:

• To ensure that the pivot table shows the latest data, you set the pivot table to refresh
when the file opened.

• To prevent deleted items from accumulating in the pivot table’s filters, you changed a
pivot table option.

• In a pivot table that is based on external data, you set an option to refresh at regular
intervals while working in a file. This ensures that you get updates throughout the day
while data is entered or changed in the source database.

• For a pivot table based on an Excel table, you changed the data source to a different
Excel table. This made it easy to create a new pivot table, with layout and formatting
identical to the original pivot table.

• For a pivot table based on an Access database, you changed the data source to connect
to a different database. This is easier than creating a new pivot table and connecting to
the new database.

• With multiple pivot tables in the workbook, you updated all the pivot tables with one
click of the mouse.

• You changed the pivot table settings so the external source data was not saved with the
file to reduce the size of the file.
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Creating Calculations 
in a Pivot Table

In this chapter, you’ll see how easily you can get a different perspective on the data in your
pivot tables. Instead of viewing total quantity sold or the average order price, you can change a
setting in the pivot table to create any of the following custom calculations:

• Compare sales in one store to another.

• Calculate the difference in sales from one month to the next.

• Create a running total to see how sales accumulate over the year.

• See what percentage of a region’s total sales comes from each product.

• Compare overall sales to each product’s sales per region.

If none of these built-in calculations provides the perspective you need, you can create
your own calculated fields and calculated items in a pivot table. For example:

• Calculate a bonus payment, based on total product sales.

• Total the sales for specific products, creating a temporary category.

• Compare results for one group of stores to another group.

In the first part of this chapter, you’ll explore custom calculations using the food sales
company data. In the second part, you’ll create calculated fields and calculated items. To start,
you’ll open the sample workbook, as described in the following steps:

1. Download and open the sample file RegionSales_02.xlsx, available from the Apress
web site.

2. Activate the Pivot_Regions worksheet, which contains a pivot table based on the 
food sales data (see Figure 9-1). The sales records are on the SalesData worksheet, and
they contain the data from the two regions, East and North, that you worked with in
Chapter 8.
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Figure 9-1. Pivot table based on the food sales data

Currently, the pivot table shows the total sales per region for each food category. In the
next section, you’ll make a simple change to the pivot table to apply a custom calculation, and
you’ll see the same data in a different way. 

Creating Custom Calculations
In a pivot table, it’s easy to get a different perspective on the data by using a custom calcula-
tion. After you create a normal sum or average, you can change a setting, and the pivot table
will compare the values, show the differences between amounts, or calculate the percentage
of a total that a sum contributes. 

In this section of the chapter, you’ll use each of the custom calculations that are available
in a pivot table. The eight types of custom calculation are described here, with an example of
how the calculation could be used:

Difference From: Calculates the difference between values. Compare each product’s sales
to a specific product’s sales or each month’s quantity to the previous month’s.

% Of: Calculates the percentage of one value to another. View one region’s sales as a per-
centage of another region’s sales.

% Difference From: Calculates the percentage difference between values. See the percent-
age change in sales each month compared to the previous month.

Running Total in: Compiles a total over a time period or in a list of items. View the year to
date total for each product or region.

% of row: Calculates the percentage that an item contributes to a row’s total. See each
product’s sales as a percentage of the overall sales in a region.

% of column: Calculates the percentage that an item contributes to a column’s total. See
each region’s sales as a percentage of the overall sales of a product.

% of total: Calculates the percentage that an item contributes to the overall total. See each
region’s sales of a product as a percentage of the overall sales.
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Index: Calculates the weight that an item contributes to the overall total. See each region’s
sales of a product as compared to product sales, region sales, and the overall sales.

In the following examples, you’ll use each of these custom calculations with the food
company sales data to compare results between regions, across a time period, or among 
products.

Using Difference From
The sales manager of the food company wants a report that highlights the differences in sales
between two regions. In which categories is the North region doing better, and how big is the
difference in sales for each category? You’ll use the Difference From custom calculation in 
the pivot table so it shows the difference, instead of the total sales, for each category. 

In the pivot table, Category is in the Row Labels area, Region is in the Column Labels area,
and Sum of TotalPrice is in the Values area.

1. In the pivot table, right-click one of the value cells. For example, right-click cell B6,
which is the total for cookies in the East.

2. In the context menu, click Summarize Data By, and then click More Options (see 
Figure 9-2).

Figure 9-2. More Options command

3. In the Value Field Settings dialog box, click the Show Values As tab.
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4. From the drop-down list for Show Values As, select Difference From (see Figure 9-3).

Figure 9-3. Show Values As Difference From

5. After you select Difference From, the Base Field and Base Item lists are activated. In
this report, you want to compare values between the regions, so select Region as the
base field.

6. After you select Region as the Base field, the region names appear in the Base Item list.
You’ll select North as the base item, and East will be compared to it. For the base item,
select North, and then click OK (see Figure 9-4).

Figure 9-4. Base field and base item selected
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The values in the pivot table change to show the difference in sales between the East and
North regions. In Figure 9-5, the pivot table at the left shows the Difference From custom cal-
culations, and the original calculations (Normal) are in the pivot table at the right.

Figure 9-5. The pivot table at left shows Difference From custom calculation.

The values in the East column now show the difference from the North region for each
category. The North column is empty, because it is the base item, and there is no difference
when compared to itself. From the revised pivot table, the sales manager will quickly see how
sales differ. For example:

• Bar sales in the East are $10,792 higher than bar sales in the North. 

• Snack sales in the East are $119 lower than snack sales in the North. 

• Overall sales in the East are $24,164 higher than sales in the North. 

■Tip You can hide the grand total for rows, because it will be empty when using this custom calculation.

You can add a heading above the pivot table to explain that the pivot table shows the dif-
ferences between regions and send the report to the sales manager.

Using % Of
The sales manager is impressed that you were able to calculate the differences between
regions so quickly and easily and asks for a slightly different report. Instead of showing the
dollars difference between the two regions, could you create a report that compares sales
among the different categories? What percentage are the sales of snacks, compared to the
sales of bars?

To create this report, you’ll use the % Of custom calculation. This will show each category’s
sales as a percentage of another category’s sales. For example, if snack sales are $50, and bar
sales are $100, the snack sales are 50 percent of the bar sales.
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In the pivot table, Category is in the Row Labels area, Region is in the Column Labels area,
and Sum of TotalPrice is in the Values area.

1. In the pivot table, right-click one of the value cells. For example, right-click cell B5,
which is Bars for the East region.

2. In the context menu, click Summarize Data By, and then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select % Of.

5. You want to compare categories, so select Category as the Base field.

6. You’ll compare the other categories to Bars, so select Bars as the base item.

7. It will be easier to compare the percentages with no decimal places, so click Number
Format, and set Decimal places to zero, and then click OK to close the Format Cells
dialog box.

8. Click OK to close the Value Field Settings dialog box.

The values in the pivot table change to show each category’s percentage of the Bars cate-
gory sales. In Figure 9-6, the pivot table at the left shows the % Of custom calculations, and the
original calculations (Normal) are in the pivot table at the right.

Figure 9-6. The pivot table at left shows the % Of custom calculation.

The revised pivot table shows the percentage for each category compared to the Bars cat-
egory. Instead of doing those calculations yourself, the pivot table did them for you, with a few
clicks of the mouse. From the revised pivot table, the sales manager can quickly see how cate-
gory sales differ. For example:

• Cracker sales in the North are 56 percent of bar sales in the North. 

• Snack sales in the East are 19 percent of snack sales in the East. 

• Total cookie sales are 136 percent of total bar sales. 

■Tip Make a copy of the pivot table to display the normal values, and leave it on the worksheet, near the
pivot table with the custom calculations.
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Using % Difference From
Next, the sales manager wants to see whether sales in each region have changed from the
beginning of 2007 to the end of 2007. Were there large fluctuations in the total sales per
month, or were sales steady throughout the year in each region?

To create this report, you can use the % Difference From custom calculation. It’s similar to
the Difference From calculation that you used earlier, but it shows the difference as a percent-
age, instead of an amount. 

To analyze the data by month, you’ll use the OrderDate, Region, and TotalPrice fields in
the pivot table layout. First you’ll change the TotalPrice field back to Normal calculation, so it
will show the dollar amounts when you change the layout:

1. Right-click a value cell in the pivot table, choose Summarize Data By, and then click
More Options. 

2. In the Value Field Settings dialog box, click the Show Values As tab, and from the drop-
down list for Show Values As, select Normal, and then click OK.

3. In the PivotTable Field List pane, remove Category from the Row Labels area. 

4. Add OrderDate to the Row Labels area, leave Region in the Column Labels area, and
leave TotalPrice in the Values area as Sum of TotalPrice.

5. Filter the OrderDate field so it shows dates in 2007 only.

The pivot table now shows the order dates, with the total sales for each region (see 
Figure 9-7).

Figure 9-7. Total sales per date for each region

You want to compare the totals to see how they change from one month to the next, so
you’ll use the % Difference From custom calculation to display the change.
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For this report, you want to compare each month’s total to the total for the previous
month and see the change as a percent difference.

1. In the pivot table, right-click one of the value cells.

2. In the context menu, click Summarize Data By, and then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select % Difference From.

5. In this report, you want to compare the totals between dates, so choose OrderDate as
the Base field.

6. In this report, you want to compare each month’s total to the previous month’s total, so
select (previous) as the base item (see Figure 9-8).

Figure 9-8. OrderDate with (previous) as base item

7. It will be easier to compare the values with no decimal places, so click Number Format,
and set Decimal places to zero, and then click OK to close the Format Cells dialog box.

8. Click OK to close the Value Field Settings dialog box.

The values in the pivot table change to show the difference for each month, from the pre-
vious month (see Figure 9-9).

The revised pivot table shows the percentage change in sales each month, compared to
the previous month. The row for the first date is empty, because there’s no previous date to
which this can be compared. From the revised pivot table, the sales manager can quickly see
how the sales totals changed during 2007. For example:

• June sales in the East were 32 percent lower than May sales. 

• August sales in the North were 40 percent higher than July sales. 

• Total December sales were 41 percent higher than November sales. 
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Figure 9-9. Months compared to previous month totals

Using Running Total In
You’ve sent your report on how the sales totals change from one month to the next, and now
the sales manager wants a report that shows how each region’s sales totals accumulate over
the year. Each month should show the year to date total for each region.

In the pivot table, OrderDate is in the Row Labels area, filtered for 2007 dates; Region is in
the Column Labels area; and Sum of TotalPrice is in the Values area. You’ll keep the current
pivot table layout and change the custom calculation so it creates a running total. 

1. In the pivot table, right-click one of the value cells. 

2. In the context menu, click Summarize Data By, and then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select Running Total In.

5. In this report, you want to create a running total based on the Order dates, so choose
OrderDate as the base field. For a Running Total In custom calculation, no base item is
required.

6. Click Number Format, and format the values as Number, with a thousands separator,
and no decimal places.

7. Click OK to close the Format Cells dialog box, and then click OK to close the Value Field
Settings dialog box.
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The values in the pivot table change to show the running total for each month (see 
Figure 9-10).

Figure 9-10. Running totals for each region

The revised pivot table shows the year-to-date total for each region for each month. In this
report, the sales manager can quickly see how each region was going at any point in the year.

■Tip The running total in custom calculations is best suited for using a date field as the base field,
although you could use another type of field. For example, if recording expenses for different projects,
you could show a running total of expenses over different phases of the project.

Using % of Row
You’ve created two reports from the monthly sales per region pivot table. In the first report,
you showed the percentage change from one month to the next. In the second report, you
showed the running total, per month, over the year. 

Now the sales manager wants a third report, based on the same data. In the new report,
you should show what percentage of each month’s sales came from each region. For example,
if there were $100 sales in the East region in January and $300 in the North region, then East
would be 25 percent of the January sales, and North would be 75 percent. Each month’s totals
are in a row in the pivot table, so you’ll use the % of row custom calculation to create the
report.

In the pivot table, OrderDate is in the Row Labels area, filtered for 2007 dates; Region is in
the Column Labels area; and Sum of TotalPrice is in the Values area. You’ll keep the current
pivot table layout and change the custom calculation so it shows the percent of monthly sales
that each category contributes.

1. In the pivot table, right-click one of the value cells. 

2. In the context menu, click Summarize Data By, and then click More Options.
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3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select % of row.

5. For a % of row custom calculation, no base field or base item is required.

6. Click Number Format, and format the values as Percentage, with no decimal places.

7. Click OK to close the Format Cells dialog box, and then click OK to close the Value Field
Settings dialog box.

The values in the pivot table change to show the percent of the monthly sales that each
category contributes (see Figure 9-11).

Figure 9-11. Region sales per month displayed as % of row

The revised pivot table shows the percentage of the month’s total for each region. In this
report, the sales manager can quickly see that the East region has the stronger sales most
months and that the North region has the weaker sales overall for the entire year.

Using % of Column
Currently the pivot table shows the percent of the row that each region contributes to each
month’s total sales. To complement this report, the sales manager wants you to create another
report that shows what percentage of each region’s sales occurred in each month. 

To create this new report from the same data, you’ll change the custom calculation. The
monthly totals are listed down each region’s column, so you’ll use the % of column custom
calculation:

1. In the pivot table, right-click one of the value cells. 

2. In the context menu, click Summarize Data By, and then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select % of column.
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5. For a % of column custom calculation, no base field or base item is required.

6. Click OK to close the Value Field Settings dialog box.

The values in the pivot table change to show the percent of each region’s total sales for
each order date (see Figure 9-12).

Figure 9-12. Region sales per month displayed as % of column

The Grand Total column shows the overall percent per order date. The Grand Total row
shows 100 percent for each category, because that is the total for each column. 

By using the custom calculation, % of column, you can see which months have the high-
est and lowest sales, for each category, and overall. 

The revised pivot table shows the percentage of the region’s total for each month. In this
report, the sales manager can quickly see that July was the lowest month in the East region
and that the North region had its weakest sales in June.

Using % of Total
You’ve reported on the values as percent of column and percent of row to see how each amount
compares to a total amount. The sales manager has asked for one more perspective on these
percentages and wants to see what percent of the overall total each value contributes. Using the
existing layout, you can create the new report by using the % of total custom calculation:

1. In the pivot table, right-click one of the value cells. 

2. In the context menu, click Summarize Data By, and then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select % of total.

5. For a % of total custom calculation, no Base Field or base item is required.

6. Because the percentages will be small, it will be best to show one decimal place. Click
Number Format, and format the values as Percentage, with one decimal place.
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7. Click OK to close the Format Cells dialog box, and then click OK to close the Value Field
Settings dialog box.

The values in the pivot table change to show the percent of each value of the overall grand
total (see Figure 9-13).

Figure 9-13. Monthly sales per region shown as % of total

From the revised pivot table, the sales manager will quickly see how what percentage of
the overall sales occurred in each region in each month. For example:

• Sales in the East for March were strong, at 5.3 percent of the overall total. 

• Sales in the North for June were weak, at only 3.0 percent of the overall total. 

• March has the highest sales, with combined sales at 10.2 percent of the overall total. 

Using Index
While creating the reports for the sales manager, you noticed that there was also a custom 
calculation named Index. To enhance the overall picture for the sales manager’s reports, you’ll
create one final report on the regions’ sales per month using the Index custom calculation.
The Index compares each value to its row total, its column total, and the overall total, using a
weighted average.

To provide a reference point for the sales manager, you’ll also make a copy of the pivot
table, adjacent to the existing pivot table. In the copy, you’ll show a normal view of the sales
amounts.

1. To copy the existing pivot table, copy columns A to D, then select cell G1, and finally
paste.

2. In the new pivot table, right-click one of the value cells, and in the context menu, click
Summarize Data By. Then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.
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4. From the drop-down list for Show Values As, select Normal.

5. Click Number Format, and format the values as Number, with no decimal places, and a
thousand separator.

6. Click OK to close the Format Cells dialog box, and then click OK to close the Value Field
Settings dialog box.

The new pivot table now shows the total sales per month for each region (see Figure 9-14).

Figure 9-14. Copy of pivot table shows sales amounts.

In the original pivot table, you’ll apply the Index custom calculation to see the indexes
that are calculated for each month and region:

1. In the pivot table that starts in column A, right-click one of the value cells. 

2. In the context menu, click Summarize Data By, and then click More Options.

3. In the Value Field Settings dialog box, click the Show Values As tab.

4. From the drop-down list for Show Values As, select Index. For an Index custom calcula-
tion, no base field or base item is required.

5. Click Number Format, and format the values as Number, with two decimal places.

6. Click OK to close the Format Cells dialog box, and then click OK to close the Value Field
Settings dialog box.

The values in the pivot table change to show each region’s index for each month (see 
Figure 9-15).
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Figure 9-15. Regions’ index per month compared to normal view of total sales

Values that are similar in the total sales pivot table can have much different indexes. For
example, in November, the values for the East and North are almost equal. However, the index
for the North region in November is 1.07, and the East region’s index is 0.94. 

The index formula is as follows:

((value in cell) x (Grand Total of Grand Totals)) /
((Grand Row Total) x (Grand Column Total))

Because the grand total is higher for the East column, the Grand Column Total in the 
formula is larger. The East November amount is divided by this larger number, and its result-
ing index is smaller.

Using the Index custom calculation gives you a picture of each value’s importance in its
row and column context. If all values in the pivot table were equal, each value would have an
index of 1. If an index is less than 1, it’s of less importance in its row and column, and if an
index is greater than 1, it’s of greater importance in its row and column. 

Creating Formulas
In addition to summary functions and custom calculations, you can create calculated fields
and calculated items in a pivot table. These formulas are similar to worksheet calculations but
use the pivot table’s field names or item names, instead of cell references. For example, in a
pivot table, you could do the following:

• You could calculate a discount for stores that order more than 1,000 items this month.

• You could subtract total expenses from total income to calculate a profit for each region.

• You could forecast sales for a new product, based on a percentage of a current product’s
sales.
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A calculated field is used when you want to create a new field in the Values area. With a
calculated field, you can perform calculations on the totals for other fields, such as multiply-
ing another field’s values by a percentage or dividing one field by another. 

With a calculated item, you can perform calculations on the totals for other items in the
same field, such as multiplying another item’s values by a percentage or totaling two of the
other items. 

Creating a Calculated Field
As part of a special promotion, the sales manager has decided to pay a 3 percent bonus to 
the sales staff, based on Bars sales in December 2007. You have been asked to create a report
that shows the total for each store and calculate the 3 percent bonuses. You could summarize
the sales data in a pivot table and calculate the bonuses using worksheet formulas (see 
Figure 9-16).

Figure 9-16. Calculating bonus amounts with worksheet formulas

However, you would prefer to include the bonus calculation within the pivot table, so the
column of bonus formulas will automatically adjust if stores are added or hidden or if other
fields are added to the pivot table layout. 

In the following steps, you will clear the pivot table and add the fields you need in the
report. Then, you will create a calculated field with a simple formula that multiplies the Sum
of TotalPrice field by 3 percent. This will create a new field in the Values area that shows the
bonus amount for each store.

1. Clear the original pivot table, and delete the comparison pivot table you created in 
column G.

2. In the PivotTable Field List pane, add Store to the Row Labels area, and add TotalPrice
to the Values area as Sum of TotalPrice.

3. Add the Category field to the Report Filter area, and select Bars from the Category
drop-down list to limit the pivot table to showing only the sales for that category.

4. Add the OrderDate field to the Report Filter area, below the Category field.
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5. From the OrderDate drop-down list, select 01-Dec-07 to limit the pivot table to show-
ing the sales only for that order date.

The pivot table now shows the total bar sales for each store in December 2007 (see 
Figure 9-17). 

Figure 9-17. Total bar sales per store for selected order date

Now that the pivot table layout is set up for this report, you’ll create a calculated field to
determine the bonus amount for each store:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Field (see Figure 9-18).

Figure 9-18. Calculated Field command on the Ribbon

The Insert Calculated Field dialog box opens, where you’ll enter a name for your calcu-
lated field and create a formula to determine the bonus on each store’s sales. The
Name box contains a default name, Field1, and a default formula, = 0. You’ll replace
these with your field name and formula.
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■Tip When naming a calculated field, you can use up to 255 characters, including letters, numbers, and
punctuation. However, it’s best to use a short, meaningful name so your pivot table is easy to read 
and understand. Since this calculated field is for a sales bonus, you’ll name the field Bonus.

4. In the Name box, type Bonus as the name for the calculated field.

5. On the keyboard, press the Tab key to move to the Formula box and to select its current
contents, and then press the Delete key to remove the existing formula.

6. In the Formula box, type an equal sign to start the formula.

7. In your formula, you want to calculate a bonus amount that is 3 percent of the order
total. The order total is in the TotalPrice field, so you’ll use that in the formula. In the
list of Fields, select TotalPrice, and click Insert Field to add it to the formula.

8. To complete the formula, type * 3% (see Figure 9-19). Space characters are included
here to make the formula easier to read—you can enter the formula with or without
the spaces.

Figure 9-19. Insert Calculated Field dialog box

9. Click OK to close the Insert Calculated Field dialog box.

The new calculated field, Bonus, appears in the PivotTable Field List pane and in the 
Values area of the pivot table (see Figure 9-20). For each store, the bonus amount is 3 percent
of its total sales, and the Grand Total row shows the total bonus amount.
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Figure 9-20. Calculated field added to the pivot table

Editing a Calculated Field
After seeing your report, the sales manager decides that the bonus can be a bit higher and asks
you to change the bonus to 5 percent, instead of 3 percent. You’ll modify the formula, so the
bonus shows the increased amount:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Field.

4. In the Insert Calculated Field dialog box, in the Name box, click the drop-down arrow,
and select Bonus, which is the formula you want to change.

5. In the Formula box, change the 3% to 5%, and then click Modify (see Figure 9-21).

Figure 9-21. Modifying a calculated field

6. Click OK to close the Insert Calculated Field dialog box.
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The revised bonus amounts now appear in the Values area of the pivot table (see Figure 9-22).
For each store, the bonus amount is 5 percent of its total sales, and the Grand Total row shows
the total bonus amount.

Figure 9-22. The modified calculated field

Creating a Complex Calculated Field
The sales manager wants you to calculate an additional bonus for the bar sales. For stores that
ordered more than 1,000 units in December 2007, there will be a special bonus of 4 percent, in
addition to the bonus you previously calculated. If you calculated the additional bonus out-
side of the pivot table, it would use the formula shown in Figure 9-23.

Figure 9-23. Calculating the additional bonus amounts with worksheet formulas

To calculate the additional bonus within the pivot table, you’ll use a similar formula, but
you’ll use the Qty field and the TotalPrice field, instead of cell references. You’ll add the Qty
field to the pivot table layout and then create the new calculated field:

1. Select a cell in the pivot table.
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2. In the PivotTable Field List pane, add a check mark to the Qty field to add it to the 
Values area as Sum of Qty.

The pivot table now shows the total quantity for bar sales for each store in December
2007, and stores 3055 and 3082 have quantities greater than 1,000 (see Figure 9-24). Their sales
will be eligible for the special bonus.

Figure 9-24. Store sales with Bonus and Qty fields

Now that the pivot table layout is set up for this report, you’ll create a new calculated field
to determine the additional bonus amount for each qualified store:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Field.

4. In the Insert Calculated Field dialog box, type Bonus2 as the name for the calculated
field.

5. On the keyboard, press the Tab key to move to the Formula box and to select its current
contents, and then press the Delete key to remove the existing formula.

In your formula, you want to calculate a bonus amount that is 4 percent of the order
total, but only if the total quantity is greater than 1,000. To do this calculation on a
worksheet, you would use an IF function to test the quantity and calculate the bonus if
the quantity passed the test. For example, with a quantity in cell D6 and sales amount
in cell B6, you would use the formula: =IF(D6>1000,B6*4%,0) (see Figure 9-25).

Figure 9-25. Worksheet calculation for special bonus
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This formula tests the quantity, IF(D6>1000, and if that is true, the sales amount is mul-
tiplied by the bonus percentage, B6*4%. If the quantity is not greater than 1,000, the test
result is false, and the formula result is 0.

To replicate this formula in the Calculated Field, you’ll use field names instead of cell
references:

6. In the Formula box, type =IF(.

7. In the list of Fields, select Qty, and click Insert Field to add it to the formula.

8. Next, type >1000 followed by a comma.

9. In the list of Fields, select TotalPrice, and click Insert Field to add it to the formula.

10. To complete the formula, type * 4%,0). The completed formula (see Figure 9-26) is as
follows: 

=IF( Qty>1000, TotalPrice*4%,0) 

Figure 9-26. Insert Calculated Field dialog box

11. Click OK to close the Insert Calculated Field dialog box.

The new calculated field, Bonus2, appears in the PivotTable Field List pane and in the 
Values area of the pivot table. For each store with quantity greater than 1,000, the additional
bonus amount is 4 percent of its total sales, and the other stores show a zero (see Figure 9-27). 

Figure 9-27. Pivot table with two calculated fields
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■Note The grand total row shows a bonus amount that is 4 percent of the total sales, because the total
quantity is greater than 1,000. When you create a calculated field, the grand total performs the same calcu-
lation as the row calculations, instead of summing the rows above. In some cases, such as this, the grand
total may not provide the information that you need, so you can ignore or hide the Grand Total row.

Using Calculated Fields in Formulas
As a final step in the report, you’ll create one more calculated field to add the two bonus
amounts. This will make it easier for the sales manager to see the total bonus for each store. 
In this calculated field, you’ll refer to the other calculated fields that you created:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Field.

4. In the Insert Calculated Field dialog box, type Total Bonus as the name for the calcu-
lated field.

5. In the Formula box, type =.

6. In the list of fields, select Bonus, and click Insert Field to add it to the formula.

7. Next, type a plus sign: +.

8. In the list of Fields, select Bonus2, and click Insert Field to add it to the formula (see
Figure 9-28). The completed formula is as follows: 

=Bonus+Bonus2

Figure 9-28. Using calculated fields in a formula

9. Click OK to close the Insert Calculated Field dialog box.

The new calculated field, Total Bonus, appears in the PivotTable Field List pane and in the
Values area of the pivot table. It totals the values in the Bonus and Bonus2 columns. 

To simplify the report, you can remove the other bonus fields from the pivot table layout
and leave just the Total Bonus field: 

1. Select a cell in the pivot table.
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2. In the PivotTable Field List pane, remove the check marks from the Bonus and Bonus2
fields.

3. Format the Total Bonus values as Number, with two decimal places.

The pivot table now shows just the Total Bonus calculated field, instead of all three. Even
though the Bonus and Bonus2 fields have been removed from the pivot table layout, the Total
Bonus field still calculates the total bonus correctly (see Figure 9-29).

Figure 9-29. Total Bonus Calculated field

Understanding a Calculated Field
It is important to understand that the formulas in a calculated field will always operate on the
sum of the fields, no matter what summary function is currently used for that field in the pivot
table. To verify this, you’ll change the summary function for the Qty field, which is used in the
Bonus2 calculated field.

1. Right-click a value cell in the Qty column.

2. In the context menu, click Summarize Data By, and then click Count.

The values in the Total Bonus column do not change, even though all the values in the Qty
column display a 3, which is less than the 1,000 limit. The result in the Total Bonus calculation
is based on the Sum of Qty for each store, not the displayed Count of Qty.

When creating formulas in a calculated field, you can use some of the worksheet func-
tions, such as IF, AND, OR, but you cannot use functions such as TODAY, NOW, or RAND, where the
results will change. 

Also, you cannot use functions that require a range reference, such as OFFSET or COUNTIF.
Some calculations should be done in the source data, instead of the pivot table, to provide

accurate results. For example, multiply item cost by item quantity in the source data to calcu-
late the total for each record. Then, in the pivot table, sum the total cost field. If you do the
calculation in the pivot table, it would multiply the sum of the item cost by the sum of the
item quantity, and the result may not be what you expect or need.
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Deleting a Calculated Field
If you no longer need a calculated field in a pivot table, you can delete it. Now that your bonus
report is finished, you’ll delete the Total Bonus calculated field:

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Field.

4. In the Insert Calculated Field dialog box, in the Name box, click the drop-down arrow,
and select Total Bonus, which is the calculated field you want to delete.

5. Click the Delete button, and then click OK.

6. The Total Bonus field is removed from the Values area of the pivot table and from the
PivotTable Field List pane.

■Caution You cannot undo the deletion of a calculated field.

Creating a Calculated Item
The sales manager is doing the sales forecasts for the upcoming year and wants a report that
compares the total sales for sweet categories, Bars and Cookies, to salty categories, Snacks and
Crackers, for each store. Because you want to perform a calculation on specific items within a
field, you’ll create a calculated item instead of a calculated field.

In the following steps, you will clear the pivot table and add the fields you need in the
report. Then, you will create two calculated items—one to total the sweet categories and one
to total the salty categories.

■Note Clearing the pivot table with the Clear All command will delete any calculated fields and calculated
items.

1. Remove all the fields from the pivot table.

2. In the PivotTable Field List pane, add the Store field to the Row Labels area, add the
Category field to the Column Labels area, and add TotalPrice to the Values area as Sum
of TotalPrice.

3. Format the values as Number, with zero decimal places, and a thousand separator.
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The pivot table now shows all four categories separately and a grand total for all four (see
Figure 9-30). 

Figure 9-30. Total sales per category per store

You’ll create a calculated item to combine the totals for the sweet items, the Bars and
Cookies items. This will create a new item in the Category field:

1. Select a cell that contains one of the Category headings in the pivot table. For example,
select cell B5, which contains the Bars heading.

■Note You must select a label for the field in which you want to create a calculated item, or the Calculated
Item command will not be available.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Item.

4. In the Insert Calculated Item dialog box, type Sweet as the name for the calculated item.

5. On the keyboard, press the Tab key to move to the Formula box and to select its current
contents, then press the Delete key to remove the existing formula.

6. In the Formula box, type an equal sign to start the formula.

7. In the list of fields, select Category, the field in which you want to create a new item. Do
not click the Insert Field button, because the name of the field is not required in this
formula.

■Note You can refer to the active field only when creating a calculated item.

CHAPTER 9 ■ CREATING CALCULATIONS IN A P IVOT TABLE192

8903Ch09CMP2  8/17/07  12:48 PM  Page 192



8. In the list of Items, select Bars, and click Insert Item to add it to the formula.

9. Type a plus sign, then select Cookies in the Items list, and click Insert Item. The com-
pleted formula is =Bars + Cookies (see Figure 9-31).

Figure 9-31. Insert Calculated Item dialog box

10. Click OK to close the Insert Calculated Item dialog box.

The new calculated item, Sweet, appears in the Column Labels area of the pivot table but
does not appear in the PivotTable Field List pane, because it is an item, not a field. 

■Note When you click a value cell in the pivot table that contains a calculated item, you see the formula in
the formula bar, instead of the number.

Now the grand total is inflated, because Bars and Cookies appear individually and are
totaled in the Sweet category. You’ll hide the individual items so the grand total is correct:

1. In cell B4, click the drop-down arrow for Column Labels.

2. Remove the check marks from Bars and Cookies, and then click OK.
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With the individual items, Bars and Cookies, removed, the grand total is correct (see 
Figure 9-32).

Figure 9-32. Calculated Item in the pivot table

Next, you’ll create a calculated item to combine the totals for the salty items, Snacks and
Crackers. This will create another new item in the Category field:

1. Select a cell that contains one of the Category headings in the pivot table. For example,
select cell B5, which contains the Crackers heading.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Item.

4. In the Insert Calculated Item dialog box, type Salty as the name for the calculated item.

5. In the Formula box, create the formula: =Snacks + Crackers.

■Tip To insert an Item name in the formula, you can type the name or double-click a name in the Items list.

6. Click OK to close the Insert Calculated Item dialog box.

The new calculated item, Salty, appears in the Column Labels area of the pivot table,
but does not appear in the PivotTable Field List pane, because it is an item, not a field. 

Now the grand total is inflated, because Snacks and Crackers appear individually, and
are totaled in the Salty category. You’ll hide the individual items, so the grand total is
correct.
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7. In cell B4, click the drop-down arrow for Column Labels.

8. Remove the check marks from Snacks and Crackers, and then click OK.

With the individual items, Snacks and Crackers, removed, the grand total is correct (see
Figure 9-33).

Figure 9-33. Two calculated items

Editing a Calculated Item
Instead of the previous sales in the Sweet and Salty calculated items, the sales manager wants
to see a projection for 2008 sales, based on 2007 sales. The estimated increase is 5 percent for
Sweet items and 12 percent for Salty items.

To create this report, you’ll add the OrderDate field to the Report Filter area, where you
can filter for 2007 order dates. Then you’ll modify the Calculated Items to show the projected
increases.

1. Select a cell in the pivot table.

2. In the PivotTable Field List pane, add OrderDate to the Report Filter area.

3. In cell B2, click the drop-down arrow for the OrderDate list, and add a check mark to
Select Multiple Items.

4. Remove the check marks from all the order dates in 2006, and then click OK, so only
the 2007 order dates are included in the pivot table summary.
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The OrderDate cell in the Report Filters area now shows (Multiple Items) as the selection
(see Figure 9-34), and only the 2007 sales are included in the totals. Next, you’ll modify the cal-
culated items.

Figure 9-34. Calculated items filtered by order date

5. Select a cell that contains one of the Category headings in the pivot table. For example,
select cell B5, which contains the Sweet heading.

6. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

7. In the Tools group, click Formulas, and then click Calculated Item.

8. In the Insert Calculated Item dialog box, in the Name box, click the drop-down arrow,
and select Sweet, which is the first formula you want to change.

The Sweets are projected to increase by 5 percent, so you’ll modify the formula to cal-
culate the increased amount.

9. In the Formula box, change the formula to =(Bars +Cookies) * 1.05, and then click
Modify (see Figure 9-35).

Figure 9-35. Modifying a calculated item

■Tip Click Modify to change the formula and to leave the dialog box open. Click OK to change the formula
and to close the dialog box.

Next, you’ll modify the formula for the Salty calculated item.
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10. In the Insert Calculated Item dialog box, in the Name box, click the drop-down arrow,
and select Salty, which is the next formula you want to change.

The Salty items are projected to increase by 12 percent, so you’ll modify the formula to
calculate the increased amount.

11. In the Formula box, change the formula to =(Snacks +Crackers) * 1.12, and then click
OK to close the Insert Calculated Field dialog box.

The projected sales amounts now appear in the Values area of the pivot table (see 
Figure 9-36).

Figure 9-36. Pivot table with modified calculated items

Creating a List of Formulas
When you have created calculated fields and calculated items in a pivot table, you may lose
track of what you have created and want a reminder. Or you may want to document the calcu-
lations you have added to help yourself, or other users, understand what the pivot table
contains.

You can use one of Excel’s built-in features to create a list of the calculated fields and cal-
culated items to view or to print. Before you send the report to the sales manager, you’ll create
a list of formulas for future reference.

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click List Formulas.
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A new sheet is inserted in the workbook, with a list of calculated fields and their formulas
and solve order (see Figure 9-37). All the formulas are listed, even if they are not currently in
the pivot table layout.

Figure 9-37. List of formulas in the pivot table

Changing the Solve Order
The solve order is the order in which the items are calculated, if two or more formulas update
a cell. For example, you might have calculated items in Row Labels and other calculated items
in the Column Labels area. In cells where these calculated items intersect, you can control
which calculation occurs last. For most pivot tables, you won’t need to change the solve order,
but it can sometimes be required, as you will see in the report that you are about to create. 

The sales manager has asked for a report to compare the forecasted sales at the older
stores and the newer stores, so you’ll create a calculated item to do that. The older stores are
3000, 3036, 3055, and 3074, and the newer stores area 3082, 3090, and 3166.

1. Select a cell that contains one of the store headings in the pivot table. For example,
select cell A7, which contains the store 3036 heading.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Calculated Item.

4. In the Insert Calculated Item dialog box, type OldVsNew as the name for the calculated
item.

5. In your formula, you want to divide the sum of old stores by the sum of the new stores.
In the Formula box, enter the following formula:

= SUM('3000','3036','3055','3074' )/SUM('3082','3090','3166' )

6. Click OK to close the Insert Calculated Item dialog box.

The new calculated item, OldVsNew, appears in the Row Labels area of the pivot table as
whole numbers (see Figure 9-38). You’ll format the values as percentage to see the results with
more accuracy. 
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Figure 9-38. Calculated item for OldVsNew stores

7. In the pivot table, select cells B13 to D13, which contain the OldVsNew values.

8. On the Ribbon, click the Home tab, and in the Number group, click Percent Style (see
Figure 9-39). This will format the three cells and leave the other values unchanged.

Figure 9-39. Percent Style command on the Ribbon

The Grand Total row is now incorrect, because it includes the OldVsNew values. The 
OldVsNew value in the Grand Total column (351%) is a sum of the Sweet and Salty values,
instead of a calculation of OldVsNew (see Figure 9-40). You’ll hide the Grand Total row and 
column and then create another calculated item to total the Sweet and Salty categories.

Figure 9-40. Incorrect grand totals after adding OldVsNew calculated item

1. To hide both grand totals, select a cell in the pivot table, and on the Ribbon, click the
Design tab. In the Layout group, click Grand Totals, and click Off for Rows and
Columns.
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2. Select a cell that contains one of the Category headings in the pivot table. For example,
select cell B5, which contains the Sweet heading.

3. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

4. In the Tools group, click Formulas, and then click Calculated Item.

5. In the Insert Calculated Item dialog box, type Category Total as the name for the calcu-
lated item.

6. In the Formula box, enter the formula = Sweet + Salty.

7. Click OK to close the Insert Calculated Item dialog box.

The new calculated item, Category Total, appears in the Column Labels area of the pivot
table. It totals Sweet and Salty in each of the rows, which is correct. However, for the last row,
you’d like it to show the OldVsNew calculation, instead of the Category Total calculation. You’ll
change the Solve Order, so it does the OldVsNew calculation last.

1. Select a cell in the pivot table.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the Tools group, click Formulas, and then click Solve Order.

The Solve Order dialog box opens, with the four calculated items listed (see Figure 9-41).

Figure 9-41. Calculated Item Solve Order dialog box

You want the OldVsNew calculation to occur last, so you’ll move it down in the order.

4. Select the OldVsNew item, and click Move Down to change its Solve Order to 4, instead
of 3. Then click Close.
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The Category Total cell in the last row now shows the OldVsNew calculation, instead of
the sum of the Sweet and Salty percentages (see Figure 9-42).

Figure 9-42. Corrected calculation after solve order changed

Summary
In this chapter, you created formulas and calculations to perform analysis beyond the scope 
of the summary functions. You used custom calculations to gain a different perspective on the
totals in the pivot table. With a few clicks of the mouse and no complex formulas, you were
able to see the differences between one item’s totals and all other totals or to compare one
month’s sales to the previous month. You created a running total over a year of orders and cal-
culated the percent that each total was compared to its row, its column, or the grand total.

You also created your own calculated fields and calculated items in a pivot table, specific
to your data and your reporting requirements. With these calculations you can create a unique
and powerful analysis tool from your pivot table.

Finally, you used the list formulas and solve order features to document and manage the
formulas you created.
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Enhancing Pivot Table
Formatting

Pivot tables are excellent tools for summarizing and presenting data, but sometimes the
amount of data they contain is overwhelming. To ensure that the key information is delivered,
you can use special formatting features to highlight the most important numbers or to replace
the numbers altogether.

In this chapter, you’ll use conditional formatting to color cells in a pivot table, and you’ll
add data bars to illustrate the amounts. You’ll also add icons, such as red, yellow, and green
traffic lights to indicate progress or decline or to indicate good or poor results. With condi-
tional formatting, you’ll color only the values that fall within a specific date range or those that
are above or below a certain level.

You’ll add other formatting features to your pivot tables to hide or show field items, empty
cells, or errors in the pivot table. You can also control the appearance of the pivot table by
specifying whether drop-downs, plus signs, and other elements appear.

Applying Conditional Formatting
The safety director wants you to create reports from the company’s safety records. The reports
will be shared with employees in all the company’s locations, and they should present the
results clearly and quickly. Instead of creating pivot tables that contain only numbers and
headings, you’ll use conditional formatting to add visual impact to the data.

Using a Two-Color Scale
Your first report will summarize the safety incidents at each plant location in 2007 and will use
color to highlight the locations with the highest and lowest number of incidents. You’ll open
the file that contains the safety data, create a pivot table, and then add conditional formatting
to the values:

1. Download and open the sample file named SafetyData.xlsx that is available at
www.apress.com.

On Sheet1 is an Excel table that contains safety data, listing the incidents that occurred
at each location (see Figure 10-1) from January 2006 to June 2008. The data shows
when and where the incident occurred, the type and severity of the incident, and the
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effects of the incident. The Excel table is named SafetyData, and you’ll create a pivot
table from this data.

Figure 10-1. Safety data in an Excel table

2. Select a cell in the Excel table named SafetyData on Sheet1.

3. Create a pivot table on a new worksheet.

Your first report will show the number of incidents per plant location for 2007, so you’ll
add those fields to the pivot table and use the Date field to count the records.

4. In the pivot table, add the Plant field to the Row Labels area, add the Year field to the
Report Filter area, and add Date to the Values area as Count of Date.

5. In the report filter for Year, select 2007.

The pivot table shows the number of incidents at each location in 2007 and the grand
total of 201 (see Figure 10-2).

Figure 10-2. Safety incidents per location

To highlight the locations with the highest number of incidents, you’ll add conditional
formatting. A color scale, with two colors, will use one color for the cell with the highest num-
ber and a second color for the cell with the lowest number. Cells with values between the
highest and lowest will be shaded in a graduated color scale.
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1. Select cells B4 to B12, which contain the location totals you want to color.

■Caution Do not include the Grand Total cell, or it will be colored as the highest value.

2. On the Ribbon, click the Home tab.

3. In the Styles group, click Conditional Formatting (see Figure 10-3).

Figure 10-3. Conditional Formatting command on the Ribbon

4. In the list of conditional formatting options, click Color Scales, and in the second row of
Color Scale options, point to the first option, Yellow – Red Color Scale (see Figure 10-4).

Figure 10-4. Yellow – Red Color Scale option for conditional formatting

While pointing to this option, you can see a preview of the formatting on the pivot
table. Cell B4, which contains the lowest value, is red, and cell B8, which contains the
highest value, is yellow. Red is often associated with danger, so you’d prefer that the
highest number be red and the lowest be yellow.

5. In the second row of Color Scale options, point to the second option, Red – Yellow
Color Scale. In the formatting preview on the pivot table, the highest number is now
red, and the lowest is yellow.

6. Click the Red – Yellow Color Scale option to apply the conditional formatting to the
selected cells in the pivot table.

The list of plant locations is now formatted the way you wanted, highlighting the highest
and lowest numbers and shading the values in between, in graduated colors from yellow to
red. When employees at the locations see the report, they’ll quickly recognize which plants
have the best and worst results. You can send this report to the safety director and get ready 
to create the next report.
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Removing Conditional Formatting
After applying conditional formatting, you can remove it if it’s no longer required. Before start-
ing on your next report, you’ll remove the conditional formatting from the pivot table.

1. Select the cells B4 to B12, which contain the cells with conditional formatting.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. Click Clear Rules, and click Clear Rules from Selected Cells (see Figure 10-5).

Figure 10-5. Clear Rules from Selected Cells command

The conditional formatting is removed from the selected cells, and you’re ready to start
the next report.

Applying a Three-Color Scale
Your next report will summarize the safety incidents in each department per shift in 2007 and
will again use color to highlight the locations with the highest and lowest number of incidents.
In this report there will be more values, so you’ll use a different color scale option. To create
the report, you’ll change the fields that are in the Row Labels and Column Labels areas.

1. In the pivot table, remove the Plant field from the Row Labels area, add the Depart-
ment field to the Row Labels area, and add the Shift field to the Column Labels area.

The pivot table shows the number of incidents per department per shift in 2007, and
the grand total remains at 201 (see Figure 10-6).

Figure 10-6. Safety incidents per department per shift
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Again to highlight the locations with the highest number of incidents, you’ll add color
scale conditional formatting. Because this layout has more value cells, you’ll use a three-color
scale. The cells with the lowest, median, and highest values will be a solid color, and cells with
values in between will have a graduated color.

1. Select cells B5 to D13, which contain the values you want to color.

■Caution Do not include the Grand Total row or column, or these values may be colored as the highest
values.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Color Scales, and in the first row of
Color Scale options, point to the second option, Red – Yellow – Green Color Scale. In
the formatting preview on the pivot table, the highest number is now red, the median
cells are yellow, and the lowest value is green.

4. Click the Red – Yellow – Green Color Scale option to apply the conditional formatting
to the selected cells in the pivot table.

■Tip Make all the value columns the same width so they appear to be of equal importance in the report.

In the report on departments by shift, the afternoon shift in the Painting department is
solid red, indicating this is the highest number of incidents. The afternoon shift for Fabrica-
tion stands out as the lowest number, since it’s solid green. Managers and employees in each
department can easily see how their performance compares to other departments. You can
send this report to the safety director for distribution and start on the next report.

Using an Icon Set
Instead of color scales, you can use icon sets to illustrate the data. These small pictures will
use shapes and colors to mark the values. In your next report, you have been asked to show
the change in the number of incidents of each report type from 2006 to 2007. You’ll remove
two of the fields from the pivot table layout and then add the Report Type field:

1. In the pivot table, remove the Departments field from the Row Labels area, and remove
the Shift field from the Column Labels area. Add Report Type to the Row Labels area,
and move the Year field to the Column Labels area.

2. Right-click a cell in the Values area, and click Value Field Settings.

3. On the Show Values As tab, choose % Difference From from the Show Values As drop-
down list.

4. For the Base field, select Year, and for the Base Item, select (previous).
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5. Click Number Format, and format the field as Percentage, with no decimal places.

6. Click OK twice to close the dialog boxes.

7. In the Column Labels drop-down list, remove the check mark from 2008. That year has
data for the first six months only, so you don’t want to compare it to the other years in
this report.

8. Widen column C to about twice its current width, and make column B narrower, since it
doesn’t contain any values. You can also hide the Grand Total for rows, which is empty.

The pivot table shows the percent difference in the number of incidents per report type
from 2006 to 2007 (see Figure 10-7).

Figure 10-7. Percent difference in incidents per report type

To illustrate the changes in the number of incidents per report type, you’ll use an icon set
with colored arrows. This will graphically represent the increases, decreases, and lack of
change:

1. Select cells C5 to C9, where you want to add icons. For this report you have included
the grand total, so its change will also be graphically portrayed.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Icon Sets, and in the first row of Icon
Sets options, point to the first option, 3 Arrows (Colored), as shown in Figure 10-8.

Figure 10-8. 3 Arrows (Colored) Icon Sets option for conditional formatting

While pointing to this option, you can see a preview of the formatting on the pivot table.
Cells C5 and C6, which contain the lowest values, have a red downward-pointing arrow,
and cell C7, which contains the highest value, has a green upward-pointing arrow.
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4. Click the 3 Arrows (Colored) Icon Sets option to apply the conditional formatting to the
selected cells in the pivot table (see Figure 10-9).

Figure 10-9. 3 Arrows (Colored) Icon Sets option applied to the pivot table

From your report’s numbers and icons, employees will see that first aid and lost time inci-
dents have decreased and medical claims have increased. Near-miss incidents had a slight
decrease, and overall, the grand total shows a decrease. You can send this report to the safety
director for distribution and start on the next report.

Using Data Bars
The safety director wants a report that shows the number of days lost per month. In this report,
you’ll have a list of the twelve months and can use conditional formatting to add data bars to the
value cells. This will make it easy to visually compare the list of numbers to see which months
have the highest number of lost days and which have the fewest.

To start, you’ll clear the pivot table to remove the current fields and conditional format-
ting. Then you’ll add the Month field and the Days Lost field, which contains the data on days
lost for each incident.

■Tip You can apply color scales, icon sets, and data bars simultaneously to the cells. However, using more
than one of the conditional formatting options may add confusion to the pivot table, rather than help illus-
trate the data, and using a single type is best in most cases.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Actions group, click Clear, and then click Clear All to remove all the fields and
formatting from the pivot table layout.

3. Add the Month field to the Row Labels area, and add the Days Lost field to the Values
area.

4. Format the Days Lost field as Number, with zero decimal places.
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To show which months have the highest number of days lost, you could sort the days in
descending order. That would move April and June to the top of the list and put May and Sep-
tember at the bottom. However, you want to keep the months in chronological order, so you’ll
add data bars to graphically represent the numbers.

1. Select cells B4 to B15, which contain the value cells you want to format. Don’t include
the Grand Total value, because it is only the individual months you want to compare.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Data Bars, and in the first row of
Data Bar options, point to the first option, Blue Data Bar (see Figure 10-10).

Figure 10-10. Blue Data Bar option for conditional formatting

While pointing to this option, you can see a preview of the formatting on the pivot
table. Cell B5 has the longest data bar, and cell B12 has the shortest. All the data bar
options are identical, except for the color.

4. Click the Blue Data Bar option to apply the conditional formatting to the selected cells
in the pivot table (see Figure 10-11).

Figure 10-11. Blue Data Bar option applied to the pivot table
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When using data bars, it’s important to understand that they aren’t exactly like using a 
bar chart. The data bars are not zero based; the shortest data bar represents the lowest value
in the formatted data, and the longest bar represents the highest value in the formatted data.
If the lowest value is zero and the highest value is 50, the data bars might look the same as the
data bars for data with values that ranged from 500 to 3000 or values from –3000 to –500 (see
Figure 10-12). Even if the lowest value is zero or a negative number, it is represented by a small
data bar. Later in this chapter you’ll learn to change the settings for conditional formatting,
and you will be able to adjust how the bars are configured.

Figure 10-12. Data bars appear the same for widely different values.

If you find it difficult to see where the bars end, because of the graduated coloring in the
data bars, you can apply a dark fill color to the cells. For example, in Figure 10-13 the cells have
been filled with black, and the number is formatted in a bold six-point font size, with white font
color. Column A was made narrower, so the month names are closer to the data bars.

Figure 10-13. Dark fill color in cells with data bars

With the data bars in your report, the safety director can easily compare the number of
lost days in the list of months. You can send this report to the safety director and start on the
next report.
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Formatting Top 10 Items
Pleased with the work you’ve done so far, the safety director asks for a few more reports. For
the next one, the average incident cost should be calculated for each incident type within each
age group. The top three amounts should be highlighted, so the safety director can investigate
these items further.

To start, you’ll clear the pivot table to remove the current fields and conditional format-
ting. Then you’ll add the Age Group field, the Incident Type field, and the Incident Cost field.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Actions group, click Clear, and then click Clear All to remove all the fields and
formatting from the pivot table layout.

3. Add the Incident Type field to the Row Labels area, add the Age Group field to the 
Column Labels area, and add the Incident Cost field to the Values area.

4. Summarize the Incident Cost by Average, and format it as Currency, with zero decimal
places.

5. On the Ribbon, under the PivotTable Tools tab, click the Design tab. In the Layout
group, click Grand Totals, and then click For Columns Only.

To highlight the amounts that are the top three, you’ll use one of the conditional format-
ting options:

1. Select cells B5 to E13, which contain the value cells you want to format.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Top/Bottom Rules, and then click
Top 10 Items (see Figure 10-14).

Figure 10-14. Top 10 Items command in the list of conditional formatting options

The Top 10 Items dialog box opens, with 10 as the setting in the scroll box on the left.
This is similar to the Top 10 feature you used when filtering in the pivot table. The for-
matting option, Light Red Fill with Dark Red Text, is selected in the drop-down list on
the right. The pivot table shows a preview of this formatting, and you’ll change the set-
tings to meet your requirements.
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4. In the scroll box, change the number of items to 3, and then click the arrow to open the
formatting drop-down list (see Figure 10-15).

Figure 10-15. Top 10 Items dialog box

There is a limited selection of formatting options and none you want to use, so you’ll
create a custom format of orange fill and bold, black text.

5. In the formatting list, click Custom Format to open the Format Cells dialog box.

6. On the Font tab, select the Bold font style, and select Black from the Color drop-down list.

■Note Some formatting options, such as font size or thick borders, are not available, because conditional
formatting doesn’t allow settings that could affect the cell size.

7. On the Fill tab, select Orange as the fill color, and then click OK to close the Format
Cells dialog box.

8. Click OK to close the Top 10 Items dialog box.

9. The colors don’t display correctly while the cells are selected, so select a cell that is 
not one of the formatted top three to see the effects of the conditional formatting (see
Figure 10-16).

Figure 10-16. Top three items highlighted
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■Note In the case of a tie, more than the specified number of cells can be formatted.

With the Top 10 Items formatting in your report, the safety director can easily identify 
the items for further investigation. You can send this report to the safety director and start 
on the next report.

Formatting Cells Between Two Values
The safety director found the Top 10 Items report to be helpful and asks whether you can high-
light a few more amounts in that report. Any amount that is between 1,500 and 2,000 should
be blue to stand out from the other amounts.

You won’t make any changes to the pivot table layout but will add another conditional
formatting option to the value cells. To make this formatting more flexible, you’ll type the min-
imum and maximum amounts on the worksheet and refer to those cells in the conditional
formatting.

1. In cell G1 on the worksheet, type 1500, which is the minimum amount for the condi-
tional formatting.

2. In cell H1 on the worksheet, type 2000, which is the maximum amount for the condi-
tional formatting.

3. Select cells B5 to E13, which contain the value cells you want to format.

4. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

5. In the list of conditional formatting options, click Highlight Cells Rules, and then click
Between (see Figure 10-17).

Figure 10-17. Highlight Cells Rules command in the conditional formatting options

The Between dialog box opens, with default values in the minimum and maximum
boxes. The default formatting option, Light Red Fill with Dark Red Text, is selected in
the drop-down list on the right. The pivot table shows a preview of this formatting, and
you’ll change the settings to meet your requirements.
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6. Delete the default value in the minimum box, and click cell G1, which contains the
minimum value you typed on the worksheet. Delete the default value in the maximum
box, and click cell H1, which contains the minimum value you typed on the worksheet
(see Figure 10-18).

Figure 10-18. Refer to worksheet cells in the Between dialog box.

7. In the formatting list, click Custom Format to open the Format Cells dialog box.

■Note In some drop-down lists, such as the formatting list in the Between dialog box, the drop-down list
closes automatically when you release the mouse button or when you point with your cursor outside the list.
To select an item in this type of list, point to the item, and then release the mouse button. In other lists you
may have to click an item to select it and to close the list.

8. On the Fill tab, select blue as the fill color, and then click OK to close the Format Cells
dialog box.

9. Click OK to close the Between dialog box.

10. The top three cells are still highlighted with orange fill and bold text, and cells with a
value between 1,500 and 2,000 are now blue (see Figure 10-19).

Figure 10-19. Two conditional formatting options applied

11. To test the maximum limit, in cell H1 type 1800 as the new limit.
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When you press the Enter key to complete the change, the conditional formatting in the
pivot table changes to match the new limit.

The safety director will now be able to highlight any range of values simply by changing
the amounts in cells G1 and H1. You can send this report to the safety director and start on the
next report.

Formatting Labels in a Date Period
The safety director wants some statistics for an education program on preventing injuries, and
she has asked whether you can create a report that shows the number of slip/trip injuries dur-
ing each shift for the current quarter. If possible, any incidents from the current month should
be highlighted.

To start, you’ll clear the pivot table to remove the current fields and conditional format-
ting. Then you’ll add the Date field, the Incident Type field, and a field to use for counting the
incidents.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Actions group, click Clear, and then click Clear All to remove all the fields and
formatting from the pivot table layout.

3. Clear cells G1 and H1, which won’t be needed for this report.

4. You want to limit the data that’s shown in the pivot table, so add the Incident Type field
to the Report Filter area, and select Slip/Trip from the Incident Type drop-down list.

5. Add the Date field to the Row Labels area, add the Shift field to the Column Labels
area, and add the Report Type field to the Values area, where it will become Count of
Report Type.

6. The report should show the incidents from the current quarter, so click the Row Labels
arrow, then click Date Filters, and finally click This Quarter.

The results you see will depend on the date you create the report. In this example, the
report was created in June 2008 (see Figure 10-20).

Figure 10-20. Report labels filtered for last quarter
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1. In this report, you have been asked to highlight the dates from the current month, so
select cells A5 to A11, which contain the date labels you want to format.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Highlight Cells Rules, and then click
A Date Occurring (see Figure 10-21).

Figure 10-21. A Date Occurring option in conditional formatting options

The A Date Occurring dialog box opens, with Yesterday as the setting in the drop-down
list at the left. The formatting option, Light Red Fill with Dark Red Text, is selected in
the drop-down list at the right. You’ll change the settings to meet your requirements.

4. In the date range drop-down list, select This Month Figure 10-22).

Figure 10-22. A Date Occurring dialog box

5. Leave the formatting option as the default fill and text, and click OK to close the A Date
Occurring dialog box.
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The dates from the current month are highlighted and will stand out in the report that
you send to the safety director (see Figure 10-23). Because both the date filter (This Quarter)
and conditional formatting (This Month) are dynamic, the visible results and highlighting
may change the next time the pivot table is refreshed.

Figure 10-23. Dates from last month are highlighted.

You can send this report to the safety director and start on the next report.

Editing a Rule for Data Bars
The Texas plant has the highest number of days lost, and the safety director wants a report
that shows the number of days lost, based on the weekday on which the incident occurred,
using data bars instead of numbers. To create an accurate set of data bars, without numbers,
you’ll use one of the existing Data Bars options and then edit it.

To start, you’ll clear the pivot table to remove the current fields and conditional format-
ting. Then you’ll add the WkDay field, which stores the name of the weekday, the Plant field,
and the Days Lost field.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Actions group, click Clear, and then click Clear All to remove all the fields and
formatting from the pivot table layout.

3. Add the WkDay field to the Row Labels area, and add the Days Lost field to the Values
area. The WkDay field will be sorted by weekday, starting with Sunday or Monday.

4. Add the Plant field to the Report Filter area, and filter for Texas, so only the days lost at
that plant are showing.
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The pivot table shows the days lost for each weekday for the Texas plant. The days range
from 4.5 for Sunday, Tuesday, and Thursday to 14.5 for Monday. You’ll apply one of the condi-
tional formatting Data Bars options and then modify it to remove the numbers from the cells.

1. Select cells B4 to B10, which contain the value cells you want to format.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. Click Data Bars, and click Orange Data Bar.

The data bars appear in the cells, with the shortest bars in the three days with 4.5 days lost
and the longest bar in Monday (see Figure 10-24). Currently, the bars are distorting the data,
because the shortest bar represents the lowest value. Although the lowest number, 4.5, is
approximately one half of 9.5, its bar appears to be about one quarter the length of the 9.5 bar.

Figure 10-24. Data bars and numbers

Because you will be removing the numbers, it will be important that the data bars reflect
the number of days lost as accurately as possible. You’ll modify the conditional formatting to
remove the numbers and to fix the scale of the data bars.

1. Select cells B4 to B10, which contain the formatted value cells.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Format-
ting. Then click Manage Rules (see Figure 10-25).

Figure 10-25. Manage Rules option
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The Conditional Formatting Rules Manager dialog box opens, where you can see the 
Data Bar rule you created when you applied conditional formatting to the Days Lost cells 
(see Figure 10-26). You’ll select that rule and then edit it.

Figure 10-26. Conditional Formatting Rules Manager dialog box

1. In the list of rules, click your Data Bar rule.

2. Click the Edit Rule button to open the Edit Formatting Rule dialog box (see Figure 10-27).

Figure 10-27. Edit Formatting Rule dialog box

The top section of the Edit Formatting Rule dialog box shows where the rule is applied.
The second section shows the type of rule that has been applied. In the third section, Edit the
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Rule Description, you can see the current settings for the Data Bar rule, and this is where
you’ll edit the rule. No changes will be required in the first or second section.

1. You want to remove the numbers from the cells, so in the third section, add a check
mark to Show Bar Only.

Currently, the shortest bar represents the lowest value in the range of cells, and this
affects the scale of the data bars and exaggerates the differences between numbers.
You want to ensure that the amounts are accurately represented in the data bars, so
you’ll change the settings for Shortest Bar. Instead of using the lowest value in the
range of cells, you’ll use zero as the setting for Shortest Bar.

2. Click the arrow for the Type drop-down list under Shortest Bar (see Figure 10-28).

Figure 10-28. Type options for Shortest Bar

3. Click Number, and a zero automatically appears in the Value box for Shortest Bar. This
is the setting you want, so leave Value as zero.

4. Click OK to close the Edit Formatting Rule dialog box, and click OK to close the Condi-
tional Formatting Rules Manager dialog box.

The numbers have been removed from the cells, and the data bars use a scale from zero to
the highest number to show a more accurate representation of the numbers. In Figure 10-29 the
revised data bars are on the right, and the original data bars are on the left. Fill color was added
to make the end of the data bars stand out more clearly.

Figure 10-29. Original data bars (left) compared to revised data bars (right)
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With the data bars revised to more accurately show the lost days per weekday, you can
send this report to the safety director and start on the next report.

Changing the Order of Rules
The next report that the safety director needs is a summary of incident costs per year for each
injury location, such as head or back. The top three costs should be highlighted, and any cost
that is above average should also be highlighted using a different color.

To start, you’ll clear the pivot table to remove the current fields and conditional format-
ting. Then you’ll add the Injury Location field, the Year field, and the Incident field.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Actions group, click Clear, and then click Clear All to remove all the fields and
formatting from the pivot table layout.

3. Add the Injury Location field to the Row Labels area, add Year to the Column Labels
area, and add the Incident Cost field to the Values area. Format the values as Currency
with zero decimal places.

4. Because 2008 is not completed, its values will skew the average, so you’ll remove it
from the pivot table layout. Click the drop-down arrow for the Column Labels, and
remove the check mark for 2008.

First you’ll apply conditional formatting to add red fill color to the top three costs:

1. Select cells B5 to C16, which contain the value cells you want to format.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Top/Bottom Rules, and then click
Top 10 Items.

4. In the scroll box, change the number of items to 3, and then click the arrow to open the
formatting drop-down list.

5. In the formatting list, click Custom Format to open the Format Cells dialog box.

6. On the Fill tab, select a shade of red as the fill color, and then click OK to close the For-
mat Cells dialog box.

7. Click OK to close the Top 10 Items dialog box.

The top three costs are highlighted with red fill (see Figure 10-30). Next, you’ll apply con-
ditional formatting so the cells with above average costs are highlighted with yellow fill color.
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Figure 10-30. The top three items are highlighted with conditional formatting.

1. Select cells B5 to C16, which contain the value cells you want to format.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Formatting.

3. In the list of conditional formatting options, click Top/Bottom Rules, and then click
Above Average.

4. In the formatting list, click Custom Format to open the Format Cells dialog box.

5. On the Fill tab, select yellow as the fill color, and then click OK to close the Format Cells
dialog box.

6. Click OK to close the Above Average dialog box.

The cells with above average costs are highlighted with yellow fill, but the red fill has been
replaced with yellow in the top three cells (see Figure 10-31).

Figure 10-31. Above average cells are highlighted with conditional formatting.
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You want to keep the red highlighting for the top three cells, so you’ll change the order in
which the conditional formatting is applied. If the above average cells are formatted first, then
the top three, the red ones, will be visible. To change the order, you’ll open the Conditional
Formatting Rules Manager dialog box:

1. Select cells B5 to C16, which contain the formatted value cells.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Format-
ting, and then click Manage Rules.

The Conditional Formatting Rules Manager dialog box opens, where you can see the 
two rules you created when you applied conditional formatting to the pivot table cells (see
Figure 10-32). To the right of the Delete Rule button are the Move Up and Move Down buttons.

Figure 10-32. Two rules in the Conditional Formatting Rules Manager dialog box

The higher items in the list have precedence over the lower items, and if there is a format-
ting conflict between rules, the rule with precedence is used. You created the Top 3 rule first,
so it is at the bottom of the list. When you created the Above Average rule, it was added to the
top of the list, taking precedence over the Top 3 rule. Because the Top 3 cells are also above
average, they are affected by both rules, and the formatting for the Above Average rule, which
has precedence, is applied last, so the cells are colored yellow.

You’ll change the order of the rules so the Top 3 rule has precedence and the red fill color
is applied to the Top 3 cells:

1. In the list of rules, click the Top 3 rule.

2. To the right of the Delete Rule button, click the Move Up button to move the Top 3 rule
above the Above Average rule.

3. Click OK to close the Conditional Formatting Rules Manager dialog box.

Because you changed the order of the rules, the Top 3 rule now has precedence, and the
top three cells are red.
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Changing the Pivot Table Layout
Just when you are ready to send the report, the safety director calls to ask whether you can
change the report so it shows the injury location per age group per year. You’ll add the Age
Group field to the report and see whether the conditional formatting needs any changes.

1. Add the Age Group field to the Row Labels area, above the Injury Location field.

The incident costs change, because they are now broken down by age group. However, the
conditional formatting is still applied correctly. The top three amounts are highlighted in
red, and all the amounts above average are highlighted in yellow (see Figure 10-33).

Figure 10-33. The conditional formatting adjusts to revised layout.

You’re not sure whether the safety director will like the long, narrow report, so you
decide to try a different layout.

2. Move the Age Group field to the Column Labels area, below the Year field.

The conditional formatting is now applied to the Year subtotals, and because they are
included, the above average cells include all the subtotals and only a few of the other cells (see
Figure 10-34).

Figure 10-34. The conditional formatting does not adjust correctly.
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Instead of having conditional formatting on the entire block of cells, you want the subtotals
to be excluded and only the individual values to be formatted. You’ll edit the rules to ensure that
the subtotals are ignored:

1. Select one of value cells in the pivot table. For example, select cell C8, which is the
value for Back in 2006 for the 25–34 age group.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Format-
ting. Then click Manage Rules.

The Conditional Formatting Rules Manager dialog box opens, where you can see the
two rules that exist for this pivot table. For each rule, the conditional formatting is
applied to cells $B$6:$K$17. You’ll change this setting in each of the rules, starting with
the Above Average rule.

3. In the list of rules, click the Above Average rule.

4. Click the Edit Rule button to open the Edit Formatting Rule dialog box.

In the Apply Rule To section at the top, there are three options, and the Selected Cells
option is currently selected. The range of cells, $B$6:$K$17, is shown (see Figure 10-35).

Figure 10-35. Apply Rule To options in the Edit Formatting Rule dialog box

The Selected cells option works in many cases, but when you rearrange the pivot table,
the conditional formatting may not adjust correctly. In your pivot table, the subtotals
are being formatted because they are within the range of cells to which the rule is
applied.

The second option, All Cells Showing “Sum of Incident Cost” Values, would also
include too many cells. It would not only include the year subtotals but also the grand
totals, because they are also Sum of Incident Cost values.

The third option, All Cells Showing “Sum of Incident Cost” Values for “Injury Location”
and “Age Group,” will be the best option for this pivot table. It will restrict the format-
ting to cells where the Age Group and Injury Location values appear and will exclude
the year subtotals and the grand totals.

5. Select the third option, All Cells Showing “Sum of Incident Cost” Values for “Injury
Location” and “Age Group.”

6. Click OK to close the Edit Formatting Rule dialog box.
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In the Conditional Formatting Rules Manager dialog box, the Above Average rule
shows the revised option in the Applies To column. Next, you’ll make the same change
to the Top 3 rule:

7. In the list of rules, click the Top 3 rule.

8. Click the Edit Rule button to open the Edit Formatting Rule dialog box.

9. In the Apply Rule to section, select the third option, All Cells Showing “Sum of Incident
Cost” Values for “Injury Location” and “Age Group.”

10. Click OK to close the Edit Formatting Rule dialog box, and click OK to close the Condi-
tional Formatting Rules Manager dialog box.

The conditional formatting is now applied correctly to the individual value cells. The 
year subtotals and the grand totals are not formatted, and their values are not included in the
average calculation. You can send the completed report to the safety director and go for a well-
earned lunch break.

Deleting a Rule
When you return to your desk, there’s a message from the safety director, who likes the report
but thinks it would look better without the Above Average highlighting. You’ll delete that rule
so only the Top 3 rule will be applied in the pivot table:

1. Select a cell in the pivot table.

2. On the Ribbon, click the Home tab, and in the Styles group, click Conditional Format-
ting. Then click Manage Rules.

3. In the list of rules, click the Above Average rule.

4. Click the Delete Rule button (see Figure 10-36).

Figure 10-36. Delete a conditional formatting rule.

5. Click OK to close the Conditional Formatting Rules Manager dialog box.

The Above Average conditional formatting is removed from the pivot table, and only the
Top 3 rule formatting remains. You can send the revised report to the safety director and start
on the next report on your list.
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Setting Format Options
The safety director wants one more report before you leave for the day. Safety meetings will be
held in the Illinois and Ohio plants next week, and the safety director wants to take a report
that shows the number of Lost Time incidents per month at these locations and the cost of 
the incidents per year. The pivot table doesn’t need any conditional formatting but should be
clearly organized and labeled.

You’ll clear the existing pivot table and then add the fields you need for the new report. 
In addition to the standard formatting you have used in other pivot tables, you’ll change the
pivot table options and some field settings to create an attractive pivot table for distribution at
the meetings.

To start, you’ll clear the pivot table to remove the current fields and conditional formatting.
Then you’ll add the fields you need for the new report.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Actions group, click Clear, and then click Clear All to remove all the fields and
formatting from the pivot table layout.

3. Add the Plant field to the Row Labels area, and select only Illinois and Ohio from the
Row Labels filter list.

4. Add the Year field to the Column Labels area, and add the Month field to the Row
Labels area below the Plant field.

5. Add the Report Type field to the Report Filter area, and select Lost Time from the drop-
down list.

6. Add the Incident Cost field to the Values area, and add the Date field to the Values area
as Count of Date.

7. Format the Incident Cost field as Currency, with zero decimal places.

The pivot table data is all in place, and the numbers are formatted correctly, but a few
things need improvement (see Figure 10-37). Some of the months are missing for each plant,
because no lost time incidents occurred in those months. The pivot table is too wide, because
the column headings for the value fields are too long. You also want to clean the pivot table up
by hiding some of the features that won’t be needed during the meeting, such as the drop-
down arrows.

First you’ll change the column headings to make them shorter:

1. Click cell B5, which contains the heading Sum of Incident Cost.

2. Type Cost, and then press the Enter key to complete the change.

3. Click cell C5, which contains the heading Count of Date.

4. Type Incidents, and then press the Enter key to complete the change.
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Figure 10-37. The pivot table needs formatting improvements.

Controlling Column Width
All the column headings have changed, and already the pivot table is easier to read and under-
stand. However, when you changed the headings, the columns did not automatically adjust to
fit the narrower headings. You’ll refresh the pivot table to autofit the columns.

1. Right-click a cell in the pivot table, and in the context menu, click Refresh.

The pivot table was refreshed, and the columns have adjusted to fit the narrower head-
ings. As you work on this pivot table, you might make adjustments to the columns
widths, and you want to prevent further automatic adjustments if the pivot table is
refreshed again. You’ll change one of the pivot table options to prevent automatic
changes to the column widths.

2. Right-click a cell in the pivot table, and in the context menu, click PivotTable Options.

3. In the PivotTable Options dialog box, on the Layout & Format tab, remove the check
mark from Autofit Column Widths on Update (see Figure 10-38).

Figure 10-38. Autofit Column Widths on Update option

4. Click OK to close the PivotTable Options dialog box.

Now, if you manually adjust the column width and then refresh the pivot table, the col-
umn width won’t change.
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Showing Items with No Data
Next, you’ll change a setting for the Month field to ensure that all the months are showing for
each plant, even if there were no incidents in that month.

1. Right-click a Month label in the pivot table. For example, right-click cell A8, which con-
tains the Apr label for Illinois.

2. In the context menu, click Field Settings.

3. In the Field Settings dialog box, on the Layout & Print tab, add a check mark to Show
Items with No Data (see Figure 10-39).

Figure 10-39. Show Items with No Data option

4. Click OK to close the Field Settings dialog box.

All the months are now listed for each plant, even where there were no incidents in any of
the years for that month. This makes it easier to compare the data, since the list of months is
consistent between plants.

Hiding Buttons and Labels
As a final step in cleaning up the pivot table, you’ll hide the buttons and labels that aren’t
needed during the meeting. You have applied filters to the Row Labels, and you’ll hide that
button to prevent any changes during the meeting. You’ll also hide the buttons to the left of
the Plant labels and you’ll remove the Row Labels and Column Labels captions in cells A5 
and B3.

1. Right-click a cell in the pivot table, and in the context menu, click PivotTable Options.

2. On the Display tab, remove the check mark from Show Expand/Collapse Buttons. This
will hide the buttons to the left of the plant names.

3. Also remove the check mark from Display Field Captions and Filter Drop Downs (see
Figure 10-40). This will hide the filter buttons and the Row Labels and Column Labels
captions.
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Figure 10-40. Display options

4. Click OK to close the PivotTable Options dialog box.

The buttons and labels have been removed from the pivot table, giving it a cleaner look.
You can make minor adjustments to the column widths so the numbers are well spaced.
Because the numbers are right-aligned, you can right-align the column headings, so it’s clear
which heading is associated with which column of numbers (see Figure 10-41).

The revised pivot table is much improved over the initial version, and you can proudly
send it to the safety director for use at the safety meetings in Illinois and Ohio.

Figure 10-41. Formatted pivot table
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Summary
In this chapter, you used conditional formatting to highlight the best and worst results in your
safety data. There are many built-in conditional formatting options, and you applied the fol-
lowing types:

• Color Scale

• Icon Set

• Data Bars

• Top 10 Items

• Above Average

• Date Range

In addition to the built-in conditional formatting options, you created custom formats to
apply the fill color, font, and other formatting you preferred. You also edited the formatting
rules and the order of the rules, so the conditional formatting would work correctly on your
pivot table data.

To create a cleaner looking pivot table, you changed the pivot table options to hide but-
tons and labels when appropriate and to control column width. You also changed the field
settings to show items that have no data, such as sales reports where some months have no
activity to report.

By using enhanced formatting, you help ensure that your pivot tables are easy to read and
understand and that the important information is highlighted in your reports.
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Creating a Pivot Chart

In this chapter, you’ll create pivot charts using the food sales data you worked with in Chap-
ters 8 and 9. A pivot chart paints a picture of the data in a pivot table and can make the data
easier to understand. Instead of a table full of numbers, a pivot chart can use columns, bars, or
pie slices to illustrate the numbers, and a pivot chart lets you easily compare results between
years, regions, or products. Or, a pivot chart can use lines to show how results change over
time (see Figure 11-1).

Figure 11-1. Pivot chart comparing 2006 vs. 2007 sales

To start, you’ll create a simple column chart with the default chart settings. You’ll modify
that chart’s layout, change its appearance, and move the pivot fields to produce a custom-
tailored chart that presents your data effectively. Then, you’ll create a line chart from the pivot
table data to compare sales over two years. You’ll add labels, titles, and trend lines to the chart
to ensure that your chart is easy to understand.

Finally, you’ll see how easy it is to use the pivot chart filters to instantly create a chart that
shows results for a different product or region. With one click of the mouse, your chart can
focus on cookie sales instead of snacks or on the east instead of the north. What might take
hours to achieve with regular charts will take seconds to create with a pivot chart.

Creating a Default Pivot Chart
The sales manager at your food sales company is preparing for a regional sales meeting and
wants a chart that compares each region’s sales for each product type. You’ll create a pivot
chart with the default settings, and then you’ll modify the chart to improve its appearance.

233

C H A P T E R  1 1

8903Ch11CMP3  8/20/07  8:07 PM  Page 233



To start, you’ll open the sample food sales workbook and prepare the pivot table:

1. Download and open the sample file RegionSales_03.xlsx, available from the Apress
web site.

2. Activate the Pivot_Regions worksheet, which contains an empty pivot table.

The pivot table is based on sales data for the East and North regions for 2006 and 2007.
The chart should compare sales in the two regions for all the product types, so you’ll add the
Region, ProdType, and TotalPrice fields to the pivot table layout and then create a pivot chart
from the pivot table.

At this point, you aren’t sure how the fields should be arranged for the pivot chart, so
you’ll add the fields where they’d make sense in a pivot table report. After you create the pivot
chart, you can change the layout, if required.

1. Select a cell in the empty pivot table, and in the PivotTable Field List pane, add the
Region field to the Row Labels area, add the ProdType field to the Column Labels area,
and add the TotalPrice field to the Values area.

This creates a concise summary of the data, and you can compare the sales between
regions for each product type.

2. To create a pivot chart, select a cell in the pivot table, and on the keyboard, press the
F11 key.

3. A chart sheet, Chart1, is inserted in the workbook, with a pivot chart based on the 
current pivot table (see Figure 11-2).

Figure 11-2. A default pivot chart
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Exploring the Pivot Chart
The chart that was created is the default chart type, a clustered column chart. In the PivotTable
Field List pane, the Row Labels area has changed to the Axis Fields (Categories) area, and the
Column Labels area is now called the Legend Fields (Series) area (see Figure 11-3).

Figure 11-3. The area names have changed in the PivotTable Field List pane.

The region names are shown on the category axis, which is the horizontal axis across the
bottom of the chart. Above each region name on the axis is a cluster of colored columns.

The product types from the ProdType field are shown in the legend at the right of the
chart. The ProdType items are series in the chart, and there is a column that represents the
total sales for each product type in each region. The colored square beside the ProdType name
in the legend indicates which color its columns are. For example, the two blue columns repre-
sent the bar sales, one for the East region and one for the North region.

1. Point to one of the blue columns, and a tool tip will appear to show the name of the
series (Bars), the region, and the value that column represents (see Figure 11-4).

Figure 11-4. A tool tip shows information about the column.

■Tip You can point to any element in the active chart and see its name in a tool tip, if tool tips are enabled.

8903Ch11CMP3  8/20/07  8:07 PM  Page 235



The red column in the East region is the tallest column in the chart. The legend shows
that red columns represent sales of cookies, so cookies in the East region are the best-
selling product type per region. Snacks in the East and North regions have the smallest
columns, indicating that sales of snacks are the lowest, and they look very close in sales
for the two regions.

2. Point to each of the purple Snacks columns to see the value each column represents
and to determine whether the values are the same. The value for the North region is
slightly higher than the value for the East region.

Using the PivotChart Filter Pane
In addition to the PivotTable Field List pane, when the pivot chart is active, a PivotChart Filter
Pane becomes available (see Figure 11-5). This lets you sort and filter the fields, just as you can
in a pivot table, and you can use the row labels, column labels, and report filters.

Figure 11-5. The PivotChart Filter Pane

You’ll use the PivotChart Filter Pane to temporarily filter the product types to show only
the snacks. This will remove the product types with more sales and will let you focus on snacks
and see the small difference between the values those columns represent.

1. In the PivotChart Filter Pane, click the drop-down arrow for ProdType in the Legend
Fields list.

2. In the Filter list, remove the check marks from Bars, Cookies, and Crackers, and then
click OK.

The color for the Snacks column changes to blue, because that is the color used for the
first column in the chart. The scale in the vertical axis at the left changes and shows a much
smaller range of numbers. Previously, it went from 0 to 180000, and it now goes from 21500 to
21720. This magnifies the difference between the two columns, and you can clearly see that
the North region had more sales (see Figure 11-6).
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Figure 11-6. Pivot chart filtered to show only snacks

Now that you’ve focused on the snacks sales, you’ll remove the filter from the pivot chart
so it shows all the product types:

1. In the PivotChart Filter Pane, click the drop-down arrow for ProdType in the Legend
Fields list.

2. In the Filter list, click Clear Filter from “ProdType.”

All the product types are visible again, and the vertical axis scale starts at zero and goes to
180000.

On the PivotChart Filter Pane is a Field List button that lets you show or hide the PivotTable
Field List pane. You’ll hide the PivotTable Field List pane temporarily to see how the pivot chart
looks when it’s hidden:

1. Click the Field List button (see Figure 11-7) at the top right of the PivotChart Filter
Pane to hide the PivotTable Field List pane.

Figure 11-7. Field List button on the PivotChart Filter Pane

This creates more room on the screen for the pivot chart, so you may want to hide the
PivotTable Field List pane after you have finished the pivot chart layout and are for-
matting the pivot chart. For now, you’ll turn the PivotTable Field List pane back on.

2. Click the Field List button at the top right of the PivotChart Filter Pane to show the 
PivotTable Field List pane.
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Moving Fields in the Pivot Chart
Currently, the chart shows all the product types for the East region in one column cluster at
the left of the chart. At the right of the chart is another column cluster that shows all the prod-
uct types for the North region. This is an ideal arrangement for comparing the product type
sales within each region.

To make it easier for the sales manager to compare the results for each product type
between regions, you want the related product type columns displayed side by side. Instead of
a cluster for each region, you want a cluster for each product type (see Figure 11-8).

Figure 11-8. Cluster columns by region or by product type

Just as you can move fields in a pivot table, you can also move fields in a pivot chart. You’ll
change the position of the ProdType and Regions fields to create the layout you want for the
chart:

1. At the bottom left of the PivotTable Field List pane, add a check mark to Defer Layout
Update. This will allow you to make changes to the field layout, without immediately
changing the pivot chart.

■Note If the PivotTable Field List pane is not visible, you may have clicked outside the pivot chart. Click in
the pivot chart to activate it, and the PivotTable Field List pane should become visible. If it is still not visible,
click the Field List button at the top right of the PivotChart Filter Pane.

2. In the PivotTable Field List pane, move the ProdType field from the Legend Fields
(Series) area to the Axis Fields (Categories) area.

3. Move the Region field from the Axis Fields (Categories) area to the Legend Fields
(Series) area.

4. In the PivotTable Field List pane, click the Update button to update the pivot chart.

5. In the PivotTable Field List pane, remove the check mark from Defer Layout Update.

The pivot chart now shows the product type names along the category axis and the region
names in the legend. The East region’s sales are represented by blue columns, and the North
region’s sales are represented by red columns. It’s easier to compare the product type sales
between regions when the columns are side by side (see Figure 11-9).
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Figure 11-9. The product type names on the category axis

With the columns clustered by product type, it’s easy to see that sales of bars and cookies
are greater in the East, cracker sales are higher in the North, and snack sales are almost equal
in the two regions.

Changing the Pivot Chart Layout
Before you send the pivot chart to the sales manager, you want to make it a bit more visually
appealing. A title could explain the chart contents, and the legend might be easier to read in a
different position in the chart.

When you create a pivot chart, a chart layout is automatically applied. The current layout
has the legend at the right, grid lines running horizontally across the chart, and no chart title.
You’ll select a different layout to quickly give the chart a different appearance.

On the Ribbon, under PivotChart Tools, there are four tabs—Design, Layout, Format, and
Analyze—that contain commands you can use when working with a pivot chart. You’ll use
these commands as you work with the pivot charts in this chapter.

1. Select the pivot chart, and on the Ribbon, under PivotChart Tools, click the Design tab.

2. In the Chart Layouts group, click the More arrow to open the Chart Layouts gallery (see
Figure 11-10).

The Chart Layouts gallery shows miniature representations of the layouts that are
available. For example, Layout 1 looks similar to the current layout, with grid lines and
a legend at the right, but it includes a chart title. Layout 4 has the legend at the bottom,
no grid lines, and numbers at the top of each column. You’ll choose Layout 2, which
has a chart title and legend at the top, no grid lines, and numbers at the top of each
column. It also shows that the columns will be slightly separated.
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Figure 11-10. The Chart Layouts gallery

3. In the Chart Layouts gallery, click Layout 2 to apply that layout to the active pivot chart.

The chart layout you clicked is applied to the pivot chart. This layout has a chart title, and
the legend is displayed at the top of the chart, where it’s easier to see. The grid lines have been
removed from the chart, as has the value axis that was at the left side of the chart. Instead, the
values are displayed at the top of each column, and the columns are slightly separated in each
cluster.

Next, you’ll change the chart title so it shows information about the food sales instead of
the generic text.

1. Click the Chart Title to select it. When it is selected, the chart title has a small round
handle in each corner (see Figure 11-11).

Figure 11-11. The chart title is selected.

2. In the chart title, select the existing text, Chart Title, and press the Delete key to remove
the text.

3. Type the new text, Food Sales 2006-2007, and then click outside the chart title to com-
plete the change.

Changing the Chart Style
Now that the chart layout is the way you want it, you’ll change the chart style, which controls
the colors and effects that are used in the chart. When you create a pivot chart, a default chart
style is automatically applied. You’ll select a different chart style to quickly give the chart a
more dramatic appearance.

1. Select the pivot chart, and on the Ribbon, under PivotChart Tools, click the Design tab.
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2. In the Chart Styles group, click the More arrow to open the Chart Styles gallery.

In the Chart Styles gallery, Style 2 is selected, because that is the style currently applied
to the pivot chart. The sales manager has asked for blue coloring in the pivot chart, so
you’ll select one of the options in the third column of styles.

3. In the Chart Styles gallery, click Style 27, which is the fourth style in the third column to
apply that style to the active pivot chart (see Figure 11-12).

Figure 11-12. Select a chart style.

The chart style you clicked is applied to the pivot chart. This style uses light and dark blue
tones to color the columns, and the columns have a beveled appearance. There is good con-
trast between the column colors for the two regions, and the chart is clean and easy to read
(see Figure 11-13).

Figure 11-13. The completed pivot chart

Now that it’s ready, you can send the pivot chart to the sales manager.
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Adding Fields to the Pivot Chart
The sales manager thinks the pivot chart will be a helpful tool for the sales meeting and asks
whether you can create another chart showing the same information but with the region
totals broken down by city. For example, in the column that shows sales of cookies in the East,
how much was sold in Boston and how much was sold in New York?

You’ll add the City field to the pivot chart layout so the chart will show the amount per
city for each product type. You’ll also change the chart type so the cities for each region will be
displayed in a single column in the chart.

1. Select the pivot chart, and in the PivotTable Field List pane, add a check mark to the
City field.

The City field is added to the Axis Fields (Category) area, and the cities are displayed
along the category axis in the pivot chart, within each product type. The columns for
the cities are colored according to region, but the chart is crowded and difficult to read.
The city totals for each product type are displayed, but the chart no longer shows a
direct comparison of the totals per region for each product type.

On the category axis, you want the product type to remain where it is, and above that,
you want the region names as they were before. The legend should show the city
names so you can identify the cities in the chart’s data. To create this layout, you’ll
change the position of the Region and City fields in the chart layout.

2. In the PivotTable Field List pane, move City to the Legend Fields area, and move
Region to the Axis Fields area, below the ProdType field.

The chart layout is now close to what you need, but instead of a cluster of cities for each
region, you want a single column for each region. In the next step you’ll change the chart type,
and this will achieve the layout you need.

Changing the Chart Type
When you create a pivot chart by pressing the F11 key, the default chart style is used. Unless
you have changed the settings, the default chart style is a clustered column chart. In this chart,
you want the cities for each region stacked in a single column for each product type. You’ll
change the chart type so the columns are stacked instead of clustered.

1. Select the pivot chart, and on the Ribbon, under PivotChart Tools, click the Design tab.

2. In the Type group, click Change Chart Type (see Figure 11-14).

Figure 11-14. Change Chart Type command on the Ribbon
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The Change Chart Type dialog box opens and shows a list of chart types at the left. At
the right are the subtypes available for each chart type. You can point to a subtype and
see its name in a tool tip.

You’ll continue to use the Column chart type for this chart, but you can see the other
chart types that are available in Excel:

• Column and bar charts are almost the same, except that bars are displayed hori-
zontally across the chart and columns are vertical. Both of these chart types work
well for comparing specific values, as you’re doing in your chart.

• Line charts and area charts connect the points that represent values and are good
for illustrating changes over time. The charts are the same, except that the area
charts are filled with color.

• Pie charts and doughnut charts show the percentage that each value comprises in
the overall total. The pie chart type works well when there is a single series and
value, such as total quantity per region. A doughnut chart can show multiple
series.

• Surface charts and radar charts are specialized chart types that you can use to
show differences in the data or aggregated data.

■Note Although they are available in the list of chart types, you cannot use the XY (Scatter), Bubble, or
Stock chart types when creating a pivot chart.

In the Change Chart Type dialog box, the current chart type, Column, is selected, and
in the Column section at the right, the current chart subtype, Clustered Column, is
selected. You’ll select Stacked Column instead so the city data is stacked in a single 
column instead of being displayed in multiple columns.

■Tip Avoid using the three-dimensional chart subtypes, because they will distort the representation of the
data in your charts.

3. In the Column chart subtypes, click Stacked Column to select it (see Figure 11-15).

Figure 11-15. Select the Stacked Column chart type.
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4. Click OK to close the Change Chart Type dialog box.

With stacked columns, the chart is now easier to read, but it’s difficult to distinguish
the cities, since the legend colors are so similar. You’ll change the chart layout and style
to make it easier to identify the cities.

5. On the Ribbon, under the PivotChart Tools tab, click the Design tab.

6. In the Chart Layouts group, click the More button to open the Chart Layouts gallery.

7. Click Layout 3 to apply a layout with the legend at the bottom of the chart and numbers
on the Values axis at the left of the chart instead of crowded numbers on the columns.

■Note If you select a layout that includes a chart title, the existing title will be retained.

8. On the Ribbon, in the Design tab, click the More button to open the Chart Styles gallery.

9. Click Style 10 in the second row and the second column to apply a multicolored style,
with fine white borders around the column segments (see Figure 11-16).

Figure 11-16. Select Style 10 in the Chart Styles gallery.

With the different colors in the chart, it’s easier to identify each city’s sales in the stacked
columns (see Figure 11-17). You can send the revised chart to the sales manager.

Figure 11-17. The completed stacked column chart

CHAPTER 11 ■ CREATING A PIVOT CHART244

8903Ch11CMP3  8/20/07  8:07 PM  Page 244



Viewing the Pivot Table
Now that you’ve finished working on the pivot chart, you’ll return to the pivot table on which
the pivot chart is based to see the effect that these changes to the pivot chart have had:

1. Activate the Pivot_Regions worksheet to return to the pivot table.

2. The City field is in the Column labels area of the PivotTable Field List pane and in the
pivot table layout on the worksheet because it was added to the Legend Fields (Series)
area of the pivot chart.

3. The ProdType and Region fields are in the Row Labels area because they were both in
the Axis Fields (Categories) area of the pivot chart.

The pivot table and pivot chart are connected, and the changes you make to one will
affect the other. In some cases, this won’t be a problem, and you can lay out the pivot table
and pivot chart as you require. However, sometimes you’ve spent a considerable amount of
time setting up a pivot table or pivot chart and want it to stay in that layout for your weekly or
monthly reports.

In these situations, you can create a second pivot table from the source data and create a
pivot chart from that pivot table. Use the first pivot table for your printed reports, and when
you make changes to the pivot chart, it will affect the second pivot table, which isn’t used for
your printed reports.

Creating a Line Pivot Chart
The sales manager has asked you to create another report for the sales meetings. In this chart,
you should show the monthly quantities of bars sold in 2006 and 2007. At the meeting, this
chart can show whether bar sales are going up or down and will show the strong and weak
sales months for each year.

When you created the first chart, you used the F11 key to create a default chart. This time,
you’ll use a Ribbon command to create the chart so you’ll have more control over the chart
setup.

You don’t want to affect the existing pivot chart, so you’ll create a copy of the pivot table
and base the new chart on the pivot table copy. First you’ll copy the pivot table, and then you’ll
change its layout to include the fields you’ll need in the new pivot chart:

1. Make a copy of the Pivot_Regions worksheet, and rename the copied worksheet
Pivot_Years.

2. In the pivot table on the Pivot_Years worksheet, change the pivot table layout so 
OrderDate is in the Row Labels area, Qty is in the Values area, and ProdType is in the
Report Filter area.

3. In the report filter, select Bars so only its data is summarized in the pivot table.

4. In the Row Labels area, group the OrderDate field by Years and Months. By grouping
the dates by year, you will be able to show the years separately in the pivot chart.
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Now that the pivot table layout includes the fields you need, you can create the pivot chart.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the Tools group, click PivotChart (see Figure 11-18).

Figure 11-18. PivotChart command on the Ribbon

In the Insert Chart dialog box, the default chart type is selected. Unless you have
changed the setting, this is the Clustered Column chart type. A column or bar chart
works well when comparing specific values, as you did in the previous chart. Because
the new chart will show changes over time, a line chart will be best, so you’ll select that
chart type for your new pivot chart.

3. In the Insert Chart dialog box, in the list of Chart Types at the left, click Line.

In the chart subtypes at the right, the default line type, Line with Markers, is selected.
For this chart, you prefer a line without markers, so you’ll select a different line chart
subtype.

4. In the line chart subtypes, click Line, which is the first subtype shown, and then click
OK to create the pivot chart.

A line chart appears on the Pivot_Years worksheet, showing the bar sales for 2006 and
2007 (see Figure 11-19).

Figure 11-19. Pivot chart with Line chart type
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The pivot chart contains the data you need for the sales manager, but it needs a few
improvements before it’s ready to send.

Creating Multiple Series
In the pivot chart, the two years are shown in a single line, with the dates stretching across the
axis at the bottom. The legend shows a line for this series, with its name of Total. Instead of
this layout, with a single series, you want each year shown as a separate line, and the legend
should show an entry for each year. The Category Axis should show the months but not sepa-
rated into years.

To create a series for each year, instead of a single series, you’ll change the field layout in
the PivotTable Field List pane. You want the years in the legend, so you’ll move the Years field
there.

1. Select the pivot chart.

2. In the PivotTable Field List pane, move the Years field from the Axis Fields area to the
Legend Fields area.

This layout change creates two series, one for each year, and both show up in the legend.
The category axis shows the 12 months, and the lines show the quantity of bars sold each
month. However, when the 2006 series was created, it received the default formatting of a line
with markers, so you’ll change its formatting.

Formatting a Series
In the pivot chart, the 2006 series is formatted as a line with markers. You’ll change it so its for-
matting is the same as the 2007 series. To format any element in the chart, you can select the
element and then apply the formatting.

1. Select the pivot chart.

2. On the Ribbon, under the PivotChart Tools tab, click the Layout tab.

3. In the Current Selection group, click the drop-down arrow to see a list of elements in
the pivot chart (see Figure 11-20).

Figure 11-20. Chart Elements list on the Ribbon
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■Tip The Chart Elements list is also available on the Format tab of the Ribbon.

The Chart Elements list shows all the elements in the active chart, and you can click
any element’s name to select that element in the chart. Using this list is an easy way to
select the elements and to ensure you’re selecting the element you intended to select.

4. In the Chart Elements list, click Series “2006.”

■Tip In the pivot chart, click an element, such as a line, or the legend to select it.

In the pivot chart, the line for the 2006 series is selected, and now you can format it.

5. Just below the Chart Elements list, in the Current Selection group, click Format Selection.

The Format Data Series dialog box opens, with a list of formatting options for the
selected data series. When you click an option in the list, the formatting options
appear at the right. For example, you could click Line Style and change the line width
and dash type. You want to remove the markers from the selected series, so you’ll
change the marker options.

6. In the Format Data Series dialog box, click Marker Options.

7. For Marker Type, click None, and then click Close (see Figure 11-21).

Figure 11-21. Marker Options command

In the pivot chart, the markers in the line for the 2006 series have been removed.

Adding a Chart Title
Currently, the pivot chart does not have a title, so you’ll add one to explain the contents of the
chart. In the previous chart, you applied a chart layout that included a chart title, but in this
chart you don’t want a package of chart formatting. You want to keep the formatting that
already is applied and just add a chart title at the top of the chart.
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Instead of using a chart layout, you’ll use a different command from the Ribbon:

1. Select the pivot chart.

2. On the Ribbon, under the PivotChart Tools tab, click the Layout tab.

3. In the Labels group, click Chart Title to see a list of options for the chart title (see 
Figure 11-22).

Figure 11-22. Chart Title options

If the chart had a title you wanted to remove, you could use the first option, None. Since
you want to add a title, you’ll use one of the other two options. The second option, Cen-
tered Overlay Title, adds a title at the top of the chart on top of whatever elements are
already there. This option is ideal if there is plenty of blank space at the top of the chart
and you can display the title there without blocking the other elements.

The third option, Above Chart, will make the chart area smaller and add the chart title
in the newly created blank space above the chart area. This option is best if there are
other elements at the top of the chart and you don’t want to cover them. For your
chart, this will be the best option, since the lines are near the top of the chart.

4. Click Above Chart to add the default chart title.

5. In the pivot chart’s chart title, select the existing text, and type Bars -- Units Sold, and
then click outside the chart title to complete it.

Changing the Pivot Chart Legend
You can also use the Ribbon commands to change the legend position. Currently the legend is
at the right of the chart. If you move it to the top, there will be more space for the 12 months
that are displayed on the category axis at the bottom of the chart.

1. Select the pivot chart, and on the Ribbon, under the PivotChart Tools tab, click the 
Layout tab.

2. In the Labels group, click Legend, and then click Show Legend at Top.
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■Tip You can click the legend to select it, point to the legend’s border, and drag it to any position in the
chart area.

Resizing a PivotChart
When you create a pivot chart, it is automatically sized. You can change the chart size by man-
ually adjusting it or by setting an exact width and height. You’ll make the pivot chart a bit
smaller so it doesn’t overlap the pivot table:

1. Select the pivot chart.

2. On the chart area border, point to one of the sizing handles.

3. When the pointer changes to a double-headed arrow shape, press the left mouse 
button, and drag toward the center of the chart to make the chart area smaller (see 
Figure 11-23).

Figure 11-23. Manually resizing the pivot chart

■Tip To make the pivot chart a specific height or width, enter a value in the Shape Height or Shape Width
box in the Size group on the Ribbon’s Format tab.

Moving a Pivot Chart
When you use the Ribbon command to insert a pivot chart, it is inserted in the center of the
worksheet window. You can drag the pivot chart to a new location on a worksheet or cut it and
paste it onto a different worksheet.

You can also use a command to move the chart to a different location. You’ll use a com-
mand to move the pivot chart to its own chart sheet. This will make the chart larger, and it will
be easier for the sales manager to see the details in the chart.

CHAPTER 11 ■ CREATING A PIVOT CHART250

8903Ch11CMP3  8/20/07  8:07 PM  Page 250



1. Select the pivot chart.

2. On the Ribbon, under the PivotChart Tools tab, click the Design tab.

3. In the Location group, at the far right, click the Move Chart command.

■Tip You can right-click the chart area of a pivot chart and choose Move Chart.

4. In the Move Chart dialog box, click New Sheet, and type Chart_Years as the name for
the new sheet.

5. Click OK to move the pivot chart.

The pivot chart is moved to a new sheet, where there is more room to display all the 
elements without crowding.

Adding Data Labels to a Series
When you create a pivot chart, there are no labels on the data to show the values that the lines
or bars represent. In some charts, you may want to add labels to some or all of the points on
the line or to the columns or bars in the chart.

Before you send this chart to the sales manager, you’ll add data labels to the lines. First
you’ll add data labels to all the points in both lines to see how that looks:

1. Select the pivot chart, and on the Ribbon, under the PivotChart Tools tab, click the 
Layout tab.

2. In the Labels group, click Data Labels.

3. In the list of Data Label options, click Above to add a data label above each point in
each of the lines.

Adding the data labels has cluttered the pivot chart, and where the lines overlap, it’s hard
to read the numbers and to tell which number belongs to which line (see Figure 11-24).

Figure 11-24. Overlapping data labels
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Instead of having each point labeled, you want to label just the last point on each line. You’ll
remove the data labels and then label just the last points to show the final value for each year.

■Tip To quickly add a label with the series name and value to the last point of each line, click the Design
tab on the Ribbon, and in the Chart Layouts, click Layout 6. However, this layout will apply other formatting
options in addition to the last point label. You could apply the layout first and then finish formatting the chart.

1. Select the pivot chart, and on the Ribbon, under the PivotChart Tools tab, click the 
Layout tab.

2. In the Labels group, click Data Labels.

3. In the list of Data Label options, click None to remove the data labels.

4. Click the 2007 line to select that series. Each point in the series will be selected and will
show handles.

5. Click the last point at the far right of the 2007 line. Now that point is the only one
selected and is the only one that has handles (see Figure 11-25).

Figure 11-25. The last point on the line is selected.

6. On the Ribbon’s Layout tab, in the Labels group, click Data Labels.

7. In the list of Data Label options, click Right to add a data label to the right of the
selected data point.

8. Select the last point on the 2006 line, and add a data label to its right.

■Tip You can select each data label and format it with a font color that matches the data series line.
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Adding a Trend Line
Next, you’ll add a trend line to each year’s line to see whether sales are going up or down over
the year:

1. Select the pivot chart, and click the 2006 line to select it.

2. On the Ribbon, click the Layout tab.

3. In the Analysis group, click Trendline, and then click Linear Trendline.

4. Select the 2007 line, and add a trend line to it.

The trend line for 2006 rises slightly over the year, and the 2007 trend line is downward.
The trend lines have also been added to the legend as Linear (2006) and Linear (2007). To
make the trend lines stand out a bit more in the chart, you can make the lines thicker and 
format each with a different color:

1. In the Chart Elements list on the Ribbon, select Series “2006” Trendline 1.

2. On the Ribbon, click the Format tab, and in the Shape Styles group, click Shape Outline.

3. Click Weight, and then click the 1.5-point line.

4. Click Shape Outline again, and click a color for the trend line.

5. Select the 2007 trend line, and format it with a thicker line and a different color (see
Figure 11-26).

Figure 11-26. Trend lines added to the pivot chart

You send the updated chart to the sales manager for discussion at the sales meeting. Per-
haps a plan can be devised to increase the bar sales in 2008.
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Creating a Variable Chart Title
Soon after you send the chart, the sales manager calls to ask whether you can create a similar
chart for each of the product types. Perhaps the other product types also have declining sales
and should be discussed at the sales meeting.

Instead of creating separate charts, you’ll show the sales manager how to select a different
product type during the meeting. You’ll change the chart title so it will show the name of the
selected product type. To make the chart title variable, you’ll create a formula on the pivot
table worksheet, and then you’ll link the chart title to that cell.

1. On the Pivot_Years worksheet, select cell F1. You’ll use this cell to create a formula that
shows the name of the selected product type and the rest of the text for the chart title.

2. Type an equal sign, and then click cell B1, which contains the product type name.

3. Type the rest of the formula, which is & “ -- Units Sold”, as shown in Figure 11-27.

Figure 11-27. Formula for variable chart title

4. Press the Enter key to complete the formula, and activate the Chart_Years sheet.

5. In the pivot chart, select the chart title.

6. Type an equal sign, then activate the Pivot_Years sheet, and finally click cell F1, which
contains the formula.

7. Press the Enter key to complete the link in the chart title.

The chart title will remain the same, because Bars is still selected as the product type.
The title will change when a different product type is selected.

8. To select a different product type, click the Report Filter drop-down on the PivotChart
Filter Pane, and click Cookies.

The chart title changes to show that Cookies is the selected product type, and the lines
show the monthly quantities of cookies sold. During the meeting the sales manager will be
able to select any product type from the PivotChart Filter Pane and lead a discussion on that
product type’s sales results.

Instead of creating four separate charts, one for each product type, you were able to cre-
ate a dynamic chart that can be changed with the click of the mouse during the meeting. It
will be easier for the sales manager to work with one chart, instead of several, and you saved
considerable time in preparation.
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Exploring Other Pivot Chart Features
When you select a pivot chart, four tabs with pivot chart commands are available on the 
Ribbon on the PivotChart Tools tab. In the examples in this chapter you used some of these
commands to format and design the pivot charts, and many others are left for you to explore
on your own.

When you create a pivot table, experiment with the options and features that are avail-
able, and see what works best to enhance your pivot charts. For example:

• On the Layout tab, use the Data Table command to show the values that are represented
in the chart in a table format. This works best if there are very few values and the table is
not too crowded to be legible.

• On the Format tab, use the Shape Styles and WordArt Styles to add color, effects, and
font formatting to the pivot chart. You can use these features in moderation to highlight
a specific part of the pivot chart or add an eye-catching brief comment.

• On the Layout tab, use the Axes and Gridlines commands to change the appearance of
these elements. You can make the grid lines a lighter color so they are less intrusive on
the chart, or you can format the text and numbers on the axes to use the space effec-
tively.

Try to keep the chart’s message clear, though, and not buried under a load of unnecessary
formatting and frills.

Summary
In this chapter, you created pivot charts to illustrate the data in a pivot table. This can make
the data easier to understand and provides a visual comparison of the data.

First, you created a default pivot chart by pressing the F11 key. Then, you used the Chart
Styles gallery and the Chart Layout gallery options to change the appearance of the pivot
chart. You changed the chart type to show related items in a single column, instead of multiple
columns. After making the changes, you viewed the pivot table to see that the pivot chart
changes had also affected the pivot table on which it was based.

You also created a pivot chart by using the Ribbon commands and modified it to show
multiple series, instead of a single series. You formatted the series to remove the markers and
added a chart title. You moved the chart legend and then resized and moved the pivot chart.
You added data labels to show the numeric value of the last points in each of the series lines
and added trend lines to show whether sales were increasing or decreasing over each year.

Finally, you entered a formula on the worksheet and linked the chart title to that cell. This
created a dynamic chart title, which will change when the chart filter is changed. With these
tools, you have a powerful tool for data analysis that can be changed with one click of the
mouse.
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Printing and Extracting Data
from a Pivot Table

In this chapter, you’ll explore different ways to extract and print the data in a pivot table.
These techniques can help you drill into the data and solve problems, create an attractively
printed document, and pull key pieces of data from a large pivot table.

• First, you’ll use the Show Details feature to extract the data that’s summarized in a cell
in the Values area. This may help you when troubleshooting or trying to understand the
data behind the numbers.

• Next, you’ll use the Show Report Filter Pages feature to create a copy of the pivot table
on a separate sheet for each of the items in a selected report filter. This feature can 
provide a quick way to produce personalized copies of the pivot table for viewing or
printing.

• Next, you’ll prepare the pivot table for printing. While working with pivot tables, you
may want to print the results for historical record or for distribution to others. You can
adjust the pivot table print settings to ensure you achieve the best results.

• Finally, you’ll use the GetPivotData function to extract a specific value from the pivot
table and show that value in a summary report on another worksheet.

Using the Show Details Feature
Each number in the pivot table’s Values area summarizes data from one or more records in the
data source. When working with the pivot table, you may have questions about the data and
want to see more detail from the records that are summarized. To see the underlying records,
you can use the Show Details feature.

In Chapter 10, you created pivot table reports for the company’s safety director, and you
have been asked to provide further help. You’ll open the file that contains the safety data and a
pivot table, and then you’ll assist the safety director by extracting data from the pivot table:

1. Download and open the sample file named SafetyData12.xlsx that is available at
www.apress.com.
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On Sheet1 there is an Excel table that contains safety data, listing the incidents that
occurred at each location from January 2006 to June 2008. On the Pivot worksheet is a
pivot table that summarizes the safety data.

The pivot table shows a count of lost time incidents at each location for each year (see
Figure 12-1).

Figure 12-1. Lost time incidents per location per year

The safety director will be visiting the Florida location and wants details on the five lost
time incidents that have occurred at that location in 2008. To provide the information, you’ll
use the pivot table’s Show Details feature. First you’ll extract the records, and then you’ll for-
mat them.

Extracting Records with the Show Details Feature
You can use the Show Details feature to quickly extract the records that are summarized in a
cell in the pivot table’s Values area. You’ll extract the lost time incident records for Florida that
were reported in 2008, then you’ll format the extracted data, and finally you’ll send the
detailed list to the safety director:

1. In the pivot table, right-click cell D7, which contains a 5. This is the number of lost
time incidents that were reported at the Florida plant in 2008.

2. In the context menu, click Show Details (see Figure 12-2).

CHAPTER 12 ■ PRINTING AND EXTRACTING DATA FROM A PIVOT TABLE258

8903Ch12CMP2  8/19/07  10:37 AM  Page 258



Figure 12-2. Show Details command

3. The lost time incident records for 2008 in Florida are extracted to a new worksheet in
the workbook (see Figure 12-3).

Figure 12-3. Records extracted to a new worksheet

The extracted records are copies of the original records that are in the Excel table on
Sheet1. They are not connected to the original records or to the pivot table.

■Note If you make changes in the exported records, it will have no effect on the pivot table, and the
changes will not be reflected in the original records.
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Formatting the Extracted Records
The exported records are automatically formatted as an Excel table. Look at the Ribbon—
you’ll see that the Design tab under TableTools is active, and you’ll see the table’s name in the
Properties group at the left end of the Ribbon. To prepare the report before sending it to the
safety director, you’ll improve the formatting:

1. Some of the columns may be too narrow, such as Column A in Figure 12-3, which
shows number signs instead of dates. Widen the columns, if necessary, to see the data.

2. The default table style for the workbook is automatically applied when the table for the
extracted records is created. To make the table easier to read, you can select a different
table style from the Table Styles gallery. For example, select Table Style Light 1, and
turn off the Banded Rows setting.

■Tip You can rename the Excel table that contains the extracted records using a descriptive name such as
FloridaLostTime.

3. To send the extracted records to the safety director, you can move the worksheet to a
new workbook. Right-click the Sheet4 sheet tab, and in the context menu, click Move
or Copy.

4. In the Move or Copy dialog box, from the drop-down list at the top, select (new book),
and then click OK (see Figure 12-4).

Figure 12-4. Move or Copy dialog box

5. Save the new workbook, and then close it and send your report to the safety director.
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Changing the Default Table Style
The safety director thanked you for the report on the Florida 2008 lost time incidents and
asked whether you can extract another set of records. This time, your report should include all
the records for medical claim reports in 2007.

You noticed that the default table style for the workbook was automatically applied when
you extracted the Florida records. You would prefer a different table style for any future
extracts, so you’ll change the default table style before you create the next report:

1. Activate Sheet1, and select a cell in the Excel table.

2. On the Ribbon, under the Table Tools tab, click the Design tab, and click the More but-
ton to open the Table Styles gallery.

3. Right-click Table Style Light 1, and click Set As Default (see Figure 12-5).

Figure 12-5. Change the default table style.

Now that you have changed the default table style for the workbook, you’ll create the next
report to show the medical claim records for 2007.

This time you try a different technique to extract the records. Instead of using the context
menu command, you’ll double-click the cell that summarizes the records you want to extract.

1. In the pivot table, change the report filter so the pivot table shows medical claims.

2. Double-click cell C14, which contains a 56. This is the number of medical claims inci-
dents reported in 2007.

■Tip If you accidentally delete a pivot table’s source data, you may be able to re-create it by using the
Show Details feature. Remove any filters from the pivot table, and then double-click the Grand Total cell.
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The 56 extracted records are listed in an Excel table on a new worksheet, and the new
default table style has been applied (see Figure 12-6). You can move the worksheet to a new
workbook and send the medical claims report to the safety director.

Figure 12-6. Extracted records in a new workbook

Disabling Show Details
In some pivot tables, you may want to disable the Show Details feature so you won’t acciden-
tally extract records if you double-click a cell in the Values area. You can follow these steps to
turn off the feature:

1. Right-click a cell in the pivot table, and in the context menu, click PivotTable Options.

2. On the Data tab, in the PivotTable Data section, remove the check mark from Enable
Show Details (see Figure 12-7), and then click OK.

Figure 12-7. Turn off the Enable Show Details feature.

Using Show Report Filter Pages
Next, the safety director wants you to print a report for each plant. The report should show the
number of lost time incidents per year, listed by age group, for the selected plant. First you’ll
modify the pivot table layout so it shows the information you need in the report. Then you’ll
use the pivot table’s Show Report Filter Pages feature to quickly create the plant reports. In the
next section, you’ll prepare the reports for printing.
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1. In the pivot table, move Plant to the Report Filter area, and add Age Group to the Row
Labels area. The Date field is still in the Values area, showing a count of incidents, and
Year is in the Column Labels area.

2. In the Report Type filter drop-down, select Lost Time (see Figure 12-8).

Figure 12-8. Lost time incidents per age group per year

To print the reports that the safety director needs, you could select a plant from the report
filter, print the pivot table worksheet, and then select the next plant, continuing until you had
printed them all. This process would take a few minutes, and it would be easy to miss one
plant in the list and forget to print its report.

To make the printing process easier, you can use the Show Report Filter Pages feature.
This feature automatically creates a worksheet from each item in the selected report filter.
Then, you can select all the worksheets that were created and print them.

You’ll use the Show Report Filter Pages feature to create the plant worksheets, and then
you’ll view the results.

1. Select a cell in the pivot table, and on the Ribbon, under the PivotTable Tools tab, click
the Options tab.

2. In the PivotTable group, click the drop-down arrow on the Options command.

3. Click Show Report Filter Pages (see Figure 12-9).

Figure 12-9. Show Report Filter Pages command
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4. In the Show Report Filter Pages dialog box, all the report filters are listed. You want a
worksheet for each plant, so select the Plant field, and then click OK (see Figure 12-10).

Figure 12-10. Show Report Filter Pages dialog box

A worksheet is created for each plant, with its name on the sheet tab. On each worksheet
is a copy of the original pivot table, with the plant’s name selected in the Report Type filter.

Printing a Pivot Table
Now that you have created the worksheets you need to print, you’ll preview them and make
any final adjustments required before printing them.

You can format and print worksheets individually or as a group, as you’ll do in this sec-
tion. All the sheets need the same formatting, and this will be quicker than changing each
sheet individually.

1. You want to print all the plant reports together, so you’ll select all the plant sheets.
Click the Alabama sheet tab to select it.

2. Scroll through the sheet tabs until the Texas sheet tab is visible. Hold the Shift key, and
click the Texas sheet tab. This selects, or groups, all the worksheets from the Alabama
sheet to the Texas sheet.

When two or more sheets are selected, the title bar at the top of the Excel window shows
[Group] at the end of the file name. The grouped sheets have white tabs, and the active sheet
has bold font in its tab name (see Figure 12-11).

Figure 12-11. The plant sheets are grouped.

■Caution While the sheets are grouped, any changes you make to the active sheet are also made to the
other sheets in the group.
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3. You’ll add a header to the worksheet, which will appear when the sheets are printed. To
add this, you’ll switch to Page Layout view, where you can see the header area. At the
bottom of the Excel window, click the Page Layout button (see Figure 12-12).

Figure 12-12. Page Layout button

4. To add the text for the header, click in the middle section in the header above the grid
lines on the worksheet (see Figure 12-13), and type Lost Time Incidents.

Figure 12-13. Adding text to the header

■Tip While working in the header, a Design tab is activated on the Ribbon. You can use the commands
there to format the header or to add special features, such as the date or file name.

5. Before you print the reports, you’ll use the Print Preview feature to see how the sheets
will look when printed. Click the worksheet to exit the header, click the Microsoft
Office Button, point to Print, and click Print Preview.

6. In the Print Preview window, click the worksheet to zoom in or out. At the bottom left
of the window you can see the page count is Page 1 of 9, and at the top left of the win-
dow you can click Next Page or Previous Page to view the plant reports.

■Tip Use the Page Up and Page Dn keys on the keyboard to navigate through the pages in Print Preview. If
you have clicked the Zoom command on the Ribbon or clicked the page to zoom in, the Page Up and Page
Dn keys will move you up and down on the current page.

7. In the Print Preview window, click Print to open the Print dialog box where you can
select a printer and set any other print options, such as the number of copies or the
range of pages to print. Then, click OK to print the reports, or click Cancel to close the
dialog box without printing.
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8. Now that you have printed the plant reports and sent them to the safety director, you
can delete the grouped sheets and return to the original pivot table. To delete the
grouped sheets, right-click the sheet tab for one of the grouped sheets, and click
Delete. Read the warning message, and click Delete to delete the sheets that are no
longer required.

Changing the Print Options
The safety director wants you to print another report for distribution. In this report, data will
be shown for 2006 and 2007, showing a count of incidents for each plant per incident type for
each age group.

1. Modify the pivot table so Plant and Incident Type are in the Row Labels area, Year is in
the Report Filter area with 2006 and 2007 selected, Age Group is in the Column Labels
area, and Date is in the Values area as count of incidents (see Figure 12-14).

Figure 12-14. Incidents per age group and incident type at each plant

2. Before you print the report, you’ll use the Print Preview feature to see how the report
will look when printed. Click the Microsoft Office Button, then point to Print, and
finally click Print Preview.

3. At the bottom left of the Print Preview window you can see the page count. To see how
the pages are laid out, click Next Page twice to view the entire report, and then click
Close Print Preview to return to Normal view of the worksheet.

In Print Preview, a few problems were visible:

• The report was spread over three pages, but the column headings were visible only on
the first page.

• When a plant’s list was continued on another page, such as the Illinois list, the plant
name was not repeated at the top of the second page.

• The pivot table headings show Row Labels and Column Labels, instead of the field
names.
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You’ll change the pivot table options to fix these problems before you print the pivot table:

1. Right-click a cell in the pivot table, and in the context menu, click PivotTable Options.

2. On the Printing tab, add a check mark to Repeat Row Labels on Each Printed Page (see
Figure 12-15). This will cause the labels to repeat when an item’s list continues on a
second page, as the Illinois list does in your pivot table.

Figure 12-15. Printing options

3. Also on the Printing tab, add a check mark to Set Print Titles. This will ensure that the
labels at the top of the pivot table, such as the Age Groups, repeat if the pivot table is
longer than one printed page.

■Tip You won’t use the third option, Print Expand/Collapse Buttons When Displayed on PivotTable, in this
report. However, you could use it when printing a pivot table with some items collapsed to alert readers to
the hidden items.

4. Click the OK button, and then preview the report again to see the changes.

At the top of the second page in the print preview, the Age Group labels are visible, so
the Set Print Titles option had the effect you wanted. However, the Illinois label isn’t
repeated on the second page, although its items started on the first page and continue
on the second page (see Figure 12-16).

Figure 12-16. Top of the second page in Print Preview view
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The option, Repeat Row Labels on Each Printed Page, doesn’t have any effect if the
pivot table is in Compact Form layout. You’ll change the report layout, and that should
solve the problem.

5. Click Close Print Preview to return to Normal view of the worksheet.

6. On the Ribbon, under the PivotTable Tools tab, click the Design tab, and in the Layout
group, click Report Layout. Then click Show in Outline Form.

This will create a report that’s similar to the Compact Form but has the Plant and Inci-
dent Type row labels in separate columns. Also, the Row Labels and Column Labels
headings have been removed from the top of the pivot table, and the field names,
Plant, Incident Type, and Age Group, are now visible (see Figure 12-17).

Figure 12-17. Field names visible in Outline Form

7. Adjust the width of column A so it’s just wide enough to fit the Incidents label in cell
A4, and adjust the other column widths, if necessary.

8. Preview the report again to see the changes. The heading for Illinois is now shown on
the second page (see Figure 12-18), because the option, Repeat Row Labels on Each
Printed Page, has an effect when the report is in Outline Form.

Figure 12-18. Row labels repeating in outline form

Now that the report is set up the way you want it, you can print a copy and send it to the
safety director for distribution at the upcoming meeting.
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Adding Page Breaks After Items
The safety director likes the report but wants each plant’s report to start on a new page. That
will make it easier to focus on each plant’s performance individually during the meeting. To
achieve this layout, you’ll change a setting in the Plant field, and you’ll also hide the grand
total so it won’t print with the final plant report.

1. Right-click one of the plant labels, such as Alabama in cell A6, and in the context
menu, click Field Settings.

2. On the Layout & Print tab, in the Print section, add a check mark to Insert Page Break
After Each Item (see Figure 12-19), and then click OK.

Figure 12-19. Inserting page break after each item

3. To remove the Grand Total row, select a cell in the pivot table, and on the Ribbon, click
the Design tab.

4. In the Layout group, click Grand Totals, and click On For Rows Only. This will remove
the grand total row at the bottom of the pivot table, which contains the grand totals for
all the columns.

5. Preview the report again to see the changes. Each plant’s report starts on a new page,
and the grand total has been removed from the end of the report.

The revised report is finished, and you can print a copy and send it to the safety director.

Using the GetPivotData Function
Next, the safety director wants you to complete an incident cost report in the workbook. On
Sheet 2, there is a list of plants and the number of employees at each plant. To calculate the
incident cost per employee at each plant, you will extract the incident costs from the pivot
table. This will create a report that combines incident costs from the pivot table with
employee numbers that are not available in the pivot table.

First, you’ll change the pivot table layout to show the number of incidents at each plant in
2007. Next, you’ll complete the summary report by using the GetPivotData function.

1. In the pivot table, remove the Incident Type, Incidents, and Age Group fields, and add
Incident Cost to the Values area.
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2. In the Report Filter, select 2007 as the year (see Figure 12-20).

Figure 12-20. Incident cost per plant in 2007

3. Select Sheet 2 to view the summary report, where you’ll fill in the incident numbers.

■Tip To extract data from a cell in a pivot table, you can enter a normal cell link, such as =B5, or you can
use the GetPivotData function, which is specially designed to extract data from a pivot table. The advantage
of using the GetPivotData function is that it uses criteria to ensure that the correct data is returned, even if
the pivot table layout is changed.

You’ll create a GetPivotData formula to extract the number of incidents at the Alabama
plant. When you use a GetPivotData formula, it will continue to provide the correct
information, even if the pivot table values are sorted or if more fields are added to the
pivot table layout.

4. On Sheet 2, select cell D5, and type an equal sign to start the formula.

5. Activate the Pivot sheet, and click cell B5, which contains the incident cost for
Alabama. Then press the Enter key to complete the formula.

A GetPivotData formula was automatically created in cell D5 (see Figure 12-21), and it
returns the 2007 incident cost for Alabama from the pivot table.

Figure 12-21. GetPivotData formula in cell D5
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The first argument in the GetPivotData function is Incident Cost; this is the Value field
being extracted. The second argument is Pivot!$A$4, which is a cell in the pivot table. The next
argument is the field name, Plant, and the name of the selected item in that field, Alabama.

■Caution If the fields or items used in the GetPivotData formula’s arguments are removed from the pivot
table layout, the formula will return a #REF! error.

Using Cell References in GetPivotData Formulas
When GetPivotData formulas are automatically created, the formulas contain text strings that
refer to the field names and item names in the pivot table. In cell D5, the formula refers to the
Plant field and the Alabama item. You could complete the incident cost report by linking each
plant’s costs individually, but you’ll change the formula so it’s more flexible.

In the formula, you can replace the text strings with references to cells that contain field or
item names. You’ll change the formula so it refers to the plant name in column B of the incident
cost report. Then, you will be able to copy the formula down, and it will show the incident cost
for each plant.

1. Select cell D5, and in the formula bar, select “Alabama” in the formula, including the
quotation marks.

2. Click cell B5 to add a reference to that cell in the formula (see Figure 12-22), and then
press the Enter key to complete the change.

Figure 12-22. Adding a cell reference to a GetPivotData formula

3. Select cell D5, point to the fill handle at the bottom right of the cell (see Figure 12-23),
and drag down to cell D13 to copy the formula.

Figure 12-23. Dragging the fill handle to copy the formula down
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By changing the formula so it refers to the plant names in column B, instead of the text
string Alabama, you were able to complete the incident report quickly.

The worksheet title, in cell B2, contains a formula that refers to the year selected in the
pivot table’s report filter. The safety director will be able to select a different year in the pivot
table and see the incident costs summary with the correct title.

■Note A GetPivotData formula will return a #REF! error if it refers to a pivot table in another workbook and
that workbook is closed.

Turning Off the Generate GetPivotData Feature
In some cases, you may want to link to a cell in a pivot table and not create a GetPivotData for-
mula. You can turn off the feature that creates the formulas automatically, and a simple link
will be created when you click a pivot table cell.

1. To turn off the Generate GetPivotData feature, select a cell in the pivot table.

■Note This is an application-level setting and will affect all the workbooks you open.

2. On the Ribbon, under the PivotTable Tools tab, click the Options tab.

3. In the PivotTable group, click the arrow on the Options command, and then click Gen-
erate GetPivotData to remove the check mark (see Figure 12-24).

Figure 12-24. Turning off the Generate GetPivotData feature

■Tip To create a simple link to a pivot table cell without turning off the Generate GetPivotData feature, you
can type an equal sign and the cell reference.
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Summary
In this chapter, you used a variety of tools to extract data from your pivot tables for analysis or
for printing.

You used the Show Details feature to drill into the details behind a number in the pivot
table. To format the extracted records automatically, you changed the default table style for
the workbook. The sheet with the extracted records can be moved to a new workbook and
saved.

By using the Show Report Filter Pages feature, you created a separate pivot table for each
item in a report filter. You grouped and printed the worksheets and then deleted them.

You adjusted the pivot table print settings and the field settings to achieve the best results
when printing your pivot tables.

Finally, you used the GetPivotData function to extract a specific value from the pivot table
and used a cell reference in the formula to make it flexible. Instead of creating individual for-
mulas to refer to the different plants, you were able to use a single formula in all the rows.
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Key Skills

The appendix contains instructions for downloading the sample files from the Apress web
site and for key Excel 2007 skills. If you’re new to Excel or to Excel 2007, you can follow these
steps to perform the tasks that are not described in detail in the book’s chapters.

Downloading the Sample Files
In each chapter, one or more sample files are provided for you to use while doing the exercises.
To download the sample files from the Apress web site, go to www.apress.com, and search for 
the title of this book or for the ISBN: 1-59059-890-3. On the web page for this book, in the Book
Extras section, click the link Source Code (see Figure A-1), and then click the link Download
Source Code File.

Figure A-1. Source Code link

The download will be a zipped file that contains the sample Excel 2007 files and other files
used in the chapter instructions.

Saving a File
Follow these steps to save a workbook for the first time using the default file format for Excel
2007:

1. In Excel, click the Microsoft Office Button at the top left of the Excel window (see 
Figure A-2).

Figure A-2. Microsoft Office Button
275
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2. Point to Save As, and then click Excel Workbook (see Figure A-3) to open the Save As
dialog box.

Figure A-3. Excel Workbook format

3. In the Save As dialog box, select a folder from the Save In drop-down list.

4. Name the file, and then click the Save button.

Converting a File from an Earlier Version
If you open a file you created in an earlier version of Excel, the file will open in Compatibility
Mode, and you will see [Compatibility Mode] in the Excel title bar after the file name. Any
pivot tables in the workbook that were created in the earlier version of Excel, or in Compatibil-
ity Mode, will not be fully functional with all the Excel 2007 features, such as label or date
filters.

Follow these steps to convert the file to Excel 2007 format:

1. Make a backup copy of the file. When you use the Convert feature, the original work-
book is deleted and cannot be restored.

2. Open the file in Excel 2007, and click the Microsoft Office Button.

3. Click Convert (see Figure A-4).

Figure A-4. Convert command

4. If a message about converting the workbook appears, read it, and then click OK to con-
vert the workbook or click Cancel.

5. After the workbook as been converted, a message appears to tell you that the conver-
sion was successful. Read the message, and then click Yes to close and reopen the
workbook or click No.

APPENDIX ■ KEY SKILLS276

8903Ch13AppACMP2  8/19/07  10:38 AM  Page 276



After the file has been closed and reopened, it is in Excel 2007 format, and [Compatibility
Mode] has disappeared from the title bar. The pivot tables will have full functionality, with all
the Excel 2007 features available.

Sharing Files with Users of Earlier Versions
You may need to send your files to someone who is using an earlier version of Excel. So that
they can open the file, you can save the file in a format they can use, or the person with the
earlier version can download and install a converter from the Microsoft web site.

To save the file in an earlier version of Excel, follow these steps:

1. Open the file in Excel 2007, and click the Microsoft Office Button.

2. Point to Save As, and then click Excel 97-2003 Workbook (see Figure A-5).

Figure A-5. Excel 97-2003 Workbook command

3. In the Save As dialog box, select a folder from the Save In drop-down list.

4. Name the file, and then click the Save button.

To download the file converters, visit the Microsoft web site at www.microsoft.com, and
search for the Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007 File
Formats. Follow the instructions there to download and install the converters.

Turning On the ScreenTips Feature
If ScreenTips do not appear when you point to commands in the Ribbon, the feature may
have been turned off. Follow these steps to turn the feature on:

1. Click the Microsoft Office Button, and then click Excel Options.

2. In the list of categories, click Popular.

3. In the Top Options for Working with Excel section, click the drop-down list for 
ScreenTip Style (see Figure A-6).

Figure A-6. ScreenTip Style drop-down list
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4. Click Show Feature Descriptions in ScreenTips to see the command names and
descriptions in the tips, or click Don’t Show Feature Descriptions in ScreenTips to see
only the command names.

5. Click OK to close the Excel Options dialog box.

Turning On Contextual Tips
If contextual tips do not appear when you point to a cell in a pivot table, the feature may have
been turned off for that pivot table. Follow these steps to turn the contextual tips feature on:

1. Right-click a cell in the pivot table, and click PivotTable Options.

2. On the Display tab, add a check mark to Show Contextual Tooltips.

3. Click OK to close the PivotTable Options dialog box.

Adjusting Regional Options
The Regional options on your computer may be different from those on the computer used for
the examples in this book. This could affect settings such as date format, currency symbols,
and digit grouping in numbers.

Follow these steps to view the Regional options on your computer with a Windows XP
operating system:

1. On the Windows taskbar, click the Start button, and click Control Panel.

2. Double-click Regional and Language Options.

3. Click the Regional Options tab to view the settings.

4. Click Customize to view the detailed settings.

Adjusting Security Settings
The security settings on your computer may be different from those on the computer used for
the examples in this book. This could affect the messages you see, especially when connecting
to external data.

Follow these steps to view the security settings on your computer:

1. In Excel, click the Microsoft Office Button, and click Excel Options.

2. In the list of categories, click Trust Center.

3. Click Trust Center Settings to open the Trust Center dialog box. Click a category in the
list at the left to view the settings for that option. For more information on the settings,
click the question mark button at the top right of the dialog box.
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4. Click the Trusted Locations category to see the trusted locations on your computer.
These are folders that are treated as secure sources, and the Trust Center security 
features won’t check them. You can add folders to this list by clicking the Add New
Location button.

■Tip Store the sample files for this book in a trusted location, and you won’t receive security warnings
when you open or connect to these files.

5. Click OK to close the Trust Center dialog box, and click OK to close Excel Options.
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■SYMBOLS
#REF! error, 271–272
% Difference From

definition of, 168
using, 173

% Of
definition of, 168
using, 171

% of column
definition of, 168
using, 177

% of row
definition of, 168
using, 176

% of total
definition of, 168
using, 178

∑Values button, 54

■A
A Date Occurring dialog box, 217
Above Average command, 223
Above Chart option, 249
Access. See Microsoft Access
Actions group, 51
Active Field group, 147
Add New Location button, 279
Add to Report Filter command, 90
Analysis group, 253
Analysis Services, Microsoft SQL Server 2005,

143
Analyze tab, 239
AND worksheet function, 190
Apply Rule To options, 226
applying a pivot table style, 42
area charts, 243
Arrows (Colored) Icon Sets option, 208–209
Aspect theme, 84
Autofit Column Widths on Update option,

229
AutoSort option, 105
∑Values button, 54
Average function, 48, 52
Axes command, 255
Axis Fields (Categories) area, 235, 238, 242,

247

■B
Banded Columns command, 74
Banded Rows command, 73
bar charts, 243
Base Field list, 170
Base Item list, 170
Before Sheet list, 155
Begins With command, 110
benefits of using pivot tables, 5
Between dialog box, 214
Blank Rows command, 72
Border tab, 77
Business Objects, 143

■C
calculated fields

adding complex formulas to, 186
AND worksheet function, 190
Calculated Field command, 183, 187, 189
Clear All command, 191
creating, 182
creating a list of, 197
creating a new field in the Values area, 182
deleting, 191
editing, 185
formulas as operating on the sum of the

fields, 190
grand total and row calculations, 189
IF worksheet function, 187, 190
Insert Calculated Field dialog box, 183,

187, 189
Insert Field button, 184
List Formulas command, 197
naming conventions of, 184
not using worksheet functions requiring a

range reference, 190
not using worksheet functions where the

results change, 190
OR worksheet function, 190
removing from a pivot table layout, 189
replacing worksheet formulas with, 182
understanding their operation, 190
using field names instead of cell

references, 181, 186
using in formulas, 189
See also calculated items; conditional

formatting; custom calculations;
summary functions

Index
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calculated items
Calculated Item command, 192, 194
changing the solve order of, 198
Clear All command, 191
creating, 191
creating a list of, 197
editing, 195
Insert Calculated Item dialog box, 192, 194
Insert Field button, 192
Insert Item button, 193
List Formulas command, 197
Solve Order dialog box, 200
using item names instead of cell

references, 181
See also calculated fields; conditional

formatting; custom calculations;
summary functions

category axis, 235, 238, 242
cell references

using field names instead of cell
references, 181, 186

using in GetPivotData formulas, 271
Cells dialog box, Format, 33, 47, 52, 77, 79,

115, 172, 174, 213, 215, 222–223
Cells group, 12
Centered Overlay Title option, 249
Change Chart Type dialog box, 243
Change Data Source command, 152, 156, 161
Change PivotTable Data Source dialog box,

152, 156, 161–162
Chart Elements list, 248, 253
Chart Layouts gallery, 239, 244
Chart Styles gallery, 241
Chart Title

adding, 249
removing, 240

charts. See pivot charts; PivotChart Tools
Choose Connection command, 161
Clear All command, 191, 228
Clear command, 76
Clear Filter command, 17, 38, 237
Clear Filters command, 95
Clear PivotTable option, 115
Clear Rules from Selected Cells command,

206
Clustered Column chart type, 243, 246
Cognos PowerPlay, 143
Collapse Entire Field command, 148
Color drop-down, 213
color scales

applying a three-color scale, 206
applying a two-color scale, 203
Color Scales option, 205, 207
using both solid and graduated colors to

highlight cell values, 207
Colors command, 82
column charts, 235, 238, 243

Column Headers command, 75
column headings

adding, 7
adding automatically to Excel tables, 11
blank heading cells, 7
My Table Has Headers option, 10
removing repeated columns, 8
separating data into multiple columns, 8
storing related data in a single column, 8
visibility of, when scrolling Excel tables, 13

column shading, adding, 73
Column Widths, Autofit on Update option,

229
Command Text box, 140
Compact Form layout

applying, 71
labels and headings in, 70
Show in Compact Form command, 71
See also layouts; Outline Form layout;

Tabular Form layout
Compatibility Mode, 276
conditional formatting

A Date Occurring dialog box, 217
Above Average command, 223
adding data bars, 209
adding visual impact to data, 203
Apply Rule To options, 226
applying a three-color scale, 206
applying a two-color scale, 203
applying multiple conditional-formatting

options, 209
Arrows (Colored) Icon Sets option,

208–209
Between dialog box, 214
changing the order of precedence for

rules, 222
Clear Rules from Selected Cells command,

206
Color Scales option, 205, 207
Conditional Formatting command, 205,

207
Conditional Formatting Rules Manager

dialog box, 220, 224, 226–227
contrasting data bars with bar charts, 211
Custom Format option, 213, 215, 223
Data Bars option, 210
date filters as dynamically changing, 218
Delete Rule button, 227
Edit Formatting Rule dialog box, 220,

226–227
Edit the Rule Description section, 221
editing a rule for data bars, 218
editing rules for changed pivot table

layouts, 225
Format Cells dialog box, 213, 215, 222–223
formatting cells between two values, 214
formatting labels in a date period, 216
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formatting top 10 items, 212
handling formatting conflicts between

rules, 224
Highlight Cells Rules command, 214, 217
Icon Sets option, 208
Manage Rules option, 219, 224, 227
not including a Grand Total cell in, 205
previewing before applying, 205
removing, 206
Shortest Bar setting, 221
Top 10 Items dialog box, 212, 222
Top/Bottom Rules option, 212, 222–223
using both solid and graduated colors to

highlight cell values, 207
using icon sets, 207
See also calculated fields; calculated items;

custom calculations; summary
functions

connecting to an Access query, 134
connecting to an OLAP cube, 144
Connection Properties dialog box, 139, 146,

163
Connection Settings

changing for an Access query, 137
changing for an OLAP Cube, 145
viewing and testing, 128

Connection String box, 140
connections. see external data sources,

source data
Connections command, 162
Connections group, 128
Contains command, 111
context menu commands, 94
contextual tips, turning on, 278
Control Panel

Regional and Language Options, 278
Regional Options tab, 278

Convert command, 276
copy a value from the cell above, 39
Count function, 48
Create PivotTable dialog box, 20, 132
Create Table dialog box, 10
creating a pivot table

adding fields to a pivot table layout, 23, 25
changing fields in a pivot table layout, 24
charting the data in a pivot table, 28
Column Labels area, 22
creating an empty pivot table layout, 20
external data sources, 123
fields (columns), 22
InsurancePolicies02.xlsx source data, 20
moving fields in a pivot table layout, 26
nesting (indenting) location labels, 26
Report Filter area, 22
reusing an existing data connection, 141
Row Labels area, 22

using a text file as an external data source,
123, 132

using an Access query as an external data
source, 134

using an OLAP cube as an external data
source, 142

using the PivotTable Field List pane, 21
Values area, 22
WorkOrders Excel table, 88
See also modifying a pivot table; printing a

pivot table; updating a pivot table
Currency format, 52
Current Selection group, 247
custom calculations

creating, 168
Difference From, definition of, 168
Difference From, using, 169
eight types of, 168
examples of, 167
Index, definition of, 169
Index, using, 179
% Difference From, definition of, 168
% Difference From, using, 173
% of column, definition of, 168
% of column, using, 177
% of row, definition of, 168
% of row, using, 176
% of total, definition of, 168
% of total, using, 178
% Of, definition of, 168
% Of, using, 171
Running Total In, definition of, 168
Running Total In, using, 175
See also calculated fields; calculated items;

conditional formatting; summary
functions

Custom Format option, 213, 215, 223
custom lists

applying a custom list sort order, 108
creating a custom list for sorting, 107
Custom Lists dialog box, 107
Edit Custom Lists setting, 107
sorting without using a custom list, 108
Use Custom Lists When Sorting check box,

109
Custom Name box, 51

■D
data bars

adding, 209
applying with a dark fill color to cells, 211
Conditional Formatting Rules Manager

dialog box, 220
contrasting with bar charts, 211
Data Bars option, 210
Edit Formatting Rule dialog box, 220
Edit the Rule Description section, 221
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data bars (continued)
editing a rule for, 218
Manage Rules option, 219
removing the numbers and fixing the scale

of, 219
Shortest Bar setting, 221
See also pivot charts; PivotChart Tools

data connection, reusing an existing, 141
Data group, 40
Data Label options, 251–252
Data Preview area, 127
Data Series dialog box, Format, 248
data source. see external data sources; source

data
Data Table command, 255
dates

applying a manual filter for specific dates,
117

Date Filter dialog box, 116
Date Filters option, 117
filtering for a dynamic or specific date

range, 116
formatting, 115
Group command, 65
Grouping dialog box, 65

Defer Layout Update check box, 238
definition of a pivot table, 1
Delete Rule button, 227
deleting a pivot table

restoring a deleted pivot table, 43
selecting the Entire PivotTable command,

43
delimiter, definition of, 124
Design tab, 14, 20, 42, 239–240
Difference From

definition of, 168
using, 169

dimensions
definition of, 143
using, 145

Display Field Captions and Filter Drop
Downs option, 230

Display Fields in Report Filter Area drop-
down, 93, 95

Do Not Show Subtotals command, 58
document themes. See themes
Don’t Show Feature Descriptions in

ScreenTips, 278
doughnut charts, 243
Down, Then Over command, 94
Download Source Code File link, 275
Duplicate command, 80

■E
Edit Custom Lists setting, 107
Edit Formatting Rule dialog box, 220, 226–227
Edit the Rule Description section, 221

Effects command, 84
EmployeeData.txt

changing security settings for, 130
downloading and checking, 124
importing into a worksheet, 124
refreshing changed data, 129
viewing and testing the connection

settings for, 128
Enable Show Details check box, 262
Entire PivotTable command, 43
examples of using pivot tables, 1
Excel 2007

Add New Location button, 279
adjusting security settings, 278
adjusting the Regional options in

Windows XP, 278
Compatibility Mode, 276
contextual tips, turning on, 278
Convert command, 276
converting files from an earlier version of

Excel, 276
Don’t Show Feature Descriptions in

ScreenTips, 278
Excel Options dialog box, 277–278
Excel Workbook format, 17
new and changed features in, 5
new file formats, 17
PivotTable Options dialog box, 278
Save As dialog box, 276–277
saving a file, 275
saving a file in Excel 97–2003 Workbook

Format, 17, 277
ScreenTip Style drop-down, 277
ScreenTips, turning on, 277
sharing files from an earlier version of

Excel, 277
Show Contextual Tooltips check box, 278
Show Feature Descriptions in ScreenTips,

278
Trust Center dialog box, 278
Trust Center Settings, 278
Trusted Locations category, 279
.xlsx file extension, 17

Excel 97–2003 Workbook Format
saving an Excel 2007 file in, 17, 277

Excel Options dialog box, 107, 277–278
Excel tables

adding new rows automatically, 11
adding rows or columns for new data, 11
adding temporary column headings

automatically, 11
automatic formatting of, 10
automatic naming of, 13
Change Data Source command, 152, 156
Change PivotTable Data Source dialog

box, 152, 156
changing the source data, 154
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Clear Filter option, 17
copying a pivot table for reuse, 154
copying the active worksheet, 155
Create Table dialog box, 10
deleting rows and columns, 12–13
Design tab, 14
determining the source of a pivot table,

152
Excel 97–2003 Workbook Format, 17, 277
features of, 11
filtering data in, 16
Move or Copy dialog box, 155
procedure for creating, 9
RegionSales.xlsx, 151
removing a data filter, 17
renaming, 14
resizing, 10
sorting data in, 14
Table Name box, 14
Table Tools tab, 14
Tables group, 9
updating the source data, 151, 153
visibility of column headings when

scrolling, 13
See also creating a pivot table; source data;

worksheets
Existing Connections dialog box, 141, 161
Expand Entire Field command, 147
External Data Range Properties dialog box

Prompt for File Name on Refresh check
box, 129

Refresh Control section, 129
Refresh Data When Opening the File check

box, 129
external data sources

adding a source file to a Trusted Location,
141

blocking an external data file for security
reasons, 131

Change Data Source command, 161
Change PivotTable Data Source dialog

box, 161–162
changing an Access data source, 160
changing the connection settings for an

Access query, 137
changing the connection settings to an

OLAP Cube, 145
Choose Connection command, 161
Command Text box, 140
connecting to an Access query, 134
connecting to an OLAP cube, 144
Connection Properties dialog box, 139,

146, 163
Connection String box, 140
Connections command, 162
Connections group, 128
Create PivotTable dialog box, 132

creating a connection to a new database,
160

creating a pivot table from an Access
query, 134

creating a pivot table from an OLAP cube,
142

creating a pivot table using an external
text file, 123, 132

creating a temporary pivot table for a new
connection, 161

EmployeeData.txt, changing security
settings for, 130

Enable This Content option, 130
enabling content temporarily for import,

131
Existing Connections dialog box, 141, 161
External Data Range Properties dialog box,

128, 132
From Access command, 135, 160
From Text command, 125
Get External Data group, 125, 135, 141, 160
Import Data dialog box, 136, 142, 161
Import Text File dialog box, 125
losing a connection to, 132
manually refreshing external data, 131
Microsoft Office Excel Security Notice

dialog box, 131, 144
Microsoft Office Security Options dialog

box, 130
pivot cache, definition of, 164
PivotTable command, 132
previewing text files before importing, 126
Refresh All command, 157
Refresh Every 60 Minutes check box, 163
refreshing a pivot table regularly, 163
refreshing changed data, 129, 133
removing a temporary pivot table and its

old connection, 162
reusing an existing connection to create a

pivot table, 141
Save Source Data with File check box, 164
Security Warning bar, 130, 140
Select Data Source dialog box, 135, 160
Select Table dialog box, 136, 161
selecting the Shipments connection, 138
Table/Range box, 133
Text Import Wizard, 126
using an external data range address as a

source range, 132
using the Trust Center, 132
viewing and testing the current

connection settings, 128
Workbook Connections dialog box,

138–139, 146, 162
See also source data
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■F
Field Captions and Filter Drop Downs

option, Display, 230
Field List button

hiding/showing the PivotTable Field List
pane, 237–238

Field Settings command, 269
Field Settings dialog box, 230
fields (columns)

adding column headings, 7
adding column shading, 73
blank heading cells, 7
Column Headers command, 75
definition of, 7
deleting in Excel tables, 13
field names, 7
not including blank columns in source

data, 9
pivot tables and, 22
quickly moving to the last column in a

record, 39
removing repeated columns, 8
separating data into multiple columns, 8
storing related data in a single column, 8
turning column header formatting on and

off, 75
See also records (rows)

Fill Color command, 82
Fill Color palette, 82
Fill tab, 213
Filter list, 236
filter symbol, 35
filters

applying a filter by selection, 119
applying a manual filter for specific dates,

117
Begins With command, 110
Clear PivotTable option, 115
clearing, 115
Contains command, 111
Date Filter dialog box, 116
Date Filters option, 117
Filter Drop Downs option, Display Field

Captions and, 230
filtering a text string using Begins With,

109
filtering a text string using Contains, 111
filtering for a dynamic or specific date

range, 116
filtering for the bottom percent, 121
filtering for the top items, 120
filtering for the top sum, 122
filtering row and column labels, 109
filtering values for column fields, 114
filtering values for row fields, 113
having multiple filters per field, 120

Include New Items in Manual Filter check
box, 119

including new data using a manual filter,
118

Keep Only Selected Items command, 120
Label Filter dialog box, 110
PivotChart Filter Pane, 236
removing, 112
showing the highest or lowest values in a

value field, 120
Top 10 Filter dialog box, 120–122
using date range filters, 114
using the * wildcard, 111
using tool tips to view filter and sort

information, 111
Value Filter dialog box, 113–114
See also report filters; Show Details feature

Font drop-down, 83
Font tab, 77, 213
Fonts command, 83
For Rows Only command, 269
Format Cells dialog box, 33, 47, 52, 77, 79,

115, 172, 174, 213, 215, 222–223
Format Data Series dialog box, 248
format options

Autofit Column Widths on Update option,
229

controlling column width, 229
Display Field Captions and Filter Drop

Downs option, 230
enhancing pivot table formatting, 228
Field Settings dialog box, 230
hiding unneeded buttons and labels, 230
Layout & Format tab, 229
Layout & Print tab, 230
making column headings shorter, 228
PivotTable Options dialog box, 229
Show Expand/Collapse Buttons option,

230
Show Items with No Data option, 230
showing items containing no data, 230

Format Selection command, 248
Format tab, 239
formulas. see calculated fields; calculated

items; GetPivotData function
From Access command, 135, 160
From Text command, 125
functions. See summary functions;

GetPivotData function

■G
Get External Data group, 125, 135, 141, 160
GetPivotData function

advantage of, 270
creating a GetPivotData formula, 270
extracting data from a cell in a pivot table,

269
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#REF! error, 271–272
turning off the Generate GetPivotData

feature, 272
using cell references in GetPivotData

formulas, 271
grand totals

Grand Total Row element, 77
PivotTable Options dialog box, 56
showing or hiding, 54–56
sorting a grand total row, 102
Totals & Filters tab, 56
See also subtotals

grid lines (chart), 239–240
Gridlines command, 255
Group command, 65
Group Field command, 63
Group group, 63, 66–67
Group Selection command, 66–67
grouping

grouping dates, 65
Grouping dialog box, 64–65
grouping numbers, 62
grouping text fields, 66
grouping worksheets by selecting, 264
renaming group labels, 67
ungrouping, 64

■H
HardwareSales.cub, downloading, 144
headers, formatting, 265
Highlight Cells Rules command, 214, 217
Home tab, 12
Hyperion Essbase, 143

■I
icon sets

Arrows (Colored) Icon Sets option,
208–209

Icon Sets option, 208
illustrating data with, 207
previewing before applying, 208

IF worksheet function, 187, 190
Import Data dialog box, 136, 142, 161
Import Text File dialog box, 125
Include New Items in Manual Filter check

box, 119
Index

definition of, 169
formula for calculating, 181
using, 179
weighting a value’s importance in its row

and column context, 181
inner fields, definition of, 58
Insert Calculated Field dialog box, 183, 187,

189
Insert Calculated Item dialog box, 192, 194
Insert Chart dialog box, 246

Insert Field button, 184, 192
Insert Item button, 193
Insert Page Break After Each Item check box,

269
InsurancePolicies.xlsx

downloading, 6
procedure for creating a sample data file, 6

InsurancePolicies02.xlsx
creating a pivot table, 20
downloading, 19

Items to Retain per Field drop-down,
Number of, 159

■K
Keep Only Selected Items command, 120
keyboard shortcuts

copy a value from the cell above, 39
creating a chart, 28, 234
go to the last cell, 39
move down a column, 39
navigate in Print Preview, 265
return to cell A1, 15
Undo, 43

■L
labels

applying a custom list sort order, 108
creating a custom list for sorting labels,

107
Custom Lists dialog box, 107
displaying in a nonalphabetical order, 96
dragging labels to a new position, 96
Edit Custom Lists setting, 107
Label Filter dialog box, 110
Labels group, 249
manually rearranging labels, 96
misspelling overtyped labels, 98
moving labels by typing, 97
pivot table labels and source data, 88
sorting labels in a custom order, 107
sorting labels using a context menu

command, 99
sorting labels using a heading drop-down

list, 100
sorting labels using Ribbon commands, 98
sorting without using a custom list, 108
Use Custom Lists When Sorting check box,

109
using context menu commands to move

labels, 96
See also sorting labels

layouts
Blank Rows command, 72
Compact Form, 69
how layout changes affect subtotals, 69
Layout & Format tab, 93–94, 229
Layout & Print tab, 230, 269
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layouts (continued)
Layout group, 58–59, 69–70
Layout tab, 239, 247, 249
Outline Form, 69
removing blank rows, 72
Report Layout command, 69–71
Show in Outline Form command, 69
Show in Tabular Form command, 70
Subtotals command, 69
Tabular Form, 69
See also Compact Form layout; Outline

Form layout; Tabular Form layout
legend (chart), 239–240, 249
Legend Fields (Series) area, 235, 238, 242,

245, 247
Line chart option, 246
line charts, 243, 246
List Formulas command, 197

■M
Manage Rules option, 219, 224, 227
Manual Filter check box, Include New Items

in, 119
Marker Options command, 248
Max (maximum) function, 48, 61
measures

definition of, 143
using, 144

Microsoft Access
Change Data Source command, 161
Change PivotTable Data Source dialog

box, 161–162
changing an Access data source, 160
changing the connection settings for an

Access query, 137
Choose Connection command, 161
Command Text box, 140
connecting to an Access query, 134
Connection Properties dialog box, 139
Connection String box, 140
Connections command, 162
creating a connection to a new database,

160
creating a pivot table from an Access

query, 134
creating a temporary pivot table for a new

connection, 161
Existing Connections dialog box, 141, 161
From Access command, 135, 160
Get External Data group, 135, 141, 160
Import Data dialog box, 136, 142, 161
removing a temporary pivot table and its

old connection, 162
reusing an existing connection to create a

pivot table, 141
Security Warning bar, 140
Select Data Source dialog box, 135, 160

Select Table dialog box, 136, 161
selecting the Shipments connection, 138
Shipments.accdb, downloading, 134
ShipmentsByDate query, 134, 136
Workbook Connections dialog box,

138–139, 162
Microsoft Office Button, 6, 17, 107, 265–266,

275
Microsoft Office Excel Security Notice dialog

box, 131, 144
Microsoft Office Security Options dialog box,

130
Microsoft Office themes, definition of, 81
Microsoft SQL Server 2005 Analysis Services,

143
Microsoft, downloading file converters from,

277
Min (minimum) function, 48
Modify PivotTable Quick Style dialog box, 79
modifying a pivot table

adding fields to specific layout areas, 32
automatically refreshing a pivot table, 153
changing the source data, 154
choosing Number Format from the

context menu, 33
clearing a pivot table layout of all fields, 31
controlling field placement, 32
Format Cells dialog box, 33
formatting numbers, 33
Number of Items to Retain per Field drop-

down, 159
PivotTable Options dialog box, 153
Refresh All command, 157
Refresh Data When Opening the File check

box, 153, 165
refreshing all pivot tables in a workbook,

157
retaining deleted items, 158
updating the source data, 153
See also creating a pivot table; printing a

pivot table; updating a pivot table
More Options command, 49
More Sort Options dialog box, 104–105
Move Chart dialog box, 251
Move or Copy dialog box, 155, 260
My Table Has Headers option, 10

■N
Name box, 38
nesting (indenting) location labels, 26
New Items in Manual Filter check box,

Include, 119
New PivotTable Quick Style dialog box, 76–77
New PivotTable Style command, 76
New Workbook dialog box, 6
Number Format command

Currency format, 52
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currency symbol and regional settings, 52
formatting values as Number, 175
formatting values as Percentage, 177
setting Decimal places to zero, 172

Number of Items to Retain per Field drop-
down, 159

Number tab, 47
numbers

formatting, 33, 47, 88
Group Field command, 63
Group group, 63
grouping, 62
Grouping dialog box, 64
Ungroup command, 64
ungrouping, 64

■O
Off for Rows and Columns command, 199
Office Theme. see themes.
OLAP (Online Analytic Processing) cube

Active Field group, 147
Business Objects, 143
changing the connection settings to, 145
Cognos PowerPlay, 143
Collapse Entire Field command, 148
connecting to, 144
Connection Properties dialog box, 146
creating, 143
creating a pivot table from, 142
dimensions, definition of, 143
dimensions, using, 145
Expand Entire Field command, 147
HardwareSales.cub, downloading, 144
Hyperion Essbase, 143
measures, definition of, 143
measures, using, 144
Microsoft Office Excel Security Notice

dialog box, 144
Microsoft SQL Server 2005 Analysis

Services, 143
OLAP Drill Through setting, 146
OLAP Server Formatting setting, 146
PivotTable Field List pane, 144
SQL Server, 142
understanding, 142
using an OLAP cube as a data source, 144
Workbook Connections dialog box, 146

Options dialog box, Excel, 107, 277–278
Options dialog box, PivotTable, 153
Options tab, 40, 43
OR worksheet function, 190
outer fields, definition of, 58
Outline Form layout

applying, 69
labels and headings in, 70
Layout group, 69
Report Layout command, 69

Show in Outline Form command, 69
Subtotals command, 69
uses for, 70
See also Compact Form layout; layouts;

Tabular Form layout
Over, Then Down setting, 93

■P
Page Break After Each Item check box, Insert,

269
Page Layout tab, 81, 84
% Difference From

definition of, 168
using, 173

% Of
definition of, 168
using, 171

% of column
definition of, 168
using, 177

% of row
definition of, 168
using, 176

% of total
definition of, 168
using, 178

Percent Style command, 199
pie charts, 243
pivot cache

definition of, 164
rebuilding, 164

pivot charts
Above Chart option, 249
adding a trend line, 253
adding data labels to a series, 251
adding fields to, 242
Analysis group, 253
area charts, 243
automatic sizing of, 250
avoiding three-dimensional chart

subtypes, 243
Axes command, 255
Axis Fields (Categories) area, 235, 238, 242,

247
bar charts, 243
category axis, 235, 238, 242
Centered Overlay Title option, 249
Change Chart Type dialog box, 243
changing the layout of, 234, 239
changing the marker options, 248
changing the style of, 240
Chart Elements list, 248, 253
Chart Layouts gallery, 239, 244
Chart Styles gallery, 241
Chart Title, 240, 249
chart types, list of, 243
choosing a different chart type, 242
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pivot charts (continued)
Clustered Column chart type, 243, 246
clustering columns, 235, 238
column charts, 243
creating, 28, 233, 245
creating a formula for a variable chart title,

254
creating multiple series, 247
Current Selection group, 247
Data Label options, 251–252
Data Table command, 255
definition of, 233
doughnut charts, 243
filters, applying, 236
filters, removing, 237
fixing overlapping data labels, 251
Format Data Series dialog box, 248
Format Selection command, 248
formatting chart elements, 247
grid lines, 239–240
Gridlines command, 255
Insert Chart dialog box, 246
keyboard shortcut for creating, 28, 234
Labels group, 249
Legend Fields (Series) area, 235, 238, 242,

245, 247
legend, changing, 249
legend, default, 239–240
Line chart option, 246
line charts, 243, 246
Marker Options command, 248
Move Chart dialog box, 251
moving fields in, 238
moving to a different location, 250
other enhancement features, 255
pie charts, 243
PivotChart command, 246
pressing F11 to create a pivot chart, 28, 234
procedure for charting pivot table data, 28
radar charts, 243
resizing, 250
Row Labels area, 245
series, definition of, 28
Shape Height box, 250
Shape Outline command, 253
Shape Styles command, 255
Shape Styles group, 253
Shape Width box, 250
Show Legend at Top command, 249
Stacked Column chart type, 243
surface charts, 243
title, adding, 248
title, default, 239–240
title, variable, 254
tool tips, 235, 243
Trendline command, 253
Values axis, 244

vertical axis scale, 236
viewing pivot table changes after charting,

245
viewing the current theme’s effects, 83
WordArt Styles command, 255
See also data bars; PivotChart Tools

PivotChart Filter Pane
Clear Filter command, 237
Field List button, 237–238
Filter list, 236
functions of, 236

PivotChart Tools
Analyze tab, 239
Change Chart Type dialog box, 243
Chart Layouts gallery, 239, 244
Chart Styles gallery, 241
Design tab, 239–240
Format tab, 239
Labels group, 249
Layout tab, 239, 247, 249
Move Chart dialog box, 251
Show Legend at Top command, 249
See also data bars; pivot charts

PivotTable command, 132
PivotTable Design tab

Banded Columns command, 74
Banded Rows command, 73

PivotTable Field List pane
Column Labels area, 22
Defer Layout Update check box, 238
dragging a value field to a new position, 53
hiding or showing, using the Field List

button, 237
inner fields and outer fields, 58
removing fields by clearing their check

boxes, 31
Report Filter area, 22, 34
Row Labels area, 22
Update button, 238
using an OLAP cube as a data source, 144
Value Field Settings dialog box, 50, 52
Values area, 22

PivotTable group, 93
PivotTable Options command, 94, 262, 267
PivotTable Options dialog box, 56, 93–94,

108, 153, 229, 278
PivotTable Style Options group, 73–74, 76
PivotTable Styles gallery, 73, 78, 81
PivotTable Styles group, 42, 73–76
PivotTable Tools tab, 32, 40, 42–43, 51, 73–74,

93, 246
planning for source data, 6
Print dialog box, 265
Print Preview window

navigating pages in, 265–266
zooming in and out, 265

printing a pivot table
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adding a header to grouped worksheets,
265

adding page breaks after items, 269
changing the print options, 266
Compact Form layout, 268
Field Settings command, 269
For Rows Only command, 269
grouping worksheets by selecting, 264
Insert Page Break After Each Item check

box, 269
Layout & Print tab, 269
PivotTable Options command, 267
Print dialog box, 265
Print Preview window, 265–266
Repeat Row Labels on Each Printed Page

check box, 267
Set Print Titles check box, 267
Show in Outline Form layout, 268
See also creating a pivot table; modifying a

pivot table; updating a pivot table
Product function, 48
Prompt for File Name on Refresh check box,

129

■Q
Quick Access Toolbar (QAT), 43

■R
radar charts, 243
records (rows)

adding row shading, 73
Blank Rows command, 72
definition of, 7
deleting in Excel tables, 12
entering related data in each row, 9
not including blank rows in source data, 9
quickly moving to the last record in a

column, 39
Row Headers command, 75
turning row header formatting on and off,

74
See also fields (columns)

#REF! error, 271–272
refresh

Refresh All command, 157
Refresh button, 40
Refresh Data When Opening the File check

box, 129, 153, 165
Refresh Every 60 Minutes check box, 163
Refresh check box, Prompt for File Name

on, 129
See also updating a pivot table

Regional options, adjusting, 278
RegionSales.xlsx, 151
removing a pivot table, 43
Repeat Row Labels on Each Printed Page

check box, 267

report filters
Add to Report Filter command, 90
adding, 33
adding a field to the Report Filter area, 89
adding multiple report filters, 90
adjusting the arrangement of, 95
arranging horizontally, 92
arranging vertically, 94
changing, 35
changing the order of, 91
Clear Filter command, 38
Clear Filters command, 95
Display Fields in Report Filter Area drop-

down, 93, 95
Down, Then Over command, 94
filter symbol, 35
Layout & Format tab, 93–94
multiple filters as independent of one

another, 91
Over, Then Down setting, 93
removing a filtered field, 37
Report Filter area, 34, 263
Report Filter Fields per Column setting, 94
Report Filter Fields per Row setting, 93
Select Multiple Items check box, 36
See also filters; Show Details feature

Report Layout command, 69–71
report layouts. See layouts
Report Type filter drop-down, 263–264
restoring a removed pivot table, 43
Ribbon, 9, 12

hiding and displaying commands, 14
Row Headers command, 75
Row Labels area, 245
row shading, adding, 73
Running Total In

definition of, 168
using, 175

■S
sample files

Download Source Code File link, 275
downloading from the Apress web site,

275
EmployeeData.txt, 124
HardwareSales.cub, 144
InsurancePolicies.xlsx, 6
InsurancePolicies02.xlsx, 19
InsurancePolicies03.xlsx, 31
RegionSales.xlsx, 151
RegionSales_02.xlsx, 167
RegionSales_03.xlsx, 234
SafetyData.xlsx, 203
SafetyData12.xlsx, 257
Shipments.accdb, 134
ShipmentsNew.accdb, 160
ShipmentPivot02.xlsx, 160
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sample files (continued)
WorkOrders_01.xlsx, 45
WorkOrders_02.xlsx, 69
WorkOrders_03.xlsx, 87

Save As dialog box, 276–277
Save Source Data with File check box, 164
saving a file, 17, 275, 277
ScreenTip feature, 42
ScreenTip Style drop-down, 277
ScreenTips, Don’t Show Feature Descriptions

in, 278
ScreenTips, turning on, 277
security settings

adjusting, 278
blocking an external data file, 131
changing for external data sources, 130
Enable This Content option, 130
enabling content temporarily for import,

131
manually refreshing external data, 131
Microsoft Office Excel Security Notice

dialog box, 131, 144
Microsoft Office Security Options dialog

box, 130
using the Trust Center, 132

Security Warning bar, 130, 140, 160
Select Data Source dialog box, 135, 160
Select Field drop-down, 109
Select Multiple Items check box, 36
Select Table dialog box, 136, 161
Selected Items command, Keep Only, 120
Selection command, Format, 248
series (chart), definition of, 28
Set Print Titles check box, 267
Shape Height box, 250
Shape Outline command, 253
Shape Styles command, 255
Shape Styles group, 253
Shape Width box, 250
Shipments.accdb, downloading, 134
ShipmentsByDate query, 134, 136
Shortest Bar setting, 221
Show All Subtotals at Bottom of Group

command, 59
Show All Subtotals at Top of Group

command, 69
Show Contextual Tooltips check box, 278
Show Details feature

changing the default table style, 261
disabling, 262
double-clicking a Values area cell to

extract records, 261
Enable Show Details check box, 262
extracting records to a new worksheet, 258
formatting extracted records, 260
Move or Copy dialog box, 260
PivotTable Options command, 262

recreating accidentally deleted source
data, 261

Show Details command, 258
Table Styles gallery, 260–261
viewing the underlying records in a data

source, 257
See also filters; report filters

Show Expand/Collapse Buttons option, 230
Show Feature Descriptions in ScreenTips, 278
Show in Compact Form command, 71
Show in Outline Form command, 69
Show in Outline Form layout, 268
Show in Tabular Form command, 70
Show Items with No Data option, 230
Show Legend at Top command, 249
Show Report Filter Pages feature

creating worksheets from selected report
filter items, 262

Report Filter area, 263
Report Type filter drop-down, 263–264
Show Report Filter Pages dialog box, 264

Show Values As tab, 169
solve order

changing in calculated items, 198
Solve Order dialog box, 200

Sort A to Z command, 98
Sort and Filter list, 158–159
Sort Automatically Every Time the Report Is

Updated check box, 105
Sort By Value dialog box, 102
Sort dialog box, 104–105
Sort group, 98, 102
Sort Largest to Smallest command, 101–102
Sort Smallest to Largest command, 100
Sort Z to A command, 99
sorting labels

applying a custom list sort order, 108
creating a custom list for sorting, 107
Custom Lists dialog box, 107
Edit Custom Lists setting, 107
Sort A to Z command, 98
Sort group, 98
Sort Z to A command, 99
sorting without using a custom list, 108
Use Custom Lists When Sorting check box,

109
using a context menu command, 99
using a heading drop-down list, 100
using Ribbon commands, 98
See also labels

sorting values
automatic sorting, preventing, 104
automatic sorting, restoring, 105
AutoSort option, 105
More Sort Options dialog box, 104–105
Sort Automatically Every Time the Report

Is Updated check box, 105
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Sort By Value dialog box, 102
Sort dialog box, 104–105
Sort group, 102
Sort Largest to Smallest command,

101–102
Sort Smallest to Largest command, 100
sorting a grand total row, 102
sorting automatically after pivot table

changes, 103
sorting from left to right, 102
sorting in ascending order, 100
sorting in descending order, 101

Source Code link, 275
source data

adding column headings, 7
automatically refreshing a pivot table, 153
Change Data Source command, 152, 156
Change PivotTable Data Source dialog

box, 152, 156
changing and updating in a pivot table, 38
changing the source data, 154
copying a pivot table for reuse, 154
copying the active worksheet, 155
determining the source of a pivot table, 152
entering related data in each row, 9
Excel tables and, 11
field (column), definition of, 7
field names, 7
Move or Copy dialog box, 155
not including blank rows or columns, 9
Number of Items to Retain per Field drop-

down, 159
organizing data in rows and columns, 7
pivot cache, definition of, 164
PivotTable Options dialog box, 153
planning for, 6
procedure for creating a sample data file, 6
record (row), definition of, 7
Refresh All command, 157
Refresh Data When Opening the File check

box, 153, 165
refreshing all pivot tables in a workbook,

157
removing repeated columns, 8
retaining deleted items, 158
Save Source Data with File check box, 164
saving the source data with a file, 164
separating data into multiple columns, 8
separating source data from other

worksheet data, 9
setting up, 6, 18
storing related data in a single column, 8
updating the source data, 153
using an unformatted range of cells, 154
See also external data sources

SQL Server, 142
Stacked Column chart type, 243

StDev and StdDevp functions, 49
styles

applying a built-in pivot table style, 42, 73
Banded Columns command, 74
Banded Rows command, 73
Border tab, 77
Clear command, 76
Column Headers command, 75
custom style, applying, 78
custom style, creating, 76
custom style, deleting, 80
custom style, duplicating, 80
custom style, modifying, 79
Duplicate command, 80
Font tab, 77
Format Cells dialog box, 77, 79
formatting the row and column headers,

74
Grand Total Row element, 77
layouts and style formatting, 72
Modify PivotTable Quick Style dialog box,

79
New PivotTable Quick Style dialog box,

76–77
New PivotTable Style command, 76
not applying a style, 43
opening the full gallery of pivot table

styles, 42
PivotTable Style Options group, 73–74, 76
PivotTable Styles gallery, 73, 78, 81
PivotTable Styles group, 42, 73–76
PivotTable Tools tab, 73–74
previewing, 42, 73
removing, 75
Row Headers command, 75
Styles group, 205
Table Element list, 77, 79–80
turning column header formatting on and

off, 75
turning row header formatting on and off,

74
See also themes

subtotals
changing the function used for a subtotal,

60
changing the row position of subtotals, 59
creating, 57
creating additional subtotals for other

summary functions, 61
displaying subtotals at the bottom of a

group, 59
Do Not Show Subtotals command, 58
how layout changes affect subtotals, 69
inner fields and outer fields, 58
position of, in the Tabular Form layout, 71
Show All Subtotals at Bottom of Group

command, 59

■INDEX 293

Find it faster at http://superindex.apress.com
/

8903CH14IndexCMP2  8/29/07  7:12 PM  Page 293

http://superindex.apress.com
http://superindex.apress.com
http://superindex.apress.com
http://superindex.apress.com


subtotals (continued)
Show All Subtotals at Top of Group

command, 69
showing or hiding, 58
Subtotals & Filters tab, 60–61
Subtotals command, 58–59, 69
See also grand totals

Sum function, 48, 60–61
Summarize Data By command, 41, 47, 49,

169
Summarize with PivotTable command, 20
summary functions

∑Values button, 54
Average, 48, 52
calculating an average, 47
changing the position of value fields, 53
changing, 41
Count, 48
Currency format, 52
Format Cells dialog box, 47, 52
formatting numbers, 47
Max (maximum), 48, 61
Min (minimum), 48
Number Format command, 47, 52
Number tab, 47
Product, 48
rearranging the order of value fields, 52
renaming value field headings, 50
showing multiple summaries for one

value field, 51
showing multiple value fields, 49
StDev and StdDevp functions, 49
Sum, 48, 60–61
Summarize Data By command, 47, 49
table of, 48
Value Field Settings dialog box, 50, 52
See also calculated fields; calculated items;

conditional formatting; custom
calculations

surface charts, 243

■T
Table. see Excel tables
Table command, 9
Table Element list, 77, 79–80
Table Name box, 14
Table Styles gallery, 260–261
Table Tools tab, 14, 20
Table/Range box, 133, 156
Tables group, 9
Tabular Form layout

applying, 70
position of subtotals, 71
removing subtotals, 71
Show in Tabular Form command, 70
uses for, 71

See also Compact Form layout; layouts;
Outline Form layout

text fields
Group group, 66–67
Group Selection command, 66–67
grouping, 66
renaming group labels, 67
Ungroup command, 67

text files
adding field headings to, 124
changing the data type for one or more

columns, 127
changing the delimiter of, 126
checking file origin and character set, 126
Connections group, 128
Create PivotTable dialog box, 132
creating a pivot table using an external

text file, 123, 132
Data Preview area, 127
delimiter, definition of, 124
EmployeeData.txt, changing security

settings for, 130
EmployeeData.txt, connection settings for,

128
EmployeeData.txt, downloading and

checking, 124
EmployeeData.txt, importing into a

worksheet, 124
External Data Range Properties dialog box,

128, 132
fixed-width, 124
From Text command, 125
Get External Data group, 125
Import Text File dialog box, 125
line breaks and, 124
Microsoft Office Excel Security Notice

dialog box, 131
PivotTable command, 132
previewing before importing, 126
Security Warning bar, 130
Table/Range box, 133
Text Import Wizard, 126
using an external data range address as a

source range, 132
using the Trust Center, 132

themes
applying, 84
Aspect theme, 84
Colors command, 82
definition of, 81
Effects command, 84
Fill Color command, 82
Fill Color palette, 82
Font drop-down, 83
Fonts command, 83
Office Theme, 81, 85
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Page Layout tab, 81, 84
Themes command, 81
Themes gallery, 84–85
Themes group, 81–82, 84
viewing the current theme’s color palette,

82
viewing the current theme’s effects, 83
viewing the current theme’s fonts, 83
viewing the current workbook theme, 81
See also styles

title (chart)
adding, 248
default, 239–240
variable, 254

tool tips, using in pivot charts, 235, 243
Tools group, 20, 246
Tooltips check box, Show Contextual, 278
Top 10 Filter dialog box, 120–122
Top 10 Items dialog box, 212, 222
Top/Bottom Rules option, 212, 222–223
totals. see subtotals, grand totals
Totals & Filters tab, 56, 108
Trendline command, 253
Trust Center, 132
Trust Center dialog box, 278
Trust Center Settings, 278
Trusted Locations category, 279

■U
Undo button, 43
Ungroup command, 64, 67
Update button, 238
updating a pivot table

automatically refreshing a pivot table, 153
Change Data Source command, 152, 156
Change PivotTable Data Source dialog

box, 152, 156
changing the source data, 38, 154
Connection Properties dialog box, 163
Defer Layout Update check box, 238
Name box, 38
Number of Items to Retain per Field drop-

down, 159
PivotTable Options dialog box, 153
Prompt for File Name on Refresh check

box, 129
quickly refreshing a pivot table, 40

Refresh All command, 157
Refresh button, 40
Refresh Data When Opening the File check

box, 153, 165
Refresh Every 60 Minutes check box, 163
refreshing a pivot table regularly, 163
refreshing all pivot tables in a workbook,

157
retaining deleted items, 158
selecting a different function to

summarize data, 41
Sort Automatically Every Time the Report

Is Updated check box, 105
Summarize Data By command, 41
updating the source data, 153
viewing new and revised data, 40
See also creating a pivot table; modifying a

pivot table; printing a pivot table;
refresh

Use Custom Lists When Sorting check box,
109

■V
Value Field Settings dialog box, 50, 52, 169
Value Filter dialog box, 113–114
Values axis, 244
vertical axis scale, 236

■W
WordArt Styles command, 255
work orders example

creating a report on technician services
and hours, 46

showing the average service time per
technician, 47

summarizing the work order data, 45
WorkOrders_01.xlsx, downloading, 45

Workbook Connections dialog box, 138–139,
146, 162

worksheets
adding a header to, 265
copying the active worksheet, 155
grouping by selecting, 264
removing permanently, 43

■X
.xlsx file extension, 17
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